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Real User Monitor
Administration Overview
This guide provides detailed instructions on how to configure and administer the HPE Real User Monitor
(RUM) data collector.

For details on installing and upgrading RUM, see the Real User Monitor Installation and UpgradeGuide.

Note: If you are an HPE Software-as-a-Service customer, youmust contact an HPE Software Support
representative to receive connection information that enables you to work with RUM.

This guide contains the following parts:

l "RUM Introduction and Compatibility" on page 11
Introduces RUM and explains how it works.

l "Data CollectionMethods" on page 23
Describes the different methods by which the RUM Probe can obtain monitored data.

l "Configuring and Administering Real User Monitor" on page 37
Explains how to configure a RUM Probe by changing the default settings, as well as how to configure and
administer the RUM Engine and how to administer RUM’s MySQL database. Also provides guidelines for
hardening RUM, deploying RUM in a SiteMinder environment, and publishing RUM data.

l "Supporting Specific Protocols" on page 216
Explains how to configure and work with RUM for monitoring specific protocols.

HPE Real User Monitor (9.30) Page 10 of 258



HPE Real User Monitor (9.30) Page 11 of 258

Part 1: RUM Introduction and
Compatibility



Chapter 1: Introducing RUM Administration
This chapter introduces HPE Real User Monitor (RUM) and explains how it works.

This chapter includes the following topics:

l "Overview of RUM" below
l "How RUMWorks" below
l "Ports Used by RUM" on the next page
l "Overview of RUM PerformanceMeasurements" on page 14
l "Installing and Administering RUM" on page 21

Overview of RUM
RUMmonitors both user and system initiated network traffic between client machines and servers and
between servers, collecting network and server performance and availability data in real time. This enables
administrators to pinpoint the cause of delays and quantify the business impact of detected performance
issues related to end users. When performance and availability exceed specified thresholds, HPE Application
PerformanceManagement (APM) proactively alerts applicationmanagers who, using the End User
Management (EUM) reports, analyze the collected data to isolate the root cause of detected problems.

Tip: For a description of the process required to set up and use RUM tomonitor applications, see "How
to Set up Real User Monitors" in the APM Application Administration Guide.

How RUMWorks
RUM consists of threemajor components: the probe, the engine, and theMySQL database.

l The probe receives data on end-user experience and/or applications, carries out initial processing on this
data, and sends it to the RUM Engine. There are two types of probe:
l Sniffer Probe - a non-intrusive, passive listening device that is subject to the same traffic the server
receives. The traffic can be collected in a number of different ways. For details, see "RUMData
CollectionMethods" on page 24.

l RUM Client Monitor Probe - collects user experience data directly from the client, for monitored web
or mobile applications. For details, see "RUMClient Monitor Probe" on page 31.

l The engine receives the data collected by the probe and assembles this data according to the
configuration specifications it receives from HPE Application PerformanceManagement (APM), that have
been configured in End User Management Administration. The engine transmits the page, transaction,
end-user, and server data samples it creates to the APMGateway Server. The APMGateway Server then
distributes the data to the relevant APM components, which create RUM alerts, reports, and Service
Health views.

Note: If the RUM Engine fails or is temporarily unavailable, or is unable to copy data from the RUM
Probe, the RUM Probe continues to collect data. The last two hours worth of data is saved on the
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RUM Probe and this data is copied by the RUM Engine when it becomes available again.

l TheMySQL database acts as RUM’s repository for data that the RUM Engine does not forward to APM
immediately, or at all. TheMySQL database stores the RUM Engine’s configuration settings, session
clickstreams (pages and snapshots included in a session), and the open sessions summary.
The following diagram shows how RUM receives user-experience and application data and passes it on to
APM.

Use the EUM reports to analyze network and application performance and availability data for the servers,
applications, pages, transactions, events, and end users that you configure for monitoring, as well as
general statistics that are collected and sent by the probes to the engine. When notified by an alert that a
certain performance or availability threshold has been exceeded, you can examine the issue in the
appropriate reports and try to pinpoint the cause of the problem and the time at which the problem
occurred. For detailed information on EUM reports, see "End User Management Reports Overview" in the
APMUser Guide.
In addition, RUM data is included in Service Health. For information on displaying RUM data in Service
Health, see "Predefined Views for End User Management" in the APM Application Administration Guide.

Ports Used by RUM
The following diagram shows the various ports used by RUM:

Real User Monitor Administration Guide
Chapter 1: Introducing RUM Administration

HPE Real User Monitor (9.30) Page 13 of 258



Note:

l The APMGateway Server initiates a connection to the RUM Engine on port 8180 for retrieving various
types of data.

l The RUM Engine initiates a connection to the APMGateway Server on port 80 (default) for sending
samples.

l The RUM Engine initiates a connection to the RUM Probe on port 2020 for https (which is the default
type of communication in RUM version 7.0 and later) and http.

l The RUM Probe does not initiate a connection to any other server in the system.
l There is no direct connection from APM to the RUM Probe.
l By default, the Snapshot Replay applet retrieves data to a user’s machine via a APM server. You can
configure the applet to retrieve data directly from the RUM Engine, in which case the connection is
made on port 8180. For details on configuring from where the Snapshot Replay applet retrieves data,
see "Determining How the Real User Monitor Snapshot Applet Retrieves Snapshots" in the APM
User Guide.

Overview of RUM Performance Measurements
This section describes themeasurements provided by RUM for the data that it monitors.

Real User Monitor Administration Guide
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This section includes the following topics:

l "Introduction to PerformanceMeasurements" below
l "TCP Request-ResponseMeasurements" below
l "HTTP Measurements" on the next page
l "End User Measurements" on page 20

Introduction to Performance Measurements
To understand RUM performancemeasurements, a basic knowledge of TCP/IP is beneficial. The following
are some of the TCP/IP and http terms used in describing performancemeasurements:

l SYN. A request for connection
l ACK. An acknowledgement response
l GET. A request for data
Performancemeasurements are aimed at measuring real-user experience, that is, the end-to-end user
experience. Tomeasure both client-side and server-sidemeasurements, the Parallel Technique is used, in
which it is assumed that measuring the event on the server side is a close approximation of the event’s
measurement on the client side. All RUMmeasurements are performed on the server side, but provide end-to-
end data. The following diagram shows that since the lines are parallel, it is assumed that T1 (client-side
measurement)=T2 (server-sidemeasurement).

TCP Request-Response Measurements
It is important to understand the following TCP Request-Responsemeasurements, as they form an integral
part of the TCP Request-Response data reported by RUM:

l Response Time. The time from the first packet of the request, until client acknowledgement of the last
packet of the response. If the request opens a new connection, the time taken to establish this connection
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is included in the response time. Download time is the sum of server time and network time.
l Server Time. By understanding the TCP protocol, RUM determines which time intervals were spent on
server processing (either server application processing time or server kernel processing time). These
intervals are incorporated into the server time. This measurement includes server time to first buffer.

l Server Time to First Buffer. The time from the last packet of the request to the first packet of the
response. This is the time taken by the server to process the request.

l Network Time. The time intervals that were spent by the server waiting for client acknowledgement to
arrive are incorporated into the network time. RUMmeasures what part of the network time is due to
network errors.

HTTPMeasurements
HTTP measurements are used by RUM to report page and transaction data to APM.

This section includes the following topics:

l "Page PerformanceMeasurements" below
l "Component Measurements" on the next page
l "PageMeasurements" on page 18
l "TransactionMeasurements" on page 19

Page Performance Measurements
The following table describes the performancemeasurements of pages that appear in RUM reports:

Measurement How it is Calculated Why it Matters

Page Time The end-to-end time it took to download the whole page. Enables you to discover
which pages are slow
(exceed their threshold).

Page Server
Time

The time spent on the servers to create the response. Enables you to track
server performance
issues.

Page Network
Time

The time spent on the network to send the response. Enables you to isolate
network delays.

Page Client
Time

The time spent on the client side. Enables you to
understand the client’s
effect on performance.

Page Hits There are separate counters for available and unavailable hits.
Unavailable hits are defined by events and errors configured
in End User Management Administration.

Help you determine the
overall availability of an
application.

Network
Latency

Network latency (round trip) per domain. Enables you to determine
whether there is a
network problem.

Real User Monitor Administration Guide
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Measurement How it is Calculated Why it Matters

Server
Availability

Server is up or down, and the service (application) is up or
down, as a percentage of available http requests.

Enables you to determine
whether there is a server
availability problem.

Component Measurements
It is important to understand component measurements as they form an integral part of page and transaction
measurements.

An http component is a single request response couple.

The following component measurements are used in RUM:

l Component Download Time. The time from the first packet of the request, until client acknowledgement
of the last packet of the response. Component download time is the sum of component server time and
component network time. If a request opens a new connection, the time taken to establish this connection
is included in the download time.

l Component Server Time. By understanding the TCP protocol, RUM determines which time intervals
were spent on server processing (either server application processing time or server kernel processing
time). These intervals are incorporated into the component server time. This measurement includes
component server time to first buffer.

l Component Server Time to First Buffer. The time from the last packet of the request to the first packet
of the response. This is the time taken by the server to process the request.

l Component Network Time. The time intervals that were spent by the server waiting for client
acknowledgement to arrive are incorporated into the component network time. RUMmeasures what part
of the network time is due to network errors.

The following diagram shows how component download time is calculated from the component server and
network times:
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Page Measurements
Each HTML page can contain sub-components (such as GIFs, JPGs, and so forth). RUM correlates themain
component (the HTML) and the sub-components, and calculates the download time for the whole page.

The following pagemeasurements are used in RUM:

l Page time. The time from the first packet of the first component’s request to the client ack for the last
packet of the last component’s response. Page time comprises page client/external time, page network
time and page server time.
Because a single pagemight be downloaded over several connections, whichmeans two or more
components might be downloaded simultaneously, and since theremight also be time gaps in the page
time in which no component is being downloaded, the total page timemight not necessarily equal the sum
of all the components’ download time.
The following diagram shows how several components server time or network timemight overlap (Comp1
and Comp2). This makes it difficult to define what portion of the page time is server time and what portion
is network time. To overcome this, RUM uses relativemeasurements for page breakdown:

l Page client/external time. A collection of all the time intervals in the page time in which no component
was downloaded. These gaps, which are shown in red in the above diagram, are usually caused by client
application processing (such as JavaScript).

l Page Server Time. The relative part of the Page Time that was spent on server processing. The formula
used to calculate this is:

l Page network time. The relative part of the page time that was spent on network transportation. The
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formula used to calculate this is:

Transaction Measurements
AnRUM transaction consists of a series of pages. A transaction is matched when RUM has monitored all the
pages in the series in the correct order.

The following transactionmeasurements are used in RUM:

l Transaction Total Time. The time from the beginning of the download of the first page until the end of the
download of the last page.

l Transaction Net Time. The portion of the total time that was actually spent downloading the pages. This
calculation excludes gaps between the pages, which are considered as user think time. Transaction net
time comprises the followingmeasurements:
l Transaction Server Time. The relative part of net time that was spent on server processing. This is
calculated considering the server time of the pages. Server time is counted only once for pages that
have overlapping sever time. Transaction server time = net transaction time * (total server time / total
download time).

l Transaction Network Time. The relative part of net time that was spent on network transportation.
This is calculated considering the network time of the pages. Network time is counted only once for
pages that have overlapping network time. Transaction network time = net transaction time * (total
network time / total download time).

l Transaction Client/External Time. The relative part of net time during which no server processing or
network transportation took place (that is, the gaps between components), usually due to client
processing. This is calculated considering the client time of the pages. Client time is counted only once
for pages that have overlapping client time. Transaction client time = net transaction time * (total client
time / total download time).

The following example shows the applicable times for a transaction comprising two pages:

Start
Time

End
Time

Download
Time

Server
Time

Client
Time

Network
Time

Total
Time

Page 1 0 10 10 4 4 2

Page 2 8 18 10 2 4 4

Net Transaction
Time

18 5.4 7.2 5.4 18

It is possible for a transaction’s server, network, or client time to be less than the individual server, network, or
client time of one of its included pages. This can occur when the download time of the pages included in the
transaction overlap, but register different measurements for the same time period. For example, two pages
may be downloading at the same time, but one registers server time while the other registers network time.

Real User Monitor Administration Guide
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End User Measurements
EndUser Latency is the average RTT (round trip time) it takes for a packet to travel between the server and
the client.

Within the scope of RUM, latency refers to Network Latency only. This term mainly refers to network
characteristics, but not to RUM itself. The following describes how RUM uses this parameter to calculate
latency.

The following diagram displays a single connection having several Actions which are shown as request-
response sections:

The latency for this connection is calculated based on the delay between the data connection and
corresponding ACK. Only ACK packets with no data are considered when calculating End User Latency.

In the diagram above, there is only one ACK client considered in the latency calculation: client-ack1. The
server ACKs participating in the calculation are: server-ack1 and server-ack3.

The following ACK durations are not considered in the calculation:

l client-ack0 and server-ack0, because they are related to the connection stage
l client-ack2 and server-ack2, because they are related to an ACK which contains packets with data
(REQUEST3 and RESPONSE2, respectively).
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The latency for the connection is calculated as:

l Server-ack-average = (server-ack1 + server-ack3 ) / 2
l Client-ack-average = (client-ack1) / 1 (we have only one considered ACK client)
l Connection-latency = (Server-ack-average + Client-ack-average) / 2
TheReported Latency for EUGs and Applications is the aggregated value calculated as the average for all
included connections (sessions).

Latency constantly changes, so for End-User Subgroups in RUM, the Global Statistic refers to the average
network latency in milliseconds for the period.

Installing and Administering RUM
To begin using RUM, youmust perform the following steps (after you have installed APM):

Install the RUM Engine.
For information on installing the RUM Engine and setting up the engine to connect to the Gateway Server, see
"Installing the RUM Engine" in the Real User Monitor Installation and UpgradeGuide.

Create and connect to the MySQL database.
You can create and connect to theMySQL database either as part of the RUM Engine installation procedure
or separately, at a later time. For details on creating theMySQL database as part of the RUM Engine
installation procedure, see "Installing the RUM Engine" in the Real User Monitor Installation and Upgrade
Guide. For details on creating theMySQL database at a later time, see "Overview of theMySQLDatabase"
on page 173.

Install one or more RUM Probes.
For information on installing a RUM Probe and setting it up to report real-user activity data to the engine, see
"Installing the RUM Sniffer Probe" and "Installing the RUMClient Monitor Probe" in the Real User Monitor
Installation and UpgradeGuide.

If necessary, reconfigure the connection between RUM and APM.
If connection parameters (such as SSL, proxy, and authentication) have changed since the installation of
APM, use the RUM Engine’s web console to reconfigure the connection between RUM and APM. For detailed
information, see "Using the RUMWebConsole" on page 41.

Configure RUM in APM End User Management Administration.
In End User Management Administration, you configure the specific application, transactions, actions,
events, and end-user groups you want to monitor. For more information, see "How to Set up Real User
Monitors" in the APM Application Administration Guide.

Note: You can create RUM alerts if you want to be notified of certain occurrences while monitoring real-
user data. You can view reports of the data collected by RUM in the End User Management application.
For information on configuring alerts, see "EUM Alerts Administration Overview" in the APM Application
Administration Guide. For information on viewing RUM reports, see "End User Management Reports
Overview" in the APMUser Guide.
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Chapter 2: RUM Compatibility Matrixes
This section includes the following information:

l "RUM–APMCompatibility Matrix" below
l "RUM Probe–RUM Engine Compatibility" below

RUM–APM Compatibility Matrix
The following table shows the compatibility between the different versions of the RUM Engine and APM
Server:

Note: Most RUM features require that the APM andRUM versions are aligned.

Compatibility Matrix APM 9.30
BSM
9.26

BSM
9.25

BSM
9.24 BSM 9.23 BSM 9.22 BSM 9.21 BSM 9.20

RUM 9.30 ✓ ✓ ✓ ✓ ✓ X X X

RUM 9.26 ✓ ✓ ✓ ✓ ✓ ✓ ✓ ✓

RUM 9.25 X X ✓ ✓ ✓ ✓ ✓ ✓

RUM 9.24 X X X ✓ ✓ ✓ ✓ ✓

RUM 9.23 X X X X ✓ ✓ ✓ ✓

RUM 9.22 X X X X X ✓ ✓ ✓

RUM 9.21 X X X X X X ✓ ✓

RUM 9.20 X X X X X X X ✓

RUM Probe–RUM Engine Compatibility
l RUM Sniffer Probe. The RUM Sniffer Probe versionmust be the same as the RUM Engine version.
l RUM Client Monitor Probe. The RUMClient Monitor Probe versionmust be the same as the RUM
Engine version.
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Chapter 3: RUM Data Collection Methods
There are a number of ways by which the RUM Probe can obtain data for monitored applications. The
available monitoring solutions depend on the type of RUM Probe you use:

l Sniffer Probe data collectionmethods:
l Network tap or switch configuration. For details, see "Data Collection Using a Network Tap or
Switch Configuration" on page 26.

l RUM Server Collector. For details, see "Sniffing Using the RUM Server Collector" on page 27.

l VMware. For details see Duplicating Traffic for RUMwith VMware in the RUMDeployment Guide.

l RUM Client Monitor Probe. For details, see "RUMClient Monitor Probe" on page 31.
For details on installing the RUM Probe, refer to the Real User Monitor Installation and UpgradeGuide.
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The following diagram illustrates the data flow for different RUM Probes and their data collectionmethods:
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Chapter 4: Data Collection Using a Network
Tap or Switch Configuration
The Sniffer Probe is a non-intrusive, passive listening device that is subject to the same traffic the server
receives. It is plugged into a network tap that is connected to amonitored server. As end-user traffic passes
through the tap, the probe listens to requests and responses sent to and from the server. In this way, data is
tracked all the way from the end-user’s IP address to the server handling the request.

Note: The configuration in a switch is usually called amirror or span port, depending on the switch
vendor.

The following diagram illustrates the flow for data collection using a network tap or switch configuration:
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Chapter 5: Sniffing Using the RUM Server
Collector
Note: The RUM Server Collector poses a significant impact on network performance and a slight impact
on the server's CPU. Therefore, use of the RUM Server Collector is limited to networks with very low
throughput and is mostly recommended for proof of concept (POC) purposes. For example, you can use
the RUM Server Collector if the network traffic is not high (150Mbps for windows and 250Mbps for
Linux) and if you are aware of the implications as noted above.

When it is not possible to use a network tap or port spanning, you can install the RUM Server Collector on a
monitored server so that the server sends packets directly to the probe (that is, the probe receives packets
directly from themonitored agent). The probe then processes the packets and forwards data to APM in the
regular manner.

The benefit of this is that you only have to be themachine owner of the server on which you install the RUM
Server Collector, and are not dependent on the infrastructure team. However, this method does require you to
install a software component on the server that runs your application, that is more than just a plug-in to the
application.

Note: The recommended data collectionmethod is to use a network tap or port spanning when possible
as this eliminates the need to configure andmaintain themonitored servers for data collection.

To work with the RUM Server Collector, youmust:

1. Install the RUM Sniffer Probe. For details, see "Installing the RUM Sniffer Probe" in the Real User
Monitor Installation and UpgradeGuide.

2. Install the RUM Server Collector on the server you want to monitor. For details, see "Installing the RUM
Server Collector" in the Real User Monitor Installation and UpgradeGuide.

3. Configure the RUM Server Collector. For details, see "Configuring the RUM Server Collector" below.
4. Configure the RUM Sniffer Probe to retrieve data from the RUM Server Collector. For details, see

"Configuring the RUM Sniffer Probe" on the next page.
5. Start the RUM Server Collector service. For details, see "Administering the RUM Server Collector

Service" on page 29.

Configuring the RUM Server Collector
Caution: The UTC times on the RUM Sniffer Probe and RUM Server Collector machines must be
identical. If they are not, the traffic captured on the RUM Server Collector may be incorrectly processed
by the RUM Sniffer Probe, resulting in missing data in EUM reports in APM.

Note: The RUM Server Collector poses a significant impact on network performance and a slight impact
on the server's CPU. Therefore, use of the RUM Server Collector is limited to networks with very low
throughput and is mostly recommended for proof of concept (POC) purposes. For example, you can use
the RUM Server Collector if the network traffic is not high (150Mbps for windows and 250Mbps for
Linux) and if you are aware of the implications as noted above.
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The RUM Server Collector is installed with default settings, which you can change according to your needs.
The configuration is stored in the collector.conf file that is located in:

l Windows: <RUM Server Collector installation directory>\etc\rum_collector\
(The default RUM Server Collector installation directory is C:\RUMSC)

l Linux: <RUM Server Collector installation directory>/etc/rum_collector/
(The default RUM Server Collector installation directory is /opt/HP/RUMSC)

To change the configuration, edit the file, make any of the following changes, and then save the file.

l Port number. The default port number used by the RUM Server Collector is 2002. You can change this
number by setting the port parameter in the [general] section of the file.

l Allowed clients. By default, the RUM Server Collector is configured to accept connections from any
client (probe). You can limit connections to specific probes by setting a client parameter in the [passive]
section of the file to a specific IP address.
Set a client parameter for each IP address you want to allow to connect to the RUM Server Collector.

l Security. By default, the RUM Server Collector is configured to enforce SSL connectivity. You can
changes this by setting the use_ssl parameter in the [security] section of the file to false.
The default security keys and certificates used by the RUM Server Collector for SSL connections are
predefined. If you want to use different keys and certificates, youmust update the following parameters in
the [security] section of the file:
l ssl_ca_file. The full path to the certificate file used to validate the client certificate sent by the probe.

l ssl_key. The full path to the private key file used for accepting server SLL connections from the probe.

l ssl_cert. The full path to the certificate file used for accepting server SLL connections from the probe.

Note:When youmake changes to the collector.conf file, youmust restart the RUM Server Collector
service for the changes to take effect. For details, see "Administering the RUM Server Collector Service"
on the next page.

Configuring the RUM Sniffer Probe
The UTC times on the RUM Sniffer Probe and RUM Server Collector machines must be identical. If they
are not, the traffic captured on the RUM Server Collector may be incorrectly processed by the RUM
Sniffer Probe, resulting in missing data in EUM reports in APM.

You can configure any RUM Sniffer Probe to connect to a RUM Server Collector, provided that it has the
capacity to handle all themonitored traffic (that is, both the regular sniffed traffic and the RUM Server
Collector traffic). A RUM Server Collector can only be connected to one RUM Sniffer Probe, but a RUM
Sniffer Probe can be connected tomultiple RUM Server Collectors.

Note: The RUM Server Collector poses a significant impact on network performance and a slight impact
on the server's CPU. Therefore, use of the RUM Server Collector is limited to networks with very low
throughput and is mostly recommended for proof of concept (POC) purposes. For example, you can use
the RUM Server Collector if the network traffic is not high (150Mbps for windows and 250Mbps for
Linux) and if you are aware of the implications as noted above.
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To configure the RUM Sniffer Probe to connect to the RUM Server Collector to retrieve data, on the RUM
Engine edit the \HPRUM\conf\configurationmanager\Beatbox_<Sniffer Probe name>_Const_
Configuration.xml file.

In the [collector] section of the file, add devices in the following format:

device rpcap://[<server name>]:<port number>/<device name>

where:

l <server name> = the name or IP address of the server on which the RUM Server Collector is installed. (If
you use an IP address it must be enclosed in square brackets.)

l <port number> = the port number used to access the server on which the RUM Server Collector is
installed, as configured in the RUM Server Collector (default 2002).

l <device name> = theWindows or Linux device name of the network card used to access the server on
which the RUM Server Collector is installed. Tomonitor all network cards, omit the <device name>
parameter completely.

Examples:

l Specific Windows device using IP: device rpcap://[172.23.61.71]:2002/\Device\WPRO_41_2001_
{8568244D-52DE-4CE5-97E7-6DDA2E86E16D}

l Specific Windows device using server name: device rpcap://myserver:2002/\Device\WPRO_41_
2001_{8568244D-52DE-4CE5-97E7-6DDA2E86E16D}

l Specific Linux device: device rpcap://[172.23.61.71]:2002/eth0
l All devices (Windows or Linux): device rpcap://[172.23.61.71]:2002/

Administering the RUM Server Collector Service
Note: The RUM Server Collector poses a significant impact on network performance and a slight impact
on the server's CPU. Therefore, use of the RUM Server Collector is limited to networks with very low
throughput and is mostly recommended for proof of concept (POC) purposes. For example, you can use
the RUM Server Collector if the network traffic is not high (150Mbps for windows and 250Mbps for
Linux) and if you are aware of the implications as noted above.

After installing the RUM Server Collector, the HPE RUM Server Collector service is automatically started.
You can administer the RUM Server Collector service as follows:

Windows:Start, stop, or restart the service from the services console.

Linux:Use the command /etc/init.d/rum_server-collector option

Valid options are start, stop, restart, or status.

RUM Server Collector Log File
To help troubleshoot problems, you can view the RUM Server Collector log file in the following locations:

Windows: <RUM Server Collector installation directory>\var\log\rum_collector\collector.log

Linux: <RUM Server Collector installation directory>/var/log/rum_collector/collector.log

Real User Monitor Administration Guide
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Note: The RUM Server Collector poses a significant impact on network performance and a slight impact
on the server's CPU. Therefore, use of the RUM Server Collector is limited to networks with very low
throughput and is mostly recommended for proof of concept (POC) purposes. For example, you can use
the RUM Server Collector if the network traffic is not high (150Mbps for windows and 250Mbps for
Linux) and if you are aware of the implications as noted above.
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Chapter 6: RUM Client Monitor Probe
The RUMClient Monitor Probe collects user experience data for your users. Unlike the RUM Sniffer Probe
that collects traffic by monitoring network packets using traffic duplication, the RUMClient Monitor Probe
receives data for monitored web or mobile applications directly from the client (end user).

The following diagram shows the conceptual difference between the RUM Sniffer Probe and the RUMClient
Monitor Probe:

You use different solutions for monitoring web andmobile applications with the RUMClient Monitor Probe:

l The RUM client monitor solution enables you tomonitor web applications through an end user's Internet
browser. For details, see "Using the RUMClient Monitor Solution toMonitorWeb Applications" on the
next page.

l The RUMmobile solution enables you tomonitor mobile applications through an app on an end user's
mobile device. For details, see "Using the RUMMobile Solution toMonitor Mobile Applications" on page
34.

Note: As the RUMClient Monitor Probemonitors traffic from the client side, reported data in EUM
reports is displayed for domains instead of running software elements.

Whenmonitoringmobile applications using Client Monitor Probes, RUM Engine creates a Running Software
CI. This CI is not labeled with an IP address since it is situated on the client side and RUM cannot determine
the server IP address. Therefore, RUM labels the CI with the application domain. When a crash occurs, RUM
cannot retrieve the domain name so the CI is labeled as application name_crash. You can filter out these
mobile application Running Software CIs.

HPE Real User Monitor (9.30) Page 31 of 258



Using the RUMClient Monitor Solution to Monitor
Web Applications
The RUM client monitor solution enables you tomonitor web applications through a user's Internet browser
and sends the collected data from the browser directly to the RUMClient Monitor Probe. The advantage of
monitoring traffic on the client side instead of the server side, is that themetrics aremore accurate as the
traffic includes data for the following:

l Proxies
l Content Delivery Networks (CDN)
l External sources (other servers than the one providing the HTML that provide external content such as
images)

Note: Data about failures, however, is not included as only successful pages are reported back to the
client.

You enable the RUM client monitor solution by installing a JavaScript snippet in the specific HTML pages you
want to monitor. This snippet is responsible for collecting performance data on the client machine and sending
the collected data to a specific RUMClient Monitor Probemachine. For details, see "Installing the JavaScript
Snippet" in the Real User Monitor Installation and UpgradeGuide.

Note:Whenmonitoring the HTML pages, time is only measured for slow components (less than 2
seconds). Size is not measured.

This section includes the following topics:

l "Supported Browsers" below
l "Getting Started with the RUM Client Monitor Probe" below
l "Configuring Applications in APM for the RUM Client Monitor Solution" on the next page

Supported Browsers
The RUM client monitor solution supports the following Internet browsers:

l Internet Explorer
l Google Chrome
l Firefox
l Safari
l Opera

Getting Started with the RUM Client Monitor Probe
To use the RUM client monitor solution with the RUMClient Monitor Probe, youmust:

1. Install the RUMClient Monitor Probe. For details, see "Installing the RUMClient Monitor Probe" in the
Real User Monitor Installation and UpgradeGuide.

2. Install the JavaScript snippet in the HTML pages you want to monitor. For details, see "Installing the
JavaScript Snippet" in the Real User Monitor Installation and UpgradeGuide.
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3. In APM, configure the web application whose pages you want to monitor. For details, see "Configuring
Applications in APM for the RUM Client Monitor Solution" below.

Configuring Applications in APM for the RUM Client Monitor Solution
When you configure a web application in End User Management in APM for monitoring by RUM, some of the
configuration settings are not applicable, or must be configured in a certain way, if the application is monitored
by a RUMClient Monitor Probe as opposed to a Sniffer Probe. The following table details the relevant
configuration settings:

Configuration
Setting Configured In Remarks

Session
Properties

RUM Session Page >
Session Properties Area

Youmust configure the following session properties,
although apart from the name, the rest of the session
property settings are not used:

l Operating System
l Browser

User Name
Detection

RUM Application General
Page > User Name
Detection Area

N/A. User name detection can be configured in the
JavaScript snippet.

Parameter
Extraction

RUM Application General
Page > Parameter
Extraction Area

N/A

TCP Settings RUM Application General
Page > TCP/Network
Settings Area

N/A. TCP data is not reported for applications configured for
the RUMClient Monitor Probe.

Session ID RUM Session Page >
Session Identification
Area

N/A. The RUMClient Monitor Probe uses its own
mechanism for user session tracking.

Exclude BPM
Data

RUMData Collection
Page > General Area

N/A

Sensitive
Data

RUMData Collection
Page > Sensitive Data
Area

N/A

Snapshots RUMData Collection
Page > Snapshot
Collection Area

N/A
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Configuration
Setting Configured In Remarks

Events RUM Application Events
Page

The following events are applicable to applications monitored
by the RUMClient Monitor Probe:

l Error Page
l Text Pattern - you configure the name of the text pattern
event in EUM, but define the actual text pattern settings
in the JavaScript snippet.

l Session Pages
l Page Size - the RUMClient Monitor Probe cannot
always determine page size.

l Page Time
All other events are not applicable to applications monitored
by the RUMClient Monitor Probe.

Using the RUMMobile Solution to Monitor Mobile
Applications
The RUM mobile solution enables you tomonitor mobile applications through apps on a user's mobile device
and sends the collected data from the app directly to the RUMClient Monitor Probe. The advantages of
monitoring traffic on the client side instead of the server side are:

l The user experience is measured including the latency of themobile network.
l Data is broken down by operating system, device, connection, and application version.
This section includes the following topics:

l "Supported Operating Systems" below
l "Supported Libraries" below
l "Getting Started with the RUM Client Monitor Probe" on the next page
l "Configuring Applications in APM for the RUM Mobile Solution" on the next page

Supported Operating Systems
The RUMmobile solution supports the following operating systems:

l Android 2.2 and later
l iOS 5 and later

Supported Libraries
Network data includes http(s) traffic only. The RUMmobile solutionmonitors the following libraries:

l iOS
l NSURLConnection (NSURLSession)

l AFNetworking
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l UIWebView andWKWebView

l Android
l HttpURLConnection

l ApacheHttpClient

l MultiDex

l HTML5 (in Hybrid applications)
l Page load time - Android version 4 and up only

l Ajax

Getting Started with the RUM Client Monitor Probe
To use the RUMmobile solution with the RUMClient Monitor Probe, youmust:

1. Install the RUMClient Monitor Probe. For details, see "Installing the RUMClient Monitor Probe" in the
Real User Monitor Installation and UpgradeGuide.

2. In APM, configure themobile application whose pages you want to monitor. For details, see "Configuring
Applications in APM for the RUM Mobile Solution" below.

3. Instrument themobile application. For details, see "InstrumentingMobile Apps for Android" and
"Instrumenting iOS Apps" in the Real User Monitor Installation and UpgradeGuide.

Note: Formore information onmonitoring hybrid apps, see "Monitoring Hybrid Applications" in the
Real User Monitor Installation and UpgradeGuide.

4. Sign themobile application and upload the application to the application store (for production
applications). For details, see "InstrumentingMobile Applications for Android" in the Real User Monitor
Installation and UpgradeGuide.

5. Install the instrumented application on amobile device.
6. Start and use the application.

Configuring Applications in APM for the RUM Mobile Solution
When you configure amobile application in End User Management in APM for monitoring by RUM, some of
the configuration settings are not applicable, or must be configured in a certain way, if the application is
monitored by a RUMClient Monitor Probe as opposed to a Sniffer Probe. The following table details the
relevant configuration settings:

Note:When you configure a new mobile application in End User Management, use theNetwork for
Mobile Application template.
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Configuration
Setting Configured In Remarks

Application
Location

RUMGeneral
Page >
Application
Location Area

Instead of configuring an application location using URLs or
IP addresses, you generate an application key that the probe uses to
link monitored data for amobile application, to the application
configured in APM.

Session
Properties

RUM Session
Page > Session
Properties Area

Applicable session properties are predefined in the Network for Mobile
Application template andmust not be changed.

User Name
Detection

RUM Application
General Page >
User Name
Detection Area

Configure user name extraction in the sameway as parameter
extraction (without configuring a parameter name). Instead of
configuring all, or specific login actions to search, you can configure
all, or specific URL patterns to search.

TCP Settings RUM Application
General Page >
TCP/Network
Settings Area

N/A. TCP data is not reported for applications configured for the RUM
Client Monitor Probe.

Session ID RUM Session
Page > Session
Identification
Area

N/A. The RUMClient Monitor Probe uses its ownmechanism for user
session tracking.

Exclude BPM
Data

RUMData
Collection Page
> General Area

N/A

Sensitive
Data

RUMData
Collection Page
> Sensitive Data
Area

N/A

Snapshots RUMData
Collection Page
> Snapshot
Collection Area

N/A

Events RUM Application
Events Page

N/A
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Chapter 7: Administering the RUM Engine
You administer RUM by using theWindows Start menu and a task bar icon, and use the RUM logs for
troubleshooting.

This chapter includes the following topics:

l "Administering RUMMonitor" below
l "RUM Logs" on the next page

Administering RUMMonitor
TheWindows Start menu options and the task bar icon that you use to administer RUM are installed during
theWindows installation of RUM.

This section includes the following topics:

l "RUMWindows Start Menu" below
l "RUM Engine Nanny" on the next page

RUMWindows Start Menu
To access the RUM Start menu that is added to theWindows machine on which the RUM Engine is installed,
select Start > Programs > RUM. Themenu includes the following options:

Administration

The Administrationmenu option includes the following options:

Option Description

RUMConfiguration
Tool

Runs the RUMConfiguration Tool, which enables you to create aMySQL database
schema, and to connect RUM to aMySQL database. For details, see "Creating and
Connecting to theMySQLDatabase" on page 173.

Database (only if the
MySQL database
has been installed)

Opens a submenu with options for starting and stopping theMySQL database on
themachine on which it is installed.

Disable RUM Stops RUM on the specific machine, and disables it from being run automatically
whenever themachine is started.

Enable RUM Starts RUM on the specific machine, and sets it to run automatically whenever the
machine is started.

Open RUM Web Console

Selecting this option opens the HPE web console used for administering HPE RUM. For details, see "Using
the RUMWebConsole" on page 41.
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RUM Engine Nanny
The RUM Engine nanny is responsible for starting and stopping RUM andmanaging the processes used by it.
The nanny runs as aWindows service.

When you enable or disable RUM using theWindows Start menu (Start > Programs > HPE Real User
Monitor > Administration) you start or stop the nanny service, which in turn starts or stops RUM. You can
see the status of RUM in the nanny JMX console.

To view the status of RUM:

1. Access the nanny JMX console using the following URL in a browser:
http://<RUM Engine machine name or IP address>:22735

2. When prompted for credentials, enter the same user name and password that are configured for the RUM
web console.

3. In theRUM.Nanny section, click RUM.Nanny:service=engine.
4. In the List of MBean attributes table, view the value for the Status attribute. Valid statuses for the RUM

Engine process are:
l Starting

l Started

l Stopping

l Stopped

l Failed

RUM Logs
RUM logs storemessages from RUMmodules and are used to troubleshoot problems, and to provide
information about the system’s operations. There are three types of logs: engine logs, jboss logs, and core
logs. The log files are located in the <Real User Monitor Engine root>\log directory.

This section includes:

l "Engine Logs" below
l "Jboss and Tomcat Logs" on the next page
l "Core Logs" on the next page

Engine Logs
Engine logs contain logmessages from the different processes. There are two types of engine log files:

l RUM Engine log files. Log files for modules within the RUM Engine.
l Repository log files. Log files for modules connecting the RUM Engine and its MySQL database.
There is a log for eachmodule and the RUM Engine saves up to 20 files for each log by default. When a file
reaches amaximum, default size of 3MB, a new log file is created automatically. Each time the RUM Engine
is restarted, it creates a new set of logs.
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The name of the RUM Engine log file consists of themodule name, log and the log file number. For example, a
module called clustermanagerwould produce the following log files:

clustermanager.log
clustermanager.log.1
clustermanager.log.2
...

The name of the repository log file consists of the log type (repository), themodule name, log and the log file
number. For example, a repository module called dataaccesslayerwould produce the following log files:

repository.dataaccesslayer.log
repository.dataaccesslayer.log.1
repository.dataaccesslayer.log.2
...

The structure of amessage in the log file is as follows: <timestamp> <invoking thread> <java class
name and line number> <message log level> <message content>. For example:

2005-08-03 14:20:32,953 [main] (NodesVerifierManager.java:185) INFO - Found primary
installation on current machine
2005-08-03 14:20:33,125 [main] (NodeVerifierServer.java:103) INFO - Got host
name=paddington from repository. Hostname ID=1

Jboss and Tomcat Logs
Jboss and Tomcat logmessages are written to the following files in the <Real User Monitor Engine
root>\log directory:

l jboss_boot.log. Logs startup activities including running the jboss process, deployment, and startup
status. If RUM fails to start, any problems are written to this log.

l jboss_server.log. Logs all jboss activities including jboss messages, deployment and startup status.
l jboss_tomcat.log. Logs the Tomcat messages.

Core Logs
Core logmessages are written to log files in the <Real User Monitor Engine root>\log\core directory.

The core log files contain messages about the general status of the application server on which the RUM
Engine is installed, and its services.
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Chapter 8: Using the RUMWeb Console
After the RUM Engine has been installed and started, you can use the RUM Engine web console to view and
configure the connection between RUM and APM, view other RUM Engine settings, monitor the health of
RUM components, and use RUM diagnostic tools.

This chapter includes the following topics:

l "Accessing the RUM EngineWebConsole" below
l "Monitoring the Health of RUMComponents" on page 44
l "RUMConfiguration and Settings" on page 99
l "APM Connection Settings" on page 100
l "ProbeManagement" on page 109
l "Advanced Settings" on page 127
l "Data Flow Probe Connection Settings" on page 127
l "System Info" on page 128
l "RUMDiagnostics Tools" on page 128

Accessing the RUM Engine Web Console
Use the RUM Engine web console tomonitor the health of RUM components. You can also use a number of
configuration tools to configure the RUM Engine, as well as view and configure the connection parameters
between RUM and APM. In addition, the RUMweb console includes diagnostic tools that you can use in
resolving RUM problems.

When you start the RUM Engine after installation, you can access the RUM Engine web console by launching
a web browser and entering the following URL: http://<RUM Engine machine name or IP>:8180.

When prompted, enter the JMX console authentication credentials (if you do not have these credentials,
contact your system administrator).

Note: On aWindows machine on which the RUM Engine is installed, you can also access the RUM
Engine web console by selectingStart > Programs > HPE Real User Monitor > Open Real User
Monitor Web Console.

This section includes the following topics:

l "Logging In" below
l "Logging Out" on the next page
l "Changing Login Parameters" on the next page
l "Changing the Language of the RUMWebConsole User Interface" on page 43
For information on supporting smart card authentication seeSupporting Smart Card Authentication in the Real
User Monitor Hardening Guide.

Logging In
When you access the RUM Engine web console, the login page opens.
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Enter the login parameters (login name and password) of a user defined in RUM, and click Log In. After
logging in, the user name appears at the top right, in the title bar.

Initial access can be gained using the default superuser login parameters: Login Name=admin,
Password=admin. We recommend that the system superuser change this password immediately to prevent
unauthorized entry. For details on changing the password, see "Changing Login Parameters" below.

The RUM Engine web console opens, displaying the topmenu bar that enables navigation to the
configuration, health, tools, and help pages, as well as the Logout button.

Note: After three, consecutive, bad log in attempts, you are locked out of the system for a period of time
set by your system superuser. Consult your system superuser for details.

Tip for system superusers:You set the lock out time in the usersLockoutTime parameter in the <RUM
root directory>\conf\rumwebconsole\rumwebconsole.xml file. We recommended that you limit
access to this file.

Logging Out
When you complete your session, we recommend that you log out of the web site to prevent unauthorized
entry, by clicking Logout at the top of the page.

Note: You are automatically logged out of the RUMweb console after 20minutes of inactivity.

Changing Login Parameters
You can add, change, and delete RUM users by editing the <RUM root
directory>\conf\rumwebconsole\users.xml file. In this file, there is a line for each user in the following
format:

<user login="admin" name="Administrator" password="encryptedPassword"
passwordEncrypted="true"/>

Note:

l We recommend that the system superuser limits access to the <RUM root
directory>\conf\rumwebconsole\users.xml file.

l Changes to the <RUM root directory>\conf\rumwebconsole\users.xml file only take effect when
the RUM Engine is restarted. When the RUM Engine is started, RUM encrypts the password, and
sets the passwordEncrypted parameter to true.

To add a RUM user:
1. Open the <RUM root directory>\conf\rumwebconsole\users.xml file in a text editor.
2. Duplicate the entry for one of the existing users.
3. In the duplicate line, enter the user name, login, and password parameters for the new user. Ensure

that the passwordEncrypted parameter is false.
4. Save the file.
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To change a RUM user:
1. Open the <RUM root directory>\conf\rumwebconsole\users.xml file in a text editor.
2. In the appropriate line, change the user name and login parameters as required.
3. To change a user’s password, enter the new password in the password parameter and ensure that the

passwordEncrypted parameter is false.
4. Save the file.

To delete a RUM user:
1. Open the <RUM root directory>\conf\rumwebconsole\users.xml file in a text editor.
2. Delete the appropriate line.
3. Save the file.

Note:When deleting users, ensure that there is at least one user configured in the users file, or you are
unable to access the RUMweb console.

Changing the Language of the RUMWeb Console User
Interface
The RUMweb console user interface can be viewed in the following languages in your web browser:

Language Language Preference in Web Browser

Chinese Chinese (China) [zh-cn]

English English (United States) [en-us]

French French (France) [fr]

German German (Germany) [de]

Japanese Japanese [ja]

Korean Korean [ko]

Russian Russian (Russia) [ru]

Spanish Spanish (Spain) [es]

Use the language preference option in your browser to select how to view the RUMweb console. The
language preference chosen affects only the user’s local machine and not the RUMmachines or any other
user accessing the sameRUMweb console. The language is determined when you log in to the RUMweb
console; changing the language preference in your browser once you have logged in has no effect until you log
out and log back in.

To view the RUM web console in a specific language using Internet Explorer:

1. Select Tools > Internet Options and click Languages. The Language Preference dialog box opens.
2. Select the language in which you want to view the RUMweb console.
3. If the language you want is not listed in the dialog box, click Add to display the list of languages. Select

the language you want to add and click OK.
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4. Click Move Up to move the selected language to the first row.
5. Click OK to save the settings.
6. Refresh the page: the RUMweb console user interface is displayed in the selected language.

Note:

l Starting from RUM version 7.0, there is no language pack installation. All translated languages are
integrated into the RUMMultilingual User Interface.

l Data stays in the language in which it was entered, even if the language of the web browser changes.
Changing the language of the web browser on your local machine does not change the language of
RUM definitions and configurations.

l If a user selects a language not supported by the RUMMultilingual User Interface, the RUMweb
console user interface appears in English.

Changing Timeout Parameters
You can enable a RUMWebConsole user session to time out after a defined period of inactivity. When this
feature is enabled, a RUMWebConsole user is logged out after the defined period of inactivity. Only active
user actions like browsing, clicking, or refreshing pages are considered to be user activities.

To enable the RUMWebConsole user session to time out:

1. Open the <RUM root directory>\conf\common\common.properties file.
2. Locate the parameterEnableWebConsoleUserSessionTimeout and set it to true.
3. The default period of inactivity is 1200 seconds (20minutes). To change the period of inactivity, locate

the parameterWebConsoleUserSessionTimeout and set a new timeout value in seconds.

Note: Youmust restart RUM for the changes to take effect.

Monitoring the Health of RUMComponents
TheHealth drop-downmenu on the RUM Engine web consolemenu bar includes options for displaying the
status of themain RUM components and for creating a zip file of the RUM resource and log files for use by
HPE Software Support.

This section includes:

l "System Health" below
l "Capture Log Files" on page 99

System Health
You use theSystem Healthmenu option to display the status of themain RUM components. When you
select this option, the System Health page opens. For each component displayed on the System Health page,
there are four possible statuses:

OK
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Minor

Critical

No status

You can drill down to see the status of the entities that comprise the RUM component by clicking the
component name.

For each entity displayed, apart from the columns included in the tables below, there is a column calledValue
(Value Since Startup). If an entity is configured to display a value, it is displayed in this column either as an
absolute value (for example, the number of pages published), or as a ratio showing a value for a given time
period (for example, the number of session events per second). An additional absolute valuemay be displayed
in brackets, which is the accumulated value of the entity since the RUM Engine was last started.

Note: Entities using ratios have no status until the System Health page has been automatically updated
twice by the RUM Engine. This can take several moments (by default, up to six minutes).

The following components are displayed in the System Health page and the table for each lists the included
entities and describes themeaning of the different statuses:

l "Configuration Retrieval From APM Server" below
l "Database" on the next page
l "RUM Sniffer Probe" on page 48
l "RUM Client Monitor Probe" on page 76
l "RUM Engine" on page 81
l "Samples to APM Server" on page 91
l "Data Access Layer" on page 92
l "PartitionManager" on page 94
l "Topology Engine" on page 94
l "MissingMirrored Data" on page 99

Configuration Retrieval From APM Server

Entity Description
OK Status
(Green)

Minor
Status
(Yellow)

Critical Status
(Red) Troubleshooting

Connection
to APM
server

Status of the
connection to the
APMGateway
Server for
retrieving RUM
Engine and Probe
configurations

Connection
to APM
server is
operational

N/A Connection to
APM server is
not operational

Check the
<HPRUM>/log/config.
manager.log file
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Entity Description
OK Status
(Green)

Minor
Status
(Yellow)

Critical Status
(Red) Troubleshooting

Data type
<type
name>
retrieval

Status of the last
attempt to retrieve
data type <type
name>
configuration from
the APMGateway
Server

Configuration
of data type
<type name>
successfully
retrieved
from APM
server

N/A Errors while
trying to
retrieve
configuration
data type <type
name> from
APM server

l Check the
<HPRUM>/log/
config.manager.log
file

l Files in the
<HPRUM>/log/
configuration
/dataType folder
describe the
configuration
retrieved for each
data type

Database

Entity Description
OK Status
(Green)

Minor
Status
(Yellow)

Critical
Status (Red) Troubleshooting

Database
connectivity

Status of the
connectivity
between the
RUM Engine and
theMySQL
database

Connection
to database
OK

N/A Connection
to database
not working

l Check that theMySQL
service is running.

l Check the following
files:
l < HPRUM_DATA>
\<hostname>.err

l <HPRUM>\log\
repository.
dataaccesslayer.log

Database
free space

Percentage of
free space
(including free
space in the
tablespace) on
the disk on which
theMySQL
database is
installed

More than
4% is free.

3–4% is
free.

Less than
3% is free.

l Increase disk space
l Remove heavy
configuration items
(such as snapshots,
clickstream, and
extracted parameters)
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Entity Description
OK Status
(Green)

Minor
Status
(Yellow)

Critical
Status (Red) Troubleshooting

Database
Response
Time

Status of the
response time
between the
RUM Engine and
theMySQL
database

Database
response
time is
normal

Database
response
time is
below
normal

Database
response
time is slow

l Remove database files
from anti-virus software
configurations

l If the database is
installed on a virtual
system (VMware) and
the disk is loaded,
relocate the database
machine to another ESX.

Database
Session
Purging
Time

The length of time
taken to purge old
sessions from the
database

Purging time
is normal

Purging
time is
slow

N/A

Number of
stale
queries

The number of
database queries
aborted because
they were stale
(running for too
long a period)

N/A N/A N/A l Remove database files
from anti-virus software
configurations

l If the database is
installed on a virtual
system (VMware) and
the disk is loaded,
relocate the database
machine to another ESX.
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RUM Sniffer Probe

Entity
Descrip
tion

OK
Status
(Gree
n)

Minor
Statu
s
(Yello
w)

Critic
al
Status
(Red) Troubleshooting

100
Continu
e Hits

Opens a
page
that
displays
for each
monitore
d web
applicati
on, the
number
of 100
Continu
e Hit
messag
es
received
by the
web
servers
from
clients

N/A N/A N/A

Active
Connect
ions

The
number
of active
TCP
connecti
ons
currently
monitore
d by the
RUM
Probe

The
numbe
r of
active
TCP
conne
ctions
is
below
the
interna
l
permit
ted
numbe
r

The
numb
er of
active
TCP
conne
ctions
is
close
to the
intern
al
permit
ted
numb
er

The
numbe
r of
active
TCP
conne
ctions
has
excee
ded
the
interna
l
permitt
ed
numbe
r

l Disable traffic discovery, if it is running.
l Verify that monitored traffic does not exceed sizing
recommendations.
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Entity
Descrip
tion

OK
Status
(Gree
n)

Minor
Statu
s
(Yello
w)

Critic
al
Status
(Red) Troubleshooting

Active
Session
s

The
number
of
session
s
currently
monitore
d by the
RUM
Probe

The
numbe
r of
active
sessio
ns is
below
the
interna
l
permit
ted
numbe
r

The
numb
er of
active
sessi
ons is
close
to the
intern
al
permit
ted
numb
er

The
numbe
r of
active
sessio
ns has
excee
ded
the
interna
l
permitt
ed
numbe
r

Check session configuration. In the RUM web console,
Use ProbeManagement > Session ID Detection.

Bytes
received
for
protocol
<type>

The
number
of bytes
received
by the
servers
from
clients
for the
protocol
<type>

N/A N/A N/A

Bytes
sent for
protocol
<type>

The
number
of bytes
sent by
the
servers
to
clients
for the
protocol
<type>

N/A N/A N/A
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Entity
Descrip
tion

OK
Status
(Gree
n)

Minor
Statu
s
(Yello
w)

Critic
al
Status
(Red) Troubleshooting

Channel
"connec
tions"
Status

Status
of the
last
attempt
to
connect
to the
channel

The
RUM
Engine
has
succe
ssfully
conne
cted to
this
probe
chann
el

The
RUM
Engin
e
experi
enced
proble
ms
while
conne
cting
to this
probe
chann
el

The
RUM
Engine
has
failed
to
conne
ct to
this
probe
chann
el
more
than
three
conse
cutive
times

Possible causes:

l Connectivity problem
l Configuration problem
l Two engines connected to the same probe (in such a
case there will be an error message in the probe
capture log file - C:\HPRumProbe\
output\log\
capture.log)

Channel
"missing
compon
ents"
Status

Status
of the
last
attempt
to
connect
to the
channel

The
RUM
Engine
has
succe
ssfully
conne
cted to
this
probe
chann
el

The
RUM
Engin
e
experi
enced
proble
ms
while
conne
cting
to this
probe
chann
el

The
RUM
Engine
has
failed
to
conne
ct to
this
probe
chann
el
more
than
three
conse
cutive
times
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Entity
Descrip
tion

OK
Status
(Gree
n)

Minor
Statu
s
(Yello
w)

Critic
al
Status
(Red) Troubleshooting

Channel
"pages"
Status

Status
of the
last
attempt
to
connect
to the
channel

The
RUM
Engine
has
succe
ssfully
conne
cted to
this
probe
chann
el

The
RUM
Engin
e
experi
enced
proble
ms
while
conne
cting
to this
probe
chann
el

The
RUM
Engine
has
failed
to
conne
ct to
this
probe
chann
el
more
than
three
conse
cutive
times

Channel
"poorRe
quests"
Status

Status
of the
last
attempt
to
connect
to the
channel

The
RUM
Engine
has
succe
ssfully
conne
cted to
this
probe
chann
el

The
RUM
Engin
e
experi
enced
proble
ms
while
conne
cting
to this
probe
chann
el

The
RUM
Engine
has
failed
to
conne
ct to
this
probe
chann
el
more
than
three
conse
cutive
times
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Entity
Descrip
tion

OK
Status
(Gree
n)

Minor
Statu
s
(Yello
w)

Critic
al
Status
(Red) Troubleshooting

Channel
"session
s"
Status

Status
of the
last
attempt
to
connect
to the
channel

The
RUM
Engine
has
succe
ssfully
conne
cted to
this
probe
chann
el

The
RUM
Engin
e
experi
enced
proble
ms
while
conne
cting
to this
probe
chann
el

The
RUM
Engine
has
failed
to
conne
ct to
this
probe
chann
el
more
than
three
conse
cutive
times

Configur
ation to
Probe

Status
of the
last
attempt
to send
the
configur
ation to
the
RUM
Probe

Probe
was
config
ured
succe
ssfully

N/A Errors
during
probe
config
uration
proces
s

l Check the connection to the probe
l Check for errors in the <HPRUM>\log\
config.-
manager.log file

Connect
ion to
Probe

Status
of the
http
connecti
on from
the
RUM
Engine
to the
RUM
Probe

The
conne
ction
is
succe
ssful

N/A There
is no
conne
ction
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Entity
Descrip
tion

OK
Status
(Gree
n)

Minor
Statu
s
(Yello
w)

Critic
al
Status
(Red) Troubleshooting

Disk
Utilizati
on for

The
RUM
Probe
disk
utilizatio
n on a
specific
partition

Free
disk
space
is
suffici
ent

Free
disk
space
is
nearin
g its
limit

Free
disk
space
is
insuffi
cient

You can reduce disk size utilized by the Probe by
disabling snapshot collection in EUM Administration.

Incompl
ete
Transac
tions

The
percenta
ge of
incompl
ete
packets
(that is,
requests
without
respons
es). A
high
number
can
indicate
a
problem
with a
switch,
or with a
probe’s
network
configur
ation.

N/A N/A N/A l If the Probe gives a response code 202 and the server
time is 0, see troubleshooting for MissingMirrored
Data.

l If you are using a switch, ensure that both TX and RX
are configured. You can trace this using a sniffer.

l If the time to first buffer (the time between the request
and the beginning of the response) is greater than two
minutes, increase the following processor
configuration values in the Probe's Beatbox_Default_
Const_Configuration.xml file:
l encrypted_request_timeout (seconds)

l unencrypted_request_timeout (seconds)
Create a pcap and open it with a tcp.analysis.lost_
segment filter. Validate that there are no such
packets.
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Entity
Descrip
tion

OK
Status
(Gree
n)

Minor
Statu
s
(Yello
w)

Critic
al
Status
(Red) Troubleshooting

IPv6
address
parsing

The
ability of
the
probe to
code
and
decode
IPv6
address
es

No
IPv6
applic
ation
is
define
d, or
an
IPv6
applic
ation
is
define
d and
an
IPv6
interfa
ce is
presen
t on
the
probe
machi
ne

N/A An
IPv6
applic
ation
is
define
d, but
no
IPv6
interfa
ce is
presen
t on
the
probe
machi
ne

Probable cause is that the RUM Probe has an IPv6
application, but no IPv6 network driver is activated and
the Probemay not be able to parse IPv6 data correctly.

Lost
SSL
Request
s

The
percenta
ge of
SSL
requests
for
which
the
decrypti
on
failed.

N/A N/A N/A View the failure reason in the RUMweb console > SSL
Keystoremanagement.
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Entity
Descrip
tion

OK
Status
(Gree
n)

Minor
Statu
s
(Yello
w)

Critic
al
Status
(Red) Troubleshooting

Missing
Mirrored
Data

Click
Missing
Mirrored
Data to
see the
entities
that
compris
e the
Missing
Mirrored
Data
compon
ent.

High rates of lost mirror packets result in incomplete data
in RUM reports, especially for SSL applications. Contact
your network administrator to check the network
mirroring configuration.

When using a switch, consider using a network tap.

Network
Capture
s
Retrieve
r Queue
Size

The
queue
size of
the
probe’s
network
capture
files.

N/A N/A N/A

Orphan
Applicati
on Hits

Opens a
page
that
displays
for each
monitore
d
applicati
on, the
percenta
ge of
page
compon
ents that
could
not be
correlate
d to a
specific
page

N/A N/A N/A Check session configuration. In the RUM web console,
Use ProbeManagement > Session ID Detection.
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Entity
Descrip
tion

OK
Status
(Gree
n)

Minor
Statu
s
(Yello
w)

Critic
al
Status
(Red) Troubleshooting

Packet
Queue
Work

The
current
number
of
packets
that
have
been
collecte
d from
the
network
devices,
but have
not yet
been
process
ed

The
packet
rate is
normal

The
packe
t rate
is
nearin
g the
limit
for
norma
l
proce
ssing

The
packet
rate is
too
high

Verify that monitored traffic does not exceed sizing
recommendations.

Packets
filtered
IPv4

The
number
of IPv4
packets
that
were
filtered
(that is,
that
reached
the
probe,
but were
not
process
ed)

N/A N/A N/A
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Entity
Descrip
tion

OK
Status
(Gree
n)

Minor
Statu
s
(Yello
w)

Critic
al
Status
(Red) Troubleshooting

Packets
filtered
IPv6

The
number
of IPv6
packets
that
were
filtered
(that is,
that
reached
the
probe,
but were
not
process
ed)

N/A N/A N/A

Packets
filtered
sum

The total
number
of
packets
(IPv4
and
IPv6)
that
were
filtered
(that is,
that
reached
the
probe,
but were
not
process
ed)

N/A N/A N/A
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Entity
Descrip
tion

OK
Status
(Gree
n)

Minor
Statu
s
(Yello
w)

Critic
al
Status
(Red) Troubleshooting

Packets
lost IPv4

The
percenta
ge of
IPv4
packets
that the
RUM
Probe
has
recogniz
ed as
missing

< 1% >= 1%
< 3%

>= 3% High rates of lost mirror packets result in incomplete data
in RUM reports, especially for SSL applications. Contact
your network administrator to check the network
mirroring configuration.

When using a switch, consider using a network tap.

Packets
lost IPv6

The
percenta
ge of
IPv6
packets
that the
RUM
Probe
has
recogniz
ed as
missing

< 1% >= 1%
< 3%

>= 3%

Packets
lost sum

The
percenta
ge of
total
packets
(IPv4
and
IPv6)
that the
RUM
Probe
has
recogniz
ed as
missing

< 1% >= 1%
< 3%

>= 3%
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Entity
Descrip
tion

OK
Status
(Gree
n)

Minor
Statu
s
(Yello
w)

Critic
al
Status
(Red) Troubleshooting

Packets
process
ed IPv4

The
number
of IPv4
packets
that
were
process
ed

N/A N/A N/A

Packets
process
ed IPv6

The
number
of IPv6
packets
that
were
process
ed

N/A N/A N/A

Packets
process
ed sum

The total
number
of
packets
(IPv4
and
IPv6)
that
were
process
ed

N/A N/A N/A

Packets
with bad
checksu
m

The
percenta
ge of
packets
with bad
checksu
ms

N/A N/A N/A If the RUM Probe is on a client/server machine, edit the
< HPRUM>\conf\ configurationmanager
\Beatbox_Default_Const_Configuration.xml file and in
the <static_global_params> section change the global_
skip_checksum value to true. The checksum is
calculated only after passing the network card.
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Entity
Descrip
tion

OK
Status
(Gree
n)

Minor
Statu
s
(Yello
w)

Critic
al
Status
(Red) Troubleshooting

Pages
Cached

The
number
of page
views
currently
being
cached
to the
RUM
Probe’s
memory

The
page
rate is
stable

The
page
rate is
nearin
g the
limit
for
norma
l
cachi
ng

The
page
rate is
too
high

Verify that monitored traffic does not exceed sizing
recommendations.

Pages
Channel
Process
ing
Delay

Displays
the
differenc
e
between
the time
a page
hit was
received
by the
probe to
when it
was
reported
to the
RUM
Engine

N/A N/A N/A l Check that the number of pages/sec is within Engine
sizing guidelines.

l The connection between the Engine and the Probe is
slow, or the Engine needs a lot of time to connect to
the Probe using SSH:
l Check the bandwidth between the Engine and the
Probe.

l Check the <HPRUM>\log\
bbretriever.log file.

Real User Monitor Administration Guide
Chapter 8: Using the RUMWebConsole

HPE Real User Monitor (9.30) Page 60 of 258



Entity
Descrip
tion

OK
Status
(Gree
n)

Minor
Statu
s
(Yello
w)

Critic
al
Status
(Red) Troubleshooting

Plain
Bytes
Receive
d

The total
number
of non
SSL
bytes
received
by the
servers
from
clients

The
current
load of
http
receiv
ed
traffic
is
normal

N/A The
current
load of
http
receiv
ed
traffic
is too
high
for a
single
RUM
Probe

The Probemay be processing toomuch traffic. Check
the sizing guidelines.

Plain
Bytes
Sent

The total
number
of non
SSL
bytes
sent by
the
servers
to
clients

The
current
load of
http
sent
traffic
is
normal

N/A The
current
load of
http
sent
traffic
is too
high
for a
single
RUM
Probe

Plain
Packets

The total
number
of non
SSL
packets
process
ed by
the
RUM
Probe

The
http
packet
rate is
normal

N/A The
http
packet
rate is
too
high
for a
single
RUM
Probe
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Entity
Descrip
tion

OK
Status
(Gree
n)

Minor
Statu
s
(Yello
w)

Critic
al
Status
(Red) Troubleshooting

Probe
and
Engine
Time
Differen
ce

Displays
the
status of
the time
synchro
nization
between
the
RUM
Engine
and
Probe

The
RUM
Engine
and
Probe
are in
sync

The
RUM
Engin
e and
Probe
are
slightl
y out
of
sync

The
RUM
Engine
and
Probe
are
grossl
y out
of
sync

l Compare system time and time zone on the APM,
RUM Engine, and RUM Probe servers. They should
display the current time +/- 2minutes.

l If the APM server is deployed on a virtual machine
(VM), check the APMGateway JMX (http://<APM_
Gateway_
Server>:29000/mbean?objectname=Mercury%3A
service%3DDate%2FTime+Manager).
TheGMTTime should display the current time in
terms of GMT+0. An incorrect time indicates a time
drift on the ESX server hosting the VM.
To resolve this problem:
l Contact the ESX server admins.
or

l Resolve the time difference locally on the RUM
Engine as follows:
i. In a text editor, open the file

<HPRUM>\conf\common\common.prope
rties

ii. Locate the line TimeService=BAC and
change it to TimeService=LOCAL

Probe
Channel
rum-
compon
ents
Guarant
ee
Delivery
Files
Total
Size

The total
size of
compon
ent
channel
files on
the
RUM
Probe

N/A N/A N/A
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Entity
Descrip
tion

OK
Status
(Gree
n)

Minor
Statu
s
(Yello
w)

Critic
al
Status
(Red) Troubleshooting

Probe
Channel
rum-
compon
ents
Total
Guarant
ee
Delivery
Files

The
number
of
guarante
ed
delivery
files for
the
compon
ents
channel
waiting
to be
read by
the
RUM
Engine

The
numbe
r of
compo
nent
chann
el files
is
normal

The
numb
er of
comp
onent
chann
el files
is
high,
indica
ting
that
the
RUM
Engin
e
might
be
proce
ssing
less
data
than
the
RUM
Probe
is
produ
cing

N/A The Probe is handling traffic faster than the Engine can
read and process data from the Probe. Check sizing
guidelines.

Probe
Channel
rum-
connecti
ons
Guarant
ee
Delivery
Files
Total
Size

The total
size of
connecti
on
channel
files on
the
RUM
Probe

N/A N/A N/A
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Entity
Descrip
tion

OK
Status
(Gree
n)

Minor
Statu
s
(Yello
w)

Critic
al
Status
(Red) Troubleshooting

Probe
Channel
rum-
connecti
ons
Total
Guarant
ee
Delivery
Files

The
number
of
guarante
ed
delivery
files for
the
connecti
ons
channel
waiting
to be
read by
the
RUM
Engine

The
numbe
r of
conne
ction
chann
el files
is
normal

The
numb
er of
conne
ction
chann
el files
is
high,
indica
ting
that
the
RUM
Engin
e
might
be
proce
ssing
less
data
than
the
RUM
Probe
is
produ
cing

N/A The Probe is handling traffic faster than the Engine can
read and process data from the Probe. Check sizing
guidelines.

Probe
Channel
rum-
pages
Guarant
ee
Delivery
Files
Total
Size

The total
size of
page
channel
files on
the
RUM
Probe

N/A N/A N/A
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Entity
Descrip
tion

OK
Status
(Gree
n)

Minor
Statu
s
(Yello
w)

Critic
al
Status
(Red) Troubleshooting

Probe
Channel
rum-
pages
Total
Guarant
ee
Delivery
Files

The
number
of
guarante
ed
delivery
files for
the
pages
channel
waiting
to be
read by
the
RUM
Engine

The
numbe
r of
page
chann
el files
is
normal

The
numb
er of
page
chann
el files
is
high,
indica
ting
that
the
RUM
Engin
e
might
be
proce
ssing
less
data
than
the
RUM
Probe
is
produ
cing

N/A The Probe is handling traffic faster than the Engine can
read and process data from the Probe. Check sizing
guidelines.

Probe
Channel
rum-
poor-
requests
Guarant
ee
Delivery
Files
Total
Size

The total
size of
poor-
request
channel
files on
the
RUM
Probe

N/A N/A N/A

Real User Monitor Administration Guide
Chapter 8: Using the RUMWebConsole

HPE Real User Monitor (9.30) Page 65 of 258



Entity
Descrip
tion

OK
Status
(Gree
n)

Minor
Statu
s
(Yello
w)

Critic
al
Status
(Red) Troubleshooting

Probe
Channel
rum-
poor-
requests
Total
Guarant
ee
Delivery
Files

The
number
of
guarante
ed
delivery
files for
the poor-
requests
channel
waiting
to be
read by
the
RUM
Engine

The
numbe
r of
poor-
reques
t
chann
el files
is
normal

The
numb
er of
poor-
reque
st
chann
el files
is
high,
indica
ting
that
the
RUM
Engin
e
might
be
proce
ssing
less
data
than
the
RUM
Probe
is
produ
cing

N/A The Probe is handling traffic faster than the Engine can
read and process data from the Probe. Check sizing
guidelines.

Probe
Channel
rum-
session
s
Guarant
ee
Delivery
Files
Total
Size

The total
size of
session
channel
files on
the
RUM
Probe

N/A N/A N/A
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Entity
Descrip
tion

OK
Status
(Gree
n)

Minor
Statu
s
(Yello
w)

Critic
al
Status
(Red) Troubleshooting

Probe
Channel
rum-
session
s Total
Guarant
ee
Delivery
Files

The
number
of
guarante
ed
delivery
files for
the
session
s
channel
waiting
to be
read by
the
RUM
Engine

The
numbe
r of
sessio
n
chann
el files
is
normal

The
numb
er of
sessi
on
chann
el files
is
high,
indica
ting
that
the
RUM
Engin
e
might
be
proce
ssing
less
data
than
the
RUM
Probe
is
produ
cing

N/A The Probe is handling traffic faster than the Engine can
read and process data from the Probe. Check sizing
guidelines.

Probe
Channel
s Data
Flow

Status
of
retrievin
g data
from the
RUM
Probe

Data
from
the
probe
succe
ssfully
retriev
ed

Probe
has
not
produ
ced
new
data
for
some
time

N/A Problem with the connection between the RUM Engine
and the RUM Probe, or problems with one or more
channels on the Probe side:

l Check the <HPRUM>\log\
bbretriever.log file

l Try to restart the RUM Probe
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Entity
Descrip
tion

OK
Status
(Gree
n)

Minor
Statu
s
(Yello
w)

Critic
al
Status
(Red) Troubleshooting

Probe
Connect
ions
Publishe
d

The
number
of
connecti
ons
recorded
by the
RUM
Probe

N/A N/A N/A

Probe
Connect
ions
Process
ed by
Engine

The
number
of
connecti
ons that
the
RUM
Engine
has
started
to
process

N/A N/A N/A

Probe
has
been
Restarte
d

"1"
indicate
s that
the
RUM
Probe
was
restarted
in the
last
measure
d
interval
(5
minutes
by
default).

Alway
s
green

N/A N/A
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Entity
Descrip
tion

OK
Status
(Gree
n)

Minor
Statu
s
(Yello
w)

Critic
al
Status
(Red) Troubleshooting

Probe
Page
Hits

The
number
of page
hits
recorded
by the
RUM
Probe

N/A N/A N/A

Probe
Page
Hits
Process
ed by
Engine

The
number
of page
hits that
the
RUM
Engine
has
started
to
process

N/A N/A N/A

Probe
Process
CPU
Utilizati
on

The
current
percenta
ge of
probe
utilizatio
n of the
probe
process

Probe
utilizat
ion is
normal

Probe
utiliza
tion is
nearin
g the
limit
for a
single
RUM
Probe

N/A The Probemay be processing toomuch traffic. Check
the sizing guidelines.

Probe
Process
Memory

The total
amount
of non-
swappe
d,
physical
memory
used by
the
RUM
Probe, in
kilobyte
s

Alway
s

N/A N/A
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Entity
Descrip
tion

OK
Status
(Gree
n)

Minor
Statu
s
(Yello
w)

Critic
al
Status
(Red) Troubleshooting

Probe
Process
Memory
Utilizati
on

The total
amount
of non-
swappe
d
physical
memory
used by
the
probe
process,
out of
the total
amount
of
physical
system
memory,
in
kilobyte
s

Memo
ry
utilizat
ion is
normal

Memo
ry
utiliza
tion is
high

Memor
y
utilizat
ion is
nearin
g the
maxim
um
permis
sible
value

The Probemay be processing toomuch traffic. Check
the sizing guidelines.

Probe
Storage
ccomps
Number
of Errors

The
number
of non
critical
errors for
compon
ents that
occurred
when
working
with the
databas
e

N/A N/A N/A

Real User Monitor Administration Guide
Chapter 8: Using the RUMWebConsole

HPE Real User Monitor (9.30) Page 70 of 258



Entity
Descrip
tion

OK
Status
(Gree
n)

Minor
Statu
s
(Yello
w)

Critic
al
Status
(Red) Troubleshooting

Probe
Storage
ccomps
Number
of Total
Records

The total
number
of
records
for
compon
ents in
the
databas
e

N/A N/A N/A

Probe
Storage
ccomps
Status

The
current
status of
the
databas
e for
compon
ents

Datab
ase
status
is
normal

N/A Datab
ase
status
is bad

Probe
Storage
mainpag
edb
Number
of Errors

The
number
of non
critical
errors for
main
pages
that
occurred
when
working
with the
databas
e

N/A N/A N/A

Probe
Storage
mainpag
edb
Number
of Total
Records

The total
number
of
records
for main
pages in
the
databas
e

N/A N/A N/A
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Entity
Descrip
tion

OK
Status
(Gree
n)

Minor
Statu
s
(Yello
w)

Critic
al
Status
(Red) Troubleshooting

Probe
Storage
mainpag
edb
Status

The
current
status of
the
databas
e for
main
pages

Datab
ase
status
is
normal

N/A Datab
ase
status
is bad

Probe
Storage
pcapnet
work
Number
of Errors

The
number
of non
critical
errors for
network
captures
that
occurred
when
working
with the
databas
e

N/A N/A N/A

Probe
Storage
pcapnet
work
Number
of Total
Records

The total
number
of
records
for
network
captures
in the
databas
e

N/A N/A N/A

Probe
Storage
pcapnet
work
Status

The
current
status of
the
databas
e for
network
captures

Datab
ase
status
is
normal

N/A Datab
ase
status
is bad
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Entity
Descrip
tion

OK
Status
(Gree
n)

Minor
Statu
s
(Yello
w)

Critic
al
Status
(Red) Troubleshooting

Probe
Total
Traffic

The
amount
of traffic
which
passed
the
kernel
filter and
came to
the
probe for
further
analysis

N/A N/A N/A

Receive
d Bytes
on
Network
Device

The total
number
of bytes
received
per
specific
NIC, in
bits per
second

Netwo
rk
device
load is
normal

Netw
ork
device
load is
nearin
g the
probe’
s limit

N/A
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Entity
Descrip
tion

OK
Status
(Gree
n)

Minor
Statu
s
(Yello
w)

Critic
al
Status
(Red) Troubleshooting

SSL
Bytes
Receive
d

The total
number
of ssl
bytes
received
by the
servers
from
clients

The
current
load of
https
receiv
ed
traffic
is
normal

N/A The
current
load of
https
receiv
ed
traffic
is too
high
for a
single
RUM
Probe

The Probemay be processing toomuch traffic. Check
the sizing guidelines.

SSL
Bytes
Sent

The total
number
of ssl
bytes
sent by
the
servers
to
clients

The
current
load of
https
sent
traffic
is
normal

N/A The
current
load of
https
sent
traffic
is too
high
for a
single
RUM
Probe

SSL
Packets

The total
number
of ssl
packets
process
ed by
the
RUM
Probe

The
https
packet
rate is
normal

N/A The
https
packet
rate is
too
high
for a
single
RUM
Probe
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Entity
Descrip
tion

OK
Status
(Gree
n)

Minor
Statu
s
(Yello
w)

Critic
al
Status
(Red) Troubleshooting

Total
Memory

The total
amount
of
physical
system
memory,
in
kilobyte
s

Alway
s

N/A N/A

SSL
Transac
tions
Dropped

The
percenta
ge of
SSL
transacti
ons that
could be
decrypte
d

N/A N/A N/A
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Entity
Descrip
tion

OK
Status
(Gree
n)

Minor
Statu
s
(Yello
w)

Critic
al
Status
(Red) Troubleshooting

XFF
over
NAT

Value
can be 0
or 1. If 1,
the
value of
“x-
forwarde
r-for”
http
header
has
different
values
within
the
same
connecti
on. Can
indicate
differenc
es
between
http and
TCP
reports
on the
same
applicati
on.

N/A N/A N/A

RUM Client Monitor Probe

Entity Description
OK Status
(Green)

Minor
Status
(Yellow)

Critical
Status (Red) Troubleshooting

Active
Sessions

The number of
sessions
currently
monitored by
the RUM Probe

The number
of active
sessions is
below the
internal
permitted
number

The number
of active
sessions is
close to the
internal
permitted
number

The number of
active
sessions has
exceeded the
internal
permitted
number
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Entity Description
OK Status
(Green)

Minor
Status
(Yellow)

Critical
Status (Red) Troubleshooting

Active
Sessions per
Application

The number of
sessions for a
specific
application
currently
monitored by
the RUM Probe

The number
of active
sessions is
below the
internal
permitted
number

The number
of active
sessions is
close to the
internal
permitted
number

The number of
active
sessions has
exceeded the
internal
permitted
number

Check session
configuration. In the
RUM web console,
Use Probe
Management >
Session ID Detection.
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Entity Description
OK Status
(Green)

Minor
Status
(Yellow)

Critical
Status (Red) Troubleshooting

Channel "cbd"
Status

Status of the
last attempt to
connect to the
channel

The RUM
Engine has
successfully
connected
to this probe
channel

The RUM
Engine
experienced
problems
while
connecting
to this probe
channel

The RUM
Engine has
failed to
connect to this
probe channel
more than
three
consecutive
times

Possible causes:

l Connectivity
problem

l Configuration
problem

l Two engines
connected to the
same probe (in
such a case there
will be an error
message in the
probe capture log
file -
C:\HPRumProbe\
output\log\
capture.log)

Channel
"connections"
Status

Status of the
last attempt to
connect to the
channel

The RUM
Engine has
successfully
connected
to this probe
channel

The RUM
Engine
experienced
problems
while
connecting
to this probe
channel

The RUM
Engine has
failed to
connect to this
probe channel
more than
three
consecutive
times

Channel
"missing
components"
Status

Status of the
last attempt to
connect to the
channel

The RUM
Engine has
successfully
connected
to this probe
channel

The RUM
Engine
experienced
problems
while
connecting
to this probe
channel

The RUM
Engine has
failed to
connect to this
probe channel
more than
three
consecutive
times

Channel
"pages" Status

Status of the
last attempt to
connect to the
channel

The RUM
Engine has
successfully
connected
to this probe
channel

The RUM
Engine
experienced
problems
while
connecting
to this probe
channel

The RUM
Engine has
failed to
connect to this
probe channel
more than
three
consecutive
times
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Entity Description
OK Status
(Green)

Minor
Status
(Yellow)

Critical
Status (Red) Troubleshooting

Channel
"poorRequests"
Status

Status of the
last attempt to
connect to the
channel

The RUM
Engine has
successfully
connected
to this probe
channel

The RUM
Engine
experienced
problems
while
connecting
to this probe
channel

The RUM
Engine has
failed to
connect to this
probe channel
more than
three
consecutive
times

Channel
"sessions"
Status

Status of the
last attempt to
connect to the
channel

The RUM
Engine has
successfully
connected
to this probe
channel

The RUM
Engine
experienced
problems
while
connecting
to this probe
channel

The RUM
Engine has
failed to
connect to this
probe channel
more than
three
consecutive
times

Configuration to
Probe

Status of the
last attempt to
send the
configuration to
the RUM Probe

Probe was
configured
successfully

N/A Errors during
probe
configuration
process

l Check the
connection to the
probe

l Check the
connection to the
probeConnection to

Probe
Status of the
http connection
from the RUM
Engine to the
RUM Probe

The
connection
is
successful

N/A There is no
connection

Pages Cached The number of
page views
currently being
cached to the
RUM Probe’s
memory

The page
rate is stable

The page
rate is
nearing the
limit for
normal
caching

The page rate
is too high

Verify that monitored
traffic does not exceed
sizing
recommendations.

Probe and
Engine Time
Difference

Displays the
status of the
time
synchronization
between the
RUM Engine
and Probe

The RUM
Engine and
Probe are in
sync

The RUM
Engine and
Probe are
slightly out
of sync

The RUM
Engine and
Probe are
grossly out of
sync
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Entity Description
OK Status
(Green)

Minor
Status
(Yellow)

Critical
Status (Red) Troubleshooting

Probe Client
Monitor Page
Hits

The number of
hits from a
client browser
on amobile
device

N/A N/A N/A

Probe Channel
Delay

The delay
between the
read time from
the probe and
the current time

N/A N/A N/A

Probe
Channels Data
Flow

Status of
retrieving data
from the RUM
Probe

Data from
the probe
successfully
retrieved

Probe has
not
produced
new data for
some time

N/A Problem with the
connection between
the RUM Engine and
the RUM Probe, or
problems with one or
more channels on the
Probe side:

l Check the
<HPRUM>\log\
bbretriever.log file

l Try to restart the
RUM Probe

Probe Dropped
Page Hits Due
Other Reasons

The number of
pages dropped
due to other
reasons

N/A N/A N/A

Probe Dropped
Page Hits Due
Traffic

The number of
pages dropped
due to traffic
issues

N/A N/A N/A

Probe Dropped
Page Hits Due
Unresolved
Host

The number of
pages dropped
due to an
unresolved host

N/A N/A N/A

Probe Dropped
Page Hits of
Undefined
Application

The number of
pages dropped
as they do not
belong to a
defined
application

N/A N/A N/A
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Entity Description
OK Status
(Green)

Minor
Status
(Yellow)

Critical
Status (Red) Troubleshooting

Probe License
Status

The license
status
according to the
license
configured in
APM

The license
status is OK

N/A Check license
status and
details in APM

In APM > EndUser
Management
Administration, check
license status for
current Probe

ProbeMobile
Page Hits

The number of
hits from a
mobile device
to a remote
server

N/A N/A N/A

Probe Session
Hits

The number of
closed
sessions
monitored by
the RUM Probe

N/A N/A N/A

RUM Engine

Entity Description
OK Status
(Green)

Minor
Status
(Yellow)

Critical
Status
(Red) Troubleshooting

Application
Transaction
Count

The total
number of
open
application
transactions

Always N/A N/A

BBRetriever
hold time due
to load on Entry
Topic

The time (in
millisecond
s) that the
BBRetriever
was stopped
due to JMS
load on the
Entry topic

N/A N/A N/A
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Entity Description
OK Status
(Green)

Minor
Status
(Yellow)

Critical
Status
(Red) Troubleshooting

BBRetriever
hold time due
load on
RawEntry
Topic

The time (in
millisecond
s) that the
BBRetriever
was stopped
due to JMS
load on the
RawEntry
topic

N/A N/A N/A

BBRetriever
hold time due
to load on TCP
Entry Topic

The time (in
millisecond
s) that the
BBRetriever
was stopped
due to JMS
load on the
TCP Entry
topic

N/A N/A N/A

BBRetriever
hold time due
load on TCP
RawEntry
Topic

The time (in
millisecond
s) that the
BBRetriever
was stopped
due to JMS
load on the
TCP
RawEntry
topic

N/A N/A N/A

BBRetriever
Thrown
Objects

The total
number of
objects
thrown by
the
BBRetriever

N/A N/A N/A
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Entity Description
OK Status
(Green)

Minor
Status
(Yellow)

Critical
Status
(Red) Troubleshooting

BBRetriever
Total Actions
Published

The number
of actions
being
published by
the
BBRetriever
in the RUM
Engine

The number
of actions
being
published is
normal

The number
of actions
being
published is
above
average

The
number of
actions
being
published
is high

There is more traffic
(actions/connections/pages)
than the Engine can handle.
Check sizing guidelines.

BBRetriever
Total
Connections
Published

The number
of
connections
being
published by
the
BBRetriever
in the RUM
Engine

The number
of
connections
being
published is
normal

The number
of
connections
being
published is
above
average

The
number of
connection
s being
published
is high

BBRetriever
Total Pages
Published

The number
of pages
being
published by
the
BBRetriever
in the RUM
Engine

The number
of pages
being
published is
normal

The number
of pages
being
published is
above
average

The
number of
pages
being
published
is high

BBRetriever
Total Poor
Requests
Published

The number
of Poor
requests
published by
the
BBRetriever
in the RUM
Engine

N/A N/A N/A
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Entity Description
OK Status
(Green)

Minor
Status
(Yellow)

Critical
Status
(Red) Troubleshooting

Classification
total
application
tiers with
classification
disabled

The number
of
applications
whose
actions will
no longer be
classified

0 > 0 N/A A specific application is not
supported by the RUM
classification algorithm.

You can view application
statistics in the RUM JMX
console:

http://<Engine_host>:8180/
jmx-console/HtmlAdaptor?
action=inspectMBean&
name=RUM.modules%
3Aservice%3DResolver
Classification > viewStatistics

If the application has more
than 200 clusters, we
recommend disabling
classification for the
application (in APM, select
EUM Admin >
<application> > Data
Collection and clear the
Enable automatic page
classification check box).

Classification
total clusters
number

The total
number of
classificatio
n clusters

The number
is below the
threshold

N/A The
number
exceeds
the
threshold

Classification
total nodes
number

The total
number of
classificatio
n nodes

The number
is below the
threshold

N/A The
number
exceeds
the
threshold

Data Access
Layer

Click Data Access Layer to see the entities that
comprise the Data Access Layer component.

Data Publisher
Channel
Configuration
Status

The status
of building
the last
published
Data
Publisher
configuration

Always N/A The latest
published
configuratio
n failed to
build

Data Publisher
Records failed
to be published
due to cache
overflow

The total
number of
records
which were
not
successfully
published
due to cache
overflow

0 N/A >0
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Entity Description
OK Status
(Green)

Minor
Status
(Yellow)

Critical
Status
(Red) Troubleshooting

Data Publisher
Records failed
to be written

The total
number of
records
which were
not
successfully
published

0 N/A >0

FreeMemory The free
memory
available for
the RUM
Engine

The free
memory is
sufficient
for the RUM
Engine to
run under
the current
load

The free
memory is
nearing the
limit for the
RUM
Engine to
run under
the current
load

The free
memory is
not
sufficient
for the
RUM
Engine to
run under
the current
load

This value shows the total free
amount of memory in the Java
virtual machine. Try
Restarting the RUM Engine.

JMS Entry
topic size

The number
of messages
in the
<entity>
queue

The number
of
messages
in the queue
is normal

The number
of
messages
in the queue
is above
normal

The
number of
messages
in the
queue is
abnormal

l Performance issue –
check sizing guidelines.

l Configuration issue
causes specific module to
stop working.

JMS
Integration
Entry topic size

JMS Publisher
topic size

JMS Raw
Entry topic size

JMS Samples
topic size

JMS TCP
Entry topic size

JMS TCP Raw
Entry topic size

JMS Topology
Topic size
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Entity Description
OK Status
(Green)

Minor
Status
(Yellow)

Critical
Status
(Red) Troubleshooting

Location
Configuration
Validity

Displays the
correctness
of location
configuratio
ns

Location
configuratio
n is OK

Overlap of
IP
addresses.
One of the
overlapping
locations is
automaticall
y deleted.
Check
resolver.log
for details.
Manually
reconfigure
the
locations so
that there is
no overlap.
(You can
delete all
manually
created
locations;
default
locations
are
automaticall
y
recreated.)

Location
configuratio
n is
problemati
c. All data
is
discarded.
Check
resolver.log
for details.

The location configuration
received from APM is invalid.
Check locations in the
Locationmanager in APM.
Ensure that there are no
overlapping IP ranges.

LoginMaps
Size per Name

The total
number of
login names
mapped to
sessions

Always N/A N/A

LoginMaps
Size per
Session

The total
number of
sessions
mapped to
login names

Always N/A N/A

Partition
Manager

Click Partition Manager to see the entities that
comprise the PartitionManager component.
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Entity Description
OK Status
(Green)

Minor
Status
(Yellow)

Critical
Status
(Red) Troubleshooting

Publish
configuration to
module
<module
name> on host
<IP address>

Status of the
last attempt
to publish
the
configuration
to the RUM
Engine
internal
modules

Configuratio
n tomodule
<module
name> on
host <IP
address>
successfull
y published

N/A Error while
trying to
publish
configuratio
n tomodule
<module
name> on
host <IP
address>

Publisher
Chunks in
Memory

The number
of sample
chunks (not
yet sent to
APM) stored
inmemory

N/A N/A N/A

Poor Request
Network
Captures
Retrieved

The number
of Poor
request
capture files
retrieved by
the RUM
Engine

N/A N/A N/A

Poor Request
Network
Captures
Thrown

The number
of Poor
request
capture files
thrown by
the RUM
Engine

N/A N/A N/A

Poor Requests
with Network
Captures

The number
of Poor
requests
that have a
network
capture file

N/A N/A N/A

Publisher
Chunks in
Queue

The total
number of
sample
chunks
waiting to be
sent to APM

N/A N/A N/A
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Entity Description
OK Status
(Green)

Minor
Status
(Yellow)

Critical
Status
(Red) Troubleshooting

Resolver
Active End
Users

The status
of received
end-user
configuration
from APM

Valid end-
user
configuratio
n received

N/A Valid end-
user
configuratio
n not
received

Resolver End
User DNS
Cache size

The size of
the end user
DNS cache

N/A N/A N/A

Resolver
Ignored
Sessions
Cache Size

The size of
the ignored
sessions
cache

Cache size
is normal

N/A Cache size
has
exceeded
the
permissible
limit

Resolver
Server DNS
Cache size

The size of
the server
DNS cache

N/A N/A N/A

Resolver
Thrown
Actions
Because
Empty
Descriptor

The number
of actions for
which the
template
(generic)
descriptor is
empty or null

N/A N/A N/A

SessionManag
er Application
Session Count

The total
number of
open
application
sessions

Always N/A N/A

SessionManag
er BB Session
Count

The total
number of
open BB
sessions

Always N/A N/A

SessionManag
er Opened
Session Count

The total
number of
open
sessions

Always N/A N/A
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Entity Description
OK Status
(Green)

Minor
Status
(Yellow)

Critical
Status
(Red) Troubleshooting

Snapshot Jobs
Alive Count

The total
number of
open
snapshot
jobs waiting
to be
processed

RUM can
process all
the open
snapshots

The number
of open
snapshots
waiting to
be
processed
is nearing
the limit for
RUM under
the current
load

RUMmight
not be able
to process
all the
snapshots

In APM, check the snapshot
configuration
(EUM Admin > End User
Management >
Data Collection > Snapshot
collection) and ensure that a
reasonable number of pages
back are configured for
snapshots.

Snapshot Jobs
Submit Denials

The total
number of
submit
requests for
snapshot
failures

Always N/A N/A

Snapshot
Relevant
Events

The total
number of
events that
should
trigger
snapshot
creation

Always N/A N/A

Snapshot
Sessions Map
Size

The total
number of
open
sessions for
which at
least one
snapshot
was created

The number
of current
sessions is
normal

The number
of current
sessions is
nearing the
permissible
limit

The
number of
current
sessions
has
exceeded
the
permissible
limit

l Check resource
connectivity.

l Check the application
session count (whichmay
be a root cause for this
indication). Try to reduce
the number of snapshots
per application.
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Entity Description
OK Status
(Green)

Minor
Status
(Yellow)

Critical
Status
(Red) Troubleshooting

Statistics Total
Aggregation
Size

The number
of
aggregation
buckets in
memory

The number
of
aggregation
buckets is
normal

The number
of
aggregation
buckets is
nearing the
permissible
limit

The
number of
aggregation
buckets
has
exceeded
the
permissible
limit

l Try restarting the Engine.
l Theremay be a problem
with the aggregation
manager module.Look for a
problematic type (such as
pages, transactions, and
so forth) in the RUM
Engine JMX console:
http://<Engine_
host>:8180/jmx-console
/HtmlAdaptor?action=
inspectMBean&name=
RUM.modules%3Aservice
%3
DStatisticsMgrConf >
viewStatus

Statistics Total
Messages
Ignored

The number
of entities
filtered out
by the
statistics
manager

Always N/A N/A

Topology
Engine

Click Topology Engine to see the entities that
comprise the Topology Engine component.

Total
application
tiers with
number of page
names above
threshold

The number
of
applications
for which the
total number
of page
names was
exceeded
and nomore
page names
will be given

0 N/A N/A

Total number of
page names

The total
number of
pages (for all
applications)
that have
been given
names

< 50000 = 50000 > 50000
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Entity Description
OK Status
(Green)

Minor
Status
(Yellow)

Critical
Status
(Red) Troubleshooting

Trie
Classification
Is Within
Thresholds

The Trie
Classificatio
nmodule is
functioning
and has not
exceeded its
defined
thresholds

1 - within
thresholds

0 - exceeds
thresholds

N/A

Trie
Classification
Total
Descriptors
Number

The current
number of
page
descriptors
in the Trie
Classificatio
nmodule

N/A N/A N/A

Trie
Classification
Total Nodes
Number

The current
number of
internal
nodes in the
Trie
Classificatio
nmodule

N/A N/A N/A

Samples to APM Server

Entity Description
OK Status
(Green)

Minor
Status
(Yellow)

Critical
Status
(Red) Troubleshooting

Connection
to APM
server

Status of the connection
between the RUM Engine
and the APMGateway
Server for publishing
samples

RUM is
successfully
sending
samples to
APM

N/A RUM has
failed in
sending
data to
APM

Publisher
burst state

Indication if any samples
were delayed during the
last attempt to publish data
to APM

All RUM
samples are
being sent to
APM. No
samples are
delayed

N/A RUM is
delaying
samples
so as not
to
overload
APM

This means that there
is more traffic
(actions) than the
Engine can handle.
Check sizing
guidelines.
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Entity Description
OK Status
(Green)

Minor
Status
(Yellow)

Critical
Status
(Red) Troubleshooting

Publisher
Samples
Created for
<entity>

The number of <entity>
samples created since the
last RUM Engine restart

Always N/A N/A

Publisher
Samples
Thrown

The total number of
samples thrown

Always N/A N/A

Publisher
Total
Samples
Created

The total number of
samples created (for all
<entities>) since the last
RUM Engine restart

Always N/A N/A

Publisher
Total
Samples
Sent

The total number of
samples sent from the
Publisher module of the
RUM Engine to APM since
the last RUM Engine
restart

Always N/A N/A

Data Access Layer
To access, click Data Access Layer in RUM Enginemonitors.

Entity Description

OK
Status
(Green)

Minor Status
(Yellow) Critical Status (Red)

Average
response
time for
<entity>

The amount of time taken to write
the <entity> objects to the
database

Response
time of
database
is normal

Response time of
database is high,
whichmight indicate
a database problem

Response time of
database is very high,
whichmight indicate
a database problem

DAL
Active

Whether the Data Access Layer is
active or not. In some instances,
when free disk space on the
database server is running low, the
Data Access Layer stops sending
data to the database.

The Data
Access
Layer is
active

N/A The Data Access
Layer is not active
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Entity Description

OK
Status
(Green)

Minor Status
(Yellow) Critical Status (Red)

Number
of cache
misses
in
<entity>
lookup
table
cache

The number of queries to the
<entity>’s cache for which data
was not available, but should have
been

N/A N/A N/A

Number
of files in
<entity>
cache

The size of the cache for each
<entity> type

There is
no
backlog

A backlog of objects
to be sent to the
database exists,
which could indicate
a database problem
or a temporary load
peak

A large backlog of
objects to be sent to
the database exists,
which could indicate a
database problem or a
temporary load peak

Number
of futile
queries
to
<entity>
lookup
table
cache

The number of queries to the
<entity>’s cache for which data
was not available

N/A N/A N/A

Number
of
<entity>
objects
sent

The number of <entity> objects
sent to the database since startup

N/A N/A N/A

Number
of
queries
to
<entity>
lookup
table
cache

The total number of queries to the
<entity>’s cache

N/A N/A N/A

Size of
<entity>
lookup
table
cache

The size of the <entity> table in
thememory cache

Within the
cache
limit

N/A Cache limit breached
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Partition Manager
To access, click Partition Manager in RUM Enginemonitors.

Entity Description
OK Status
(Green)

Minor Status
(Yellow) Critical Status (Red)

Average
Task
Execution
Time

The average
execution
time of the
scheduled
task

Partition
Manager
average
performance
is normal

PartitionManager
average task
performance has
exceeded the warning
threshold

PartitionManager average
performance has exceeded the error
threshold andmight cause locks in
the database during execution

Last Task
Execution
Status

The status of
the last
executed
task

Partition
Manager is
running
normally

N/A PartitionManager task failed during
last execution

Max Task
Execution
Time

The
maximum
execution
time of the
scheduled
task

N/A N/A N/A

Topology Engine
To access, click Topology Engine in RUM Enginemonitors.

Entity Description
OK Status
(Green)

Minor
Status
(Yellow)

Critical
Status
(Red) Troubleshooting

Auto
discovered
pages
accumulator
size

The number
of pages
created by
RUM, waiting
to be sent to
APM

<= 500 N/A > 500 Consider reconfiguring, or
disabling themeaningful page
mechanism in APM (EUM
Admin).

Auto
discovered
pages sent
set size

The number
of create
pages sent to
APM since
the last RUM
Engine restart

<= 1000 N/A > 1000
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Entity Description
OK Status
(Green)

Minor
Status
(Yellow)

Critical
Status
(Red) Troubleshooting

Connection
status to
CMDB

Status of the
connection to
the Run-time
Service
Model
(RTSM)

Connection
OK

N/A No
connection

Check the RTSM password in
the RUM Engine web console
(Configuration > APM
Connection Settings > RTSM-
RUM integration user password
field) and test it using the Test
RTSM password button. This
passwordmay have been
changed from the default one in
this specific APM installation
and was not changed in the
RUM Engine. You can change
the password in BPM using
JMX:

http://<APM Data Processing
Server machine>:
21212/jmx-
console/HtmlAdaptor?
action=inspectMBean&name=
UCMDB:service=
Security Services#
changeIntegration
UserPassword

where:

l customerId = 1
l userName = rum_
integration_user

Discovery
data is
pending
report

Tier
discovery
data is
waiting to be
delivered to
APM as it
was not
successfully
delivered
previously

No data
pending

N/A Data
pending

This may be critical (red) during
peak traffic periods.
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Entity Description
OK Status
(Green)

Minor
Status
(Yellow)

Critical
Status
(Red) Troubleshooting

IP
accumulator
permanently
unresolved
set size

The number
of IP ranges
sent to APM,
that the
Location
Manager
could not
resolve to a
specific
location

< 10,000 N/A >= 10,000

IPs
accumulator
size

The number
of IP ranges
waiting to be
sent to APM
for location
matching

<= 5,000 N/A > 5,000

Location
accumulator
permanently
unresolved
set size

The size of
cached
unresolved
locations to
be published
to APM

Within the
permitted
cache size

N/A Greater
than the
permitted
cache size

Locations
accumulator
size

The size of
cached
locations to
be published
to APM

Within the
permitted
cache size

N/A Greater
than the
permitted
cache size

Number of
accumulated
IP ranges

The
accumulated
data structure
size of
discovered IP
ranges

N/A N/A N/A This may be critical (red) during
peak traffic periods.

Number of
accumulated
tiers

The
accumulated
data structure
size of
discovered
tiers

N/A N/A N/A
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Entity Description
OK Status
(Green)

Minor
Status
(Yellow)

Critical
Status
(Red) Troubleshooting

Number of
new
accumulated
IP ranges

The
accumulated
data structure
size of new
IP ranges

N/A N/A N/A This may be critical (red) during
peak traffic periods.

Reporters
connection to
APM status

The status of
the
connection to
APM

Connection
OK

N/A No
connection

Check the RTSM password in
the RUM Engine web console
(Configuration > APM
Connection Settings > RTSM-
RUM integration user password
field) and test it using the Test
RTSM password button. This
passwordmay have been
changed from the default one in
this specific APM installation
and was not changed in the
RUM Engine. You can change
the password in BPM using
JMX:

http://<APM Data Processing
Server machine>:
21212/jmx-
console/HtmlAdaptor?
action=inspectMBean&name=
UCMDB:service=Security
Services
#changeIntegration
UserPassword

where:

l customerId = 1
l userName = rum_
integration_user
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Entity Description
OK Status
(Green)

Minor
Status
(Yellow)

Critical
Status
(Red) Troubleshooting

Resolved
Hosts cache
size

The number
of hosts to be
reported to
APM for CI
creation

<= 10,000 N/A > 10,000 Check in the RTSM that your
topology is really this big. If so,
consider increasing the
maximum value in the xml file
for themonitor
(c:\<HPRUM>\conf\
monitoringmanager
\RumEngine\TopologyEngine\
<monitor name>.xml).

Resolved
Software
Elements -
Application
links cache
size

The number
of application
and software
element links
reported to
APM

<= 10,000 N/A > 10,000

Resolved
Software
Elements
cache size

The number
of software
elements
reported to
APM

<= 10,000 N/A > 10,000

Resolved
Subgroups
cache size

The number
of end-user
subgroups
reported to
APM

<= 30,000 N/A > 30,000

Unresolved
Hosts cache
size

The number
of hosts
waiting to be
reported to
APM

<= 1,000 N/A > 1,000
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Entity Description
OK Status
(Green)

Minor
Status
(Yellow)

Critical
Status
(Red) Troubleshooting

Unresolved
Software
Elements -
Application
links cache
size

The number
of application
and software
element links
waiting to be
reported to
APM

<= 500 N/A > 500 Check in the RTSM that your
topology is really this big. If so,
consider increasing themax
value in the xml file located in:
c:\<HPRUM>\conf\
monitoringmanager\RumEngine
\TopologyEngine\.

Unresolved
Software
Elements
cache size

The number
of software
elements
waiting to be
reported to
APM

<= 1,000 N/A > 1,000

Unresolved
Subgroups
cache size

The number
of end-user
subgroups
waiting to be
reported to
APM

<= 1,000 N/A > 1,000

Missing Mirrored Data
To access, click MissingMirrored Data in RUM Probemonitors.

Entity Description
OK Status
(Green)

Minor
Status
(Yellow)

Critical
Status
(Red)

<Application>
Lost Requests

The number of lost requests to web servers
per monitored application

N/A N/A N/A

<Application>
Lost Responses

The number of lost responses from web
servers per monitored application

N/A N/A N/A

Capture Log Files
You use this option to create a .ZIP file of the current status of RUM for support purposes.

Click Capture and specify the name and location of the file.

RUMConfiguration and Settings
TheConfiguration drop-downmenu on the RUM Engine web consolemenu bar includes the following
options:
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l APM Connection Settings. Used to view and configure the connection parameters between RUM and
APM. For details, see "APM Connection Settings" below.

l Probe Management. Used to configure communication settings with the RUM Probe. For details, see
"ProbeManagement" on page 109.

l Advanced Settings. Provides links to specific areas of the HPE Real User Monitor JMX console for
configuring parameters and settings for individual RUMmodules. For details, see "Advanced Settings" on
page 127.

l Data Flow Probe Connection Settings. Used to view and configure the connection parameters between
RUM andHPE Universal Discovery. For details, see "Data Flow Probe Connection Settings" on page
127.

l System Info. Provides general system information about RUM. For details, see "System Info" on page
128.

APMConnection Settings
This page displays the current connection settings for the communication channel between RUM and APM,
which you can update.

If you change the configuration, click theSave Configuration button to save the configuration and update the
RUM Engine.

The page contains the following panes:

l "RUMGeneral Settings Pane" below
l "Connection to APM Pane" on the next page
l "Authentication Pane" on the next page
l "Proxy Pane" on the next page
l "SSL Pane" on page 102

RUMGeneral Settings Pane

Field Description

RUM
Engine
name

Configure a name for the RUM Engine. This name is registered in APM and is used to identify
the engine in RUM Administration.

RTSM-
RUM
integration
user
password

Set the password for the default RTSM-RUM integration user.

The RUM Engine sends created CIs to the Run-time ServiceModel (RTSM), via the APM
Gateway Server. To enable the connection to the RTSM, a default user name (rum_
integration_user) and password is used. If you change the default integration user's password
in APM, youmust also change it in the RUM Engine. For details on changing the password in
APM, see "Create an Integration User" in the RTSMDeveloper ReferenceGuide.

Note: If the correct password is not configured (that is, the password configured in the RUM
Engine is different to the password configured in APM), RUM-related topology is not updated
in the RTSM and you will not see all RUM data in End User Management reports.
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Connection to APM Pane

Field Description

APM Gateway Server
host name

The IP address or host name of themachine on which the APMGateway Server is
installed.

Port The port number used to connect to the host machine on which the APMGateway
Server is installed.

Protocol The protocol used to connect to the host machine on which the APMGateway
Server is installed. Select either http or https.

Note: If you are an HPE Software-as-a-Service user, contact an HPE Software Support representative to
receive the host name or URL to enter.

Authentication Pane

Field Description

Use
authentication

Select the check box if authentication is required when connecting to the host machine
on which the APMGateway Server is installed.

Authentication
user name

If authentication is required, enter the user name to use.

Authentication
password

If authentication is required, enter the password to use.

Authentication
domain

If authentication is required, enter the applicable domain for the user.

For more information on using basic authentication in APM, see "Using Basic Authentication in APM" in the
APMHardening Guide.

Proxy Pane

Field Description

Use proxy Select the check box if the RUM Engine connects to the APMGateway Server machine
via a proxy server.

Proxy host If the RUM Engine connects to the APMGateway Server machine via a proxy server,
enter the IP address or host name of the proxy server.

Proxy port If you connect to the APMGateway Server machine via a proxy server, enter the port
number used to connect to the proxy server.

Use proxy
authentication

Select the check box if authentication is required when connecting to the proxy server.
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Field Description

Proxy user
name

If authentication is required when connecting to the proxy server, enter the user name to
use.

Proxy
password

If authentication is required when connecting to the proxy server, enter the password to
use.

Proxy domain If authentication is required when connecting to the proxy server, enter the applicable
domain for the user.

For information on using a reverse proxy server with APM, see "Using a Reverse Proxy in APM" in the APM
Hardening Guide.

SSL Pane

Field Description

Truststore path The full path and file name of the keystore file containing the trusted root
certificates. The keystore file must be either a java keystore file (JKS) or
PKCS#12 type file.

Note:

l Configure this field only if do not want to use the default JRE truststore
(containing well knownCA certificates).

l We recommend that you locate the truststore file outside of the <Real User
Monitor Engine root directory> to avoid possible upgrade issues.

Truststore type The type of truststore file—JKS or PKCS#12.

Truststore password The password for the truststore file.

Keystore path The full path and file name of the keystore file containing the private keys and
client certificate. The keystore file must be either a java keystore file (JKS) or
PKCS#12 type file.

Note:

l Configure this field only if you want to use client certificates.
l We recommend that you locate the keystore file outside of the <Real User
Monitor Engine root directory> to avoid possible upgrade issues.

Keystore type The type of keystore file—JKS or PKCS#12.

Keystore password The password for the keystore file.

Private key
password

The password for the private key located in the keystore file.

Validate host names
on server certificates

Select this check box to validate that the configured APMGateway Server host
namematches the name in the server certificate.
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Field Description

Validate that the
server certificates
are trusted

Select this check box to validate that at least one of the certificates in the server
certificate chain exists in the truststore (either in the configured truststore path, or
in the default truststore).

Validate that the
server certificates
are not expired

Select this check box to validate that the certificate is current.

For information on configuring RUM and APM to work with SSL, see "Using SSL in APM" in the APM
Hardening Guide.

Docker Host Management
You use the Docker Host Management configuration option to create and administer Docker Engine or Docker
SwarmManager hosts whose containers you would like tomonitor with RUM or Kubernetes Master hosts
whose Docker hosts (nodes), pods, and services you would like tomonitor with RUM.

When you select the Docker Host Management option from the Configuration drop-downmenu, the Docker
Host Management page opens and displays a table with the following information for each Docker host or
Kubernetes Master host:

Column Description

Enabled This value denotes whether the Docker Engine, Docker SwarmManager, or Kubernetes
Master host is enabled or not. A host that is not enabled will not have its containers
monitored. It also implies that the host will not be queried for the type and number of
containers it hosts.

Note:Not all the configuration options are enabled for disabled hosts.

Name The name you configured for the Docker host or Kubernetes Master host.

Host IP The IP address of the Docker Engine, Docker SwarmManager, or Kubernetes Master host
whose containers are ready to bemonitored.

Type l DockerEngine – For a Docker Engine host
l KubernetesMaster – For a Docker cluster managed by Kubernetes
l DockerSwarmManager – For a Docker cluster managed by Docker Swarm

Description A free text description qualifying the configured Docker Engine, Docker SwarmManager, or
Kubernetes Master host.

Action Buttons
You use the actions buttons displayed above the table to configure a Docker Engine host, Docker Swarm
Manager host, or Kubernetes Master host and tomanage the table. You select a Docker Engine host, Docker
SwarmManager host, or Kubernetes Master host by clicking a row in the table. The following table lists and
describes the available action buttons:
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Icon Description
For details,
see ...

New Host Configuration. Opens the New Host Configuration dialog box, where
you configure a new Docker host whose containers are to bemonitored or Docker
SwarmManager or Kubernetes Master host whose underlying Docker hosts are to
bemonitored.

"Host
Configuration
Dialog Box"
below

Edit Host Configuration. Opens the Edit Host Configuration dialog box, where
you configure an existing Docker host whose containers are to bemonitored or
Docker SwarmManager or Kubernetes Master host whose underlying Docker hosts
are to bemonitored.

"Host
Configuration
Dialog Box"
below

Delete Host Configuration. Deletes a selected Docker host or Docker Swarm
Manager or Kubernetes Master host configuration from the engine.

N/A

Docker Probe Management. Opens the Docker ProbeManagement page for the
selected Docker host. This button is enabled for Docker hosts of type Docker
SwarmManager and Docker Engine.

"Docker
Probe
Management"
on page 108

Container Patterns Filter. Enables you to fine tunemonitoring based on the
container name or container image and specify the containers that should be
monitored for each application tier.

"Docker
Pattern Filter
Settings" on
page 108

Refresh. Refreshes the list of Docker host and Docker SwarmManager or
Kubernetes Master host in the table.

N/A

Reset columns width. Resets the columns in the table to their default width. N/A

Select Columns. Selects the columns displayed in the table. N/A

Host Configuration Dialog Box
You use the Host Configuration dialog box to configure a new host whose containers are to bemonitored, or to
edit the settings of an existing host. Hosts can either be Docker Engine, Docker SwarmManager, or
Kubernetes Master hosts.
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To access the Host Configuration dialog box, click theNew Host Configuration button or theEdit Host

Configuration button on the Docker Host Management page. The Host Configuration dialog box includes
the following fields that you configure for a Docker Engine, Docker SwarmManager, or Kubernetes Master
host:

Host Details Pane

Field Description

Enabled Select the check box to enable the Docker Engine, Docker SwarmManager, or Kubernetes
Master host, or clear the check box to disable the host.

Note:

l A host that is not enabled will not have its containers monitored.
l If you enable the host and the IP address is not valid, an error message will appear.

Name The Docker Engine, Docker SwarmManager, or Kubernetes Master host name.

Note: This field is mandatory.

Syntax exceptions:Cannot exceed 255 characters.

Description A free text description of the Docker Engine, Docker SwarmManager, or Kubernetes Master
host.

Cannot exceed 255 characters.

Connection to Host Pane

Field Description

Host The IPv4/IPv6 address of themachine on which the Docker Engine, Docker Swarm
Manager, or Kubernetes Master is installed.

Note: This field is mandatory.

Syntax exceptions:

l Cannot exceed 255 characters.
l Allowed characters are a-z, A-Z, 0-9, and - \ . ] *.

Port The port number used to connect to the Docker Engine, Docker SwarmManager, or
Kubernetes API.

Default value:

l 2375 for a Docker Engine Host and Docker SwarmManager
l 8080 for a Kubernetes Master host
Syntax exceptions:Cannot exceed 100 characters.
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Field Description

Probe
Management

Select the probemanagement type.

l Automatic – RUM Engine will ensure that at least one probe container is running on the
host and that a probe configuration on the Engine side is connected to this probe
container.

l Manual – User is responsible for creating a probe container, ensuring that it is running,
creating a probe configuration on the Engine, and connecting the probe configuration to
the probe container.

Type For a Docker Engine host, select Docker Engine.

For a Kubernetes Master host, select Kubernetes Master.

For a Docker SwarmManager host, select Docker Swarm Manager.

Protocol The protocol used to connect to the Docker Engine, Docker Swarm, or Kubernetes API.
Select eitherHTTP orHTTPS.

Authentication Pane

Field Description

Use
authentication

Select the check box if authentication is required to connect to the the Docker Engine,
Docker Swarm, or Kubernetes API.

Authentication
user name

If authentication is required, enter the user name to use.

Authentication
password

If authentication is required, enter the password to use.

Authentication
domain

If authentication is required, enter the applicable domain for the user.

Proxy Pane

Field Description

Use proxy Select the check box if the RUM Engine connects to Docker Engine, Docker Swarm
Manager, or Kubernetes Master host machine via a proxy server.

Proxy host If the RUM Engine connects to the Docker host, Docker SwarmManager, or Kubernetes
Master host machine via a proxy server, enter the IP address or host name of the proxy
server.

Proxy port If you connect to the Docker host, Docker SwarmManager, or Kubernetes Master host
machine via a proxy server, enter the port number used to connect to the proxy server.

Use proxy
authentication

Select the check box if authentication is required when connecting to the proxy server.
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Field Description

Proxy user
name

If authentication is required when connecting to the proxy server, enter the user name to
use.

Proxy
password

If authentication is required when connecting to the proxy server, enter the password to
use.

Proxy domain If authentication is required when connecting to the proxy server, enter the applicable
domain for the user.

SSL Pane

Field Description

Truststore path The full path and file name of the keystore file containing the trusted root
certificates. The keystore file must be either a java keystore file (JKS) or
PKCS#12 type file.

Note:Configure this field only if do not want to use the default JRE truststore
(containing well knownCA certificates).

Truststore type The type of truststore file—JKS or PKCS#12.

Truststore password The password for the truststore file.

Keystore path The full path and file name of the keystore file containing the private keys and
client certificate. The keystore file must be either a java keystore file (JKS) or
PKCS#12 type file.

Note:Configure this field only if you want to use client certificates.

Keystore type The type of keystore file—JKS or PKCS#12.

Keystore password The password for the keystore file.

Private key
password

The password for the private key located in the keystore file.

Validate host names
on server certificates

Select this check box to validate that the configured Docker host, Docker Swarm
Manager, or Kubernetes Master host namematches the name in the server
certificate.

Validate that the
server certificates
are trusted

Select this check box to validate that at least one of the certificates in the server
certificate chain exists in the truststore (either in the configured truststore path, or
in the default truststore).

Validate that the
server certificates
are not expired

Select this check box to validate that the certificate is current.
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Docker Pattern Filter Settings
The Docker Pattern Filter Settings page enables you to fine tunemonitoring based on the container name or
container image and specify the containers that should bemonitored for each application tier.

Your filters are listed according to the Application Name and Tier Name.

Icon Description

Select all filters.

Select no filters.

Invert filter selection.

Delete. Click to delete the selected filter. Youmust then click Save Configuration to process this
change.

Edit. Opens the Edit Docker Pattern Filters Settings page to enable you to edit the selected filter.

New Definition. Opens the Edit Docker Pattern Filters Settings page to create a new filter. On this
page you enter the following information:

l Tier Name - Select the application/tier name for which you want to add the filter.
l Image Name Filter - Enter the image name of the containers to filter into the selected tier. You
can use wildcards (*) in this field.

l Container Name Filter - Enter the name of the containers to filter into the selected tier. You can
use wildcards (*) in this field.

Click Submit after entering the information.

Save Configuration. After creating a filter, click to save the filter to the backend xml.

Reload Current Configuration. Click to reload the current filter into the table.

Docker Probe Management
When you click the Docker ProbeManagement button from the Docker Host Management page, the Docker
ProbeManagement page opens and displays a table with the following probe information for the selected
Docker Host:

UI
Element Description

Remove and Recreate Container. Deletes selected container on Docker host and recreates
it. This is useful if probe is unresponsive.

Remove Container. Deletes probe container from Docker host. If automatic probe
management is enabled for the Docker host, although RUM deletes the probe container, RUM
would recreate the container in the next configuration cycle.
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UI
Element Description

Check HPRUMProbe Process Status. Connects to the probe container and checks that the
RUM probe process is running with the probe container.

Retrieve Container Log. Connects to the probe container and displays the last 20 lines of the
capture log. This is useful for troubleshooting.

Refresh. Repopulates the Docker ProbeManagement table with updated data.

Force Docker Discovery. RUM Engine connects to all the Docker hosts and performs
Discovery to check if new container or new images have been created, or if a host requires
deployment of probe containers. If a container was deleted and automatic probemanagement
is enabled for the probe, the Docker host recreates the container.

Node Name of the Docker node.

Probe
Name

Name of the probe that is managed by the engine. This matches the name of the probe created
underConfiguration > Probe Management for this probe container.

Container
Image

Name of the image from which the probe container was created.

Container
Name

Name of the probe container on this node.

Container
Port

Port on which this probe container is listening.

Container
Status

Status of container (Up orDown).

Probe Management
You use the ProbeManagement configuration option to create and administer the RUM Probes that are
connected to the engine.

When you select the ProbeManagement option from the Configuration drop-downmenu, the Probe
Management page opens and displays a table with the following information for each probe:

Column Description

Enabled This value denotes whether the probe is enabled or not. A probe that is not enabled does not
monitor RUM traffic.

Note:Not all the configuration options are enabled for disabled probes.

Name The name you configured for the probe.

Host Name The host name of themachine on which the probe is installed.

Description A free text description you configured for the probe.
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Action Buttons
You use the actions buttons displayed above the table to configure a selected probe and tomanage the table.
You select a probe by clicking a row in the table. The following table lists and describes the available action
buttons:

Icon Description
For details,
see ...

New Probe Configuration. Opens the New Probe Configuration dialog box,
where you configure a new probe for the engine.

"Probe
Configuration
Dialog Box" on
the next page

Edit Probe Configuration. Opens the Edit Probe Configuration dialog box, where
you configure an existing probe for the engine.

"Probe
Configuration
Dialog Box" on
the next page

Delete Probe Configuration. Deletes a selected probe from the engine. N/A

Probe Traffic Discovery. Opens the Probe Traffic Discovery page, where you
enable the probe to automatically discover the servers and domains being
accessed by the traffic to which it is listening.

Note: This button is not enabled for disabled probes.

"Probe Traffic
Discovery" on
page 113

Probe Information. Displays general information about the selected probe in a
new window. The information displayed shows the status of the probe, the
operating system and version running on the probe, the last configuration time of
the probe, and the last successful configuration time.

N/A

SSL Keystore Management. Opens the SSL KeystoreManagement page, where
youmanage the keys used by the probe tomonitor SSL encrypted traffic.

Note: This button is not enabled for disabled probes.

"SSL Keystore
Management"
on page 116

Interfaces Configuration. Opens the Interfaces Configuration page, where you
list and select a probe’s Ethernet devices used tomonitor server traffic.

Note: This button is not enabled for disabled probes.

"Interface
Configurations"
on page 119

Server Filter Settings. Opens the Server Filter Settings page, where you list and
configure the filters to be used for monitoring server traffic.

Note: This button is not enabled for disabled probes.

"Server Filter
Settings" on
page 121

Probe Traffic Capture. Opens the Probe Traffic Capture page where you instruct
a RUM Probe to save the traffic it monitors to a file.

"Probe Traffic
Capture" on
page 122
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Icon Description
For details,
see ...

Session ID Detection. Opens the Session ID Detection page, where you instruct
a RUM Probe to detect Session IDs in the traffic it monitors.

"Session ID
Detection" on
page 123

Refresh. Refreshes the list of probes in the table. N/A

Reset columns width. Resets the columns in the table to their default width. N/A

Select Columns. Selects the columns displayed in the table. N/A

Probe Configuration Dialog Box
You use the Probe Configuration dialog box to configure a new probe for a RUM Engine, or to edit the settings
of an existing probe. To access the Probe Configuration dialog box, click theNew Probe Configuration

button or theEdit Probe Configuration button on the ProbeManagement page. The Probe
Configuration dialog box includes the following fields that you configure for a probe:

Probe Details Pane

Field Description

Enabled Select the check box to enable the probe, or clear the check box to disable the probe.

Note:A probe that is not enabled does not monitor RUM traffic.

Name The probe name.

Note: This field is mandatory.

Syntax exceptions:Cannot exceed 255 characters.

Description A free text description of the probe.

Cannot exceed 255 characters.

Connection to Probe Pane

Field Description

Host The IP address or host name of themachine on which the probe is installed.

Note: This field is mandatory.

Syntax exceptions:

l Cannot exceed 255 characters.
l Allowed characters are a-z, A-Z, 0-9, and - \ . ] *.
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Field Description

Port The port number used to connect to the host machine on which the probe is installed.

Default value: 2020

Syntax exceptions:Cannot exceed 100 characters.

Protocol The protocol used to connect to the host machine on which the probe is installed. Select either
http or https.

Authentication Pane

Field Description

Use
authentication

Select the check box if authentication is required when connecting to the host
machine on which the probe is installed.

Authentication
user name

If authentication is required, enter the user name to use.

Authentication
password

If authentication is required, enter the password to use.

Authentication
domain

If authentication is required, enter the applicable domain for the user.

Proxy Pane

Field Description

Use proxy Select the check box if the RUM Engine connects to the probemachine via a proxy
server.

Proxy host If the RUM Engine connects to the probemachine via a proxy server, enter the IP
address or host name of the proxy server.

Proxy port If you connect to the probemachine via a proxy server, enter the port number used to
connect to the proxy server.

Use proxy
authentication

Select the check box if authentication is required when connecting to the proxy server.

Proxy user name If authentication is required when connecting to the proxy server, enter the user name
to use.

Proxy password If authentication is required when connecting to the proxy server, enter the password
to use.

Proxy domain If authentication is required when connecting to the proxy server, enter the applicable
domain for the user.
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SSL Pane

Field Description

Truststore path The full path and file name of the keystore file containing the trusted root
certificates. The keystore file must be either a java keystore file (JKS) or
PKCS#12 type file.

Note:Configure this field only if do not want to use the default JRE truststore
(containing well knownCA certificates).

Truststore type The type of truststore file—JKS or PKCS#12.

Truststore password The password for the truststore file.

Keystore path The full path and file name of the keystore file containing the private keys and
client certificate. The keystore file must be either a java keystore file (JKS) or
PKCS#12 type file.

Note:Configure this field only if you want to use client certificates.

Keystore type The type of keystore file—JKS or PKCS#12.

Keystore password The password for the keystore file.

Private key
password

The password for the private key located in the keystore file.

Validate host names
on server certificates

Select this check box to validate that the configured Probe host namematches
the name in the server certificate.

Validate that the
server certificates
are trusted

Select this check box to validate that at least one of the certificates in the server
certificate chain exists in the truststore (either in the configured truststore path, or
in the default truststore).

Validate that the
server certificates
are not expired

Select this check box to validate that the certificate is current.

Probe Traffic Discovery
You use the Probe Traffic Discovery tool to instruct the RUM Probe to automatically detect and report the
domains and servers that are accessed by the traffic to which it is listening. You can use the information
obtained from the Probe Traffic Discovery tool to help you:

l Configure servers and applications to bemonitored by RUM, in End User Management Administration. For
task details, see "Getting Started with Real User Monitor" in the APM Application Administration Guide.

l Determine the protocol types that are used in the system.
l Determine sizing and load balancing needs for RUM. For example, discover throughput for configured
applications and ports.

l Troubleshoot RUM Probe issues by checking if and what the probe is monitoring. For example, check if
traffic is discovered for a configured application.
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When you click theProbe Traffic Discovery button in the ProbeManagement page, the Probe Traffic
Discovery page opens and the Summary View tab is displayed by default. If probe traffic discovery is
currently running its results are displayed, otherwise previously saved data (if it exists) is displayed. When
you start a new probe traffic discovery, the new statistics are displayed and they are automatically saved,
overwriting previously saved data, when you stop the discovery.

Note: It is possible to run the Probe Traffic Discovery tool concurrently with regular probemonitoring.

This section includes the following topics:

l "Common Elements" below
l "Summary View Tab" on the next page
l "Domain View/Server View Tabs" on the next page

Common Elements
The following elements are common to all the tabs in the Probe Traffic Discovery page:

UI
Element Description

Reset Discovery Statistics. Resets and initializes probe traffic discovery statistics.

Note: This button is available only when probe traffic discovery is running.

Refresh. Refreshes the data displayed on the Probe Traffic Discovery page with themost up
to date statistics.

Note: This button is available only when probe traffic discovery is running.

Server
Type

You can filter the data displayed according to the type of servers. Select Servers on Private
IPs, Servers on Non-Private IPs, orBoth from the drop-down list in theServer Type filter.
The data is redisplayed according to the records matching the search criteria.

Default value:Both

<General
statistics>

Discovery start time. The start time of a currently running traffic discovery.

Sample period. The date and time that the displayed statistics were retrieved are displayed.
For statistics loaded from a saved file, Saved Results is displayed next to the date and time.

Peak total traffic. The peak amount of traffic transmitted to and from all the domains or
servers included in the page, for all the discovered protocols.

Peak pages/sec. The peak number of pages per second for all the domains or servers
included in the page, for the http protocol.

Start
Discovery

Click theStart Discovery button to start probe traffic discovery for the probe. Starting
discovery automatically deletes any previously saved data.

Note: TheStart Discovery andStop Discovery buttons are not enabled simultaneously.
When one is enabled, the other is disabled.
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UI
Element Description

Stop
Discovery

Click theStop Discovery button to stop probe traffic discovery for the probe and save the
current data.

Note:

l TheStart Discovery andStop Discovery buttons are not enabled simultaneously. When
one is enabled, the other is disabled.

l When you click Stop Discovery, you are prompted to save the current statistics. Saving
the statistics overwrites any previously saved data.

Summary View Tab
The Summary View tab displays a pie chart in which each slice represents a different, discovered protocol
and the slice size is determined by the percentage of protocol throughput out of the total throughput for all the
protocols. Click the slice representing the http protocol to display the Domain View tab, or click on any other
slice to display the Server View tab. The Domain View or Server View tab opens with the selected protocol
expanded in the hierarchical tree.

Note: The pie chart includes amaximum of 20 slices for the protocols with the highest throughput. If
there aremore than 20 protocols to be displayed, the protocols with lower throughput are included in the
Others slice, which also includes protocols and servers that have not yet been recognized.

Domain View/Server View Tabs
The Domain View and Server View tabs display the following information for each discovered protocol:

UI Element Description

Search You can filter the data displayed by searching for domains or servers that match a specific
pattern or IP address. Enter the search pattern in the Search filter located at the top left of
the page, and click Search Domain orSearch Server. The data is redisplayed according
to the records matching the search criteria.

Note:

l When using the search feature in theDomain View tab, you can enter alpha-numeric
characters, the asterisk (*) wild card character, and use partial strings for matching. The
search filters domain names that include the search string.

l In theServer View tab, you can enter only valid IP addresses in the search field. The
search filters server IP addresses that exactly match the search string.
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UI Element Description

<Domain
View
protocol
tree>

For each discovered protocol, the statistics are grouped by domain names (for http), or IP
addresses (for other protocols). For each port in the domain, the IP address of each server
that connected to the domain is listed. For example:

Note: This is the default view when you drill down from the Summary View pie chart for the
http protocol.

<Server
View
protocol
tree>

For each discovered protocol, the statistics are grouped by server IP addresses and for
each server, by port. For example:

Note: This is the default view when you drill down from the Summary View pie chart for
protocols other than http.

%
Throughput

The percentage of throughput for a specific protocol out of the total throughput for all
protocols.

Throughput The total throughput to and from the domain or server, for a specific protocol.

Peak Traffic The peak amount of traffic transmitted to and from the domain or server, for a specific
protocol. Peak traffic is determined based on 30 second intervals.

Peak
Pages/sec

The peak number of pages per second for the domain or server for http.

Note: This is applicable for http only.

Compressed Ticked if any of the traffic sent and received by the domain or server was compressed.

Encrypted Ticked if any of the traffic sent and received by the domain or server was encrypted.

Server Info The name of the server, if available.

More Details Reserved for future use.

SSL Keystore Management
You use the SSL KeystoreManagement page tomanage the keys used by a selected RUM Probe tomonitor
SSL encrypted traffic. To access the SSL KeystoreManagement page, click theSSL Keystore
Management button on the ProbeManagement page. The KeystoreManagement page contains three
panes –SSL Keystore Administration, SSL Application Decryption Statistics, andSSL Server

Decryption Statistics. To refresh the information on this page, click theRefresh button .
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Note:

l The RUMweb console keystore import tool supports PEM, DER, PKCS8, and PKCS12 unencrypted
private key types, as well as encrypted Java Keystore. Other key types can be imported if they are
converted to one of the supported types.

l The RUM Probe cannot decrypt traffic that uses Diffe Helman keys. If there is a high percentage of
such traffic (which you can see in theDecryption Failed (unsupported algorithm) column in the
"SSL Application Decryption Statistics Pane" on page 119) it is recommended that you configure the
web server of themonitored server not to support the Diffe Helman protocol.

l The following is a list of ciphers that can be decrypted while monitoring:
SSL v3.0 cipher suites

SSL_RSA_WITH_NULL_MD5
SSL_RSA_WITH_NULL_SHA
SSL_RSA_EXPORT_WITH_RC4_40_MD5
SSL_RSA_WITH_RC4_128_MD5
SSL_RSA_WITH_RC4_128_SHA
SSL_RSA_EXPORT_WITH_RC2_CBC_40_MD5
SSL_RSA_WITH_IDEA_CBC_SHA
SSL_RSA_EXPORT_WITH_DES40_CBC_SHA
SSL_RSA_WITH_DES_CBC_SHA
SSL_RSA_WITH_3DES_EDE_CBC_SHA

NULL-MD5
NULL-SHA
EXP-RC4-MD5
RC4-MD5
RC4-SHA
EXP-RC2-CBC-MD5
IDEA-CBC-SHA
EXP-DES-CBC-SHA
DES-CBC-SHA
DES-CBC3-SHA

TLS v1.0 cipher suites

TLS_RSA_WITH_NULL_MD5
TLS_RSA_WITH_NULL_SHA
TLS_RSA_EXPORT_WITH_RC4_40_MD5
TLS_RSA_WITH_RC4_128_MD5
TLS_RSA_WITH_RC4_128_SHA
TLS_RSA_EXPORT_WITH_RC2_CBC_40_MD5
TLS_RSA_WITH_IDEA_CBC_SHA
TLS_RSA_EXPORT_WITH_DES40_CBC_SHA
TLS_RSA_WITH_DES_CBC_SHA
TLS_RSA_WITH_3DES_EDE_CBC_SHA
TLS_RSA_WITH_AES_128_CBC_SHA
TLS_RSA_WITH_AES_256_CBC_SHA
TLS_RSA_WITH_CAMELLIA_128_CBC_SHA
TLS_RSA_WITH_CAMELLIA_256_CBC_SHA
TLS_RSA_WITH_SEED_CBC_SHA
TLS_RSA_EXPORT1024_WITH_DES_CBC_SHA
TLS_RSA_EXPORT1024_WITH_RC4_56_SHA

NULL-MD5
NULL-SHA
EXP-RC4-MD5
RC4-MD5
RC4-SHA
EXP-RC2-CBC-MD5
IDEA-CBC-SHA
EXP-DES-CBC-SHA
DES-CBC-SHA
DES-CBC3-SHA
AES128-SHA
AES256-SHA
CAMELLIA128-SHA
CAMELLIA256-SHA
SEED-SHA
EXP1024-DES-CBC-SHA
EXP1024-RC4-SHA

TLS v1.2 cipher suites

TLS_RSA_WITH_NULL_SHA256
TLS_RSA_WITH_AES_128_CBC_SHA256
TLS_RSA_WITH_AES_256_CBC_SHA256
TLS_RSA_WITH_AES_128_GCM_SHA256
TLS_RSA_WITH_AES_256_GCM_SHA384

NULL-SHA256
AES128-SHA256
AES256-SHA256
AES128-GCM-SHA256
AES256-GCM-SHA384

This section includes:
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l "SSL Keystore Administration Pane" below
l "SSL Application Decryption Statistics Pane" on the next page
l "SSL Server Decryption Statistics Pane" on the next page

SSL Keystore Administration Pane
The SSL Keystore Administration pane displays a list of all the configured keys for the selected probe, and for
each key shows the number of servers on which it was used to decipher traffic.

To add a key:

1. Click Add Key. The KeystoreManagement page opens.
2. Enter a logical name for the key you are adding.
3. Select the type of file from which to import the key you are adding (a key file or a keystore) and configure

the applicable settings:

Key Type Setting Description

Import from
Key File

File The path and name of the file containing the private key. You can click
Browse to navigate to the relevant file.

Password The password with which the key is encrypted, or null if the key is not
encrypted.

Import from
Keystore

Keystore file The path and name of the keystore file. You can click Browse to
navigate to the relevant file.

Keystore
password

The keystore password.
Note: This field is mandatory.

Private key
alias

The alias of the specific key in the keystore. If no alias is configured,
the first key in the keystore is used.

Private key
password

The password of the specific key in the keystore.

4. Click Submit to save the key and exit, orCancel to exit without saving.
To delete a key:

1. Select the check box to the left of the keys you want to delete.

2. Click theDelete button at the bottom of the pane, or at the end of the row of the selected key.

You can select all, clear all, or invert your selection using theSelect buttons .
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SSL Application Decryption Statistics Pane
The SSL Application Decryption Statistics pane displays the following information for each application for
which encrypted traffic was monitored:

Column Description

Application
Name

The name of the application.

Decryption
Successful

The percentage of successfully decrypted traffic for the application.

Decryption
Failed (in
parsing)

The percentage of unsuccessfully decrypted traffic for the application due to a failure in
parsing, possibly due to packet loss. If you determine that packet loss is occurring, check
your network settings and consider using a tap instead of port spanning for the RUM
Probe.

Decryption
Failed (no
handshake)

The percentage of unsuccessfully decrypted traffic for the application due to an SSL
handshake not being found. Possible causes are a non SSL connection, or the RUM Probe
being stopped/started during an SSL handshake.

Decryption
Failed
(unsupported
algorithm)

The percentage of unsuccessfully decrypted traffic for the application due to an
unsupported algorithm. The SSL handshake algorithm used unsupported, temporary
private keys (such as D-H, or RSA with Export restrictions on the key length). If you use
an SSL accelerator, a possible solution is to move the RUM Probe behind it.

Decryption
Failed (no
matching
key)

The percentage of unsuccessfully decrypted traffic for the application due to no suitable
key being found for the decryption, possibly as a result of the web server key being
replaced. Check the keys and if necessary, obtain and configure a new key for use.

Decryption
Failed (cache
timeout)

The percentage of unsuccessfully decrypted traffic for the application due to any of the
above errors in connections from the same user, when decryption failed in the first
connection in the session.

SSL Server Decryption Statistics Pane
The SSL Statistics pane displays the amount of encrypted traffic as a percentage of the entire traffic
monitored from each server.

Interface Configurations
Use the Interfaces Configuration page to list and select a probe’s Ethernet devices used tomonitor server
traffic.

For RUM Probes running on Linux, only devices named ethX (whereX is a number – such as, eth0, eth1, etc.)
can be used for sniffing. This is because the RUM Probes sniff only from an Ethernet network device and rely
on eth as a standard Ethernet prefix.

To sniff from an Ethernet device with a different name:

1. Open the <HPRUM>\conf\configurationmanager\Beatbox_<probe name or IP address>_Const_
Configuration.xml file.
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2. Edit the [collector] section by adding the corresponding configuration:
[collector]
#device all
device <1st NIC name>
device <2nd NIC name>
…
device <nth NIC name>

Note: Make sure the #device all line is prefixed with a hashmark (#).

To access the Interfaces Configuration page, click the Interfaces Configuration button on the Probe
Management page. For each Ethernet device, the following information is displayed:

UI Element Description

Sniff Check box to select the device tomonitor server traffic.

Link Up Whether the network interface is physically connected to a cable.

Name The logical name of the Ethernet device.

Up Whether the device is running or not.

Sniffable Whether the device can be used to listen to Ethernet traffic.

Hardware The hardware details of the device.

Driver The name of the driver used for the device.

IP The IP address assigned to the device, if any.

Interface
Details

Click the Interface Details button for a device to display link, driver, other settings, and
statistics information in a new window.

Note: For RUM Probes running onWindows, only the Name element is displayed.

To select a device to be used by the probe for monitoring server traffic, use one of the following options:

l Select theSniff check box to the left of the device you want to use.
l Select theProbe Auto Select check box to configure the RUM Probe to listen to all available devices
automatically.

Note: This differs from selecting all the devices manually, as the RUM Probe only listens to available
devices and not to all devices.

l Click Restore to Current to select the devices currently configured for monitoring.
l Click Recommended Selection to have the RUM Engine select the devices it considers to be themost
suitable to use.

When you havemade your selection, click Save and Upload Configuration to save the configuration and
send it to the RUM Probe.

Note: You can select all, clear all, or invert your selection using theSelect buttons .
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Server Filter Settings

Note: Use server filters to manage probe clustering only. That is, when two or more probes receive the
same traffic and you want to assign different parts of the traffic for each probe tomonitor.

For traffic filtering, configure application location settings in End User Management Administration. For
details, see "Real User Monitor Application ConfigurationWizard" in the APM Application Administration
Guide.

If you have existing server filter settings that are used for regular server filtering, we recommend that you
delete them and configure application location settings in End User Management Administration instead.

The RUM Probe filters the traffic that it monitors. By default, the filter is set to monitor all traffic from port 80.
You can override the default filter by setting filters for specific IP addresses or ranges, and for specific ports
that you want to monitor.

You use the Server Filter Settings page to list and configure the filters to be used for monitoring specific server
traffic. To access the Server Filter Settings page, click theServer Filter Settings button on the Probe
Management page. For each server range, the following information is displayed:

UI Element Description

Servers The range or mask of servers to bemonitored.

Ports The ports of the servers included in the range to bemonitored.

Clients By default, a filter applies for all clients accessing the servers.

To display the current server filters data, click Reload Current Configuration at the bottom of the page.

You can add new filters, and delete or edit existing filters. After adding, deleting, or changing a filter, click
Save and Upload Configuration to save the configuration and send it to the RUM Probe.

Add a new filter
1. Click New Definition. The Edit Server Filter Settings page opens.
2. In the Edit Server Filter Settings page, enter the following:

Field Description

Servers Select the type of server filter you are adding and enter the required data. The following are
the available options:
l Single IP. Enter a single IP address.

l IP Range. Enter the starting and ending IP addresses of the range.

l IP Mask. Enter the network address and applicable IP mask.
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Field Description

Ports Select the type of port filter you are adding and enter the required data. The following are the
available options:
l Single Port. Enter a single port number.

l Port Range. Enter the starting and ending port numbers of the range.

3. Click Submit to save the filter and exit, orCancel to exit without saving.

Delete a filter

Click theDelete button in the row of the filter you want to delete.

Edit a filter

1. Click theEdit button in the row of the filter you want to edit. The Edit Server Filter Settings page
opens.

2. In the Edit Server Filter Settings page, edit the information displayed. See above for an explanation of the
filter’s fields.

3. Click Save to save the filter and exit, orCancel to exit without saving.

Probe Traffic Capture
You use the Probe Traffic Capture feature to instruct a RUM Probe to save the traffic it monitors to a file. This
is useful for analysis and troubleshooting. To configure and start probe traffic capturing, click theProbe
Traffic Capture button on the ProbeManagement page. The Probe Traffic Capture page opens and
displays the following elements:

Element Description

Capture file max
size (MB)

Enter themaximum capture file size in megabytes. You can configure a file size of
up to 100MB.

Note:Capturing is automatically stopped when either the configured file size or the
configured time is reached.

Capture duration
(seconds)

Enter themaximum time (in seconds) for capturing to run. You can configure a
time of up to 3600 seconds.

Note:Capturing is automatically stopped when either the configured file size or the
configured time is reached.

Use client IP filter Select this check box if you want to capture traffic for a specific range of clients.

Client IP filter
from...to

If you select theUse client IP filter check box, enter the IP range for the clients
whose traffic you want to capture.

Use server port filter Select this check box if you want to capture traffic for a specific range of server
ports.
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Element Description

Server IP filter
from...to

If you select theUse server port filter check box, enter the IP range for the server
whose traffic you want to capture.

Server port to filter If you select theUse server port filter check box, enter the port for the server
whose traffic you want to capture.

Use advanced
capture filtering

Select this check box if you want to capture traffic based on advanced filtering
rules.

Advanced text If you select theUse advanced capture filter check box, enter the text you want
to capture.

Start Capture Click theStart Capture button to start the probe traffic capture. The following
elements are displayed:

l Time left. The amount of remaining time that capturing will run.
l Current file size. The current size of the capture file.
l Capture file location and name.
l Stop Capture. Click theStop Capture button to stop probe traffic capturing
when it is running.

l Click theRefresh button tomanually refresh the displayed Time left and
Current file size data.

Note: The Time left andCurrent file size data is refreshed automatically every
ten seconds when capturing is running.

Session ID Detection
Use session ID detection to instruct the RUM Probe to detect session IDs in the traffic it monitors, for
applications configured in End User Management Administration. For information on configuring applications
in End User Management Administration, see "Real User Monitor Application ConfigurationWizard" in the
APM Application Administration Guide.

This section includes the following topics:

l "Configuring Applications in End User Management Administration Using Traffic Discovery and Session
ID Detection" below

l "Session ID Detection Page" on the next page
l "Session ID Detection Report" on the next page

Configuring Applications in End User Management Administration
Using Traffic Discovery and Session ID Detection
To configure applications in End User Management Administration, you use traffic discovery and session ID
detection in the following sequence:

1. Run traffic discovery to identify applications onmonitored servers.
2. Configure the discovered applications in End User Management Administration, without session ID

parameters.
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3. Run session ID detection to identify the relevant session IDs for the applications.
4. Configure the session ID parameters for the applications in End User Management Administration.

Session ID Detection Page

When you click theSession ID Detection button on the ProbeManagement page, the Session ID
Detection page opens. On the Session ID Detection page, the following elements are displayed, which you
use to configure and run session ID detection for the selected probe:

UI
Element Description

Detection
duration

The length of time, in minutes, that session ID detection should run, when started.

Detect for
single IP

If you know that only a single session originates from a specific IP address, select this check
box and enter the IP address in the adjacent field.

This enhances session detection accuracy.

Last
successful
detection
time

Shows the last date and time that the Session ID Detection tool was successfully run.

Status The status of the session ID detection. Valid statuses are:

l Idle. Session ID detection is not running.
l Running. Displays the percentage of completed data collection and the remaining
amount of time that session ID detection will run.

Start
Detection

Click to start session ID detection.

Stop
Detection

Click to stop session ID detection.

View
Results

Click to view the Session ID Detection report for the probe. For user interface details, see
"Session ID Detection Report" below.

Note:You can only view the results of the current run, once it has stopped (that is, either it
completed its full run, or you stopped it manually). If you click theView Results button while
session ID detection is running, you see the results of the last completed session ID
detection run.

Refresh. Refreshes the data displayed on the Session ID Detection page.

Session ID Detection Report
For each application configured for the probe in End User Management Administration, the Session ID
Analysis report shows the following information:
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UI Element Description

Application
Name

The application name, as defined in End User Management Administration. For
applications not been defined in End User Management Administration, the application
name is Default Website. For information on configuring applications in End User
Management Administration, see "RUM Application ConfigurationWizard" in the APM
Application Administration Guide.

Application
Components

The total number of hits in the application.

Application
Pages

The total number of pages in the application.

Application
Clients

The total number of clients that accessed the application.

Application
Connections

The total number of connections to the application.

All Session
IDs
Coverage

The percentage of hits in the application that contain a discovered session ID key.

Session ID
Key

The session ID key name of the session ID discovered for the application.

Type Where the session ID key is located – cookie, query, or cookie and query.

Regular
Expression

The regular expression that uniquely defines the session ID key. The same regular
expression should be used in theScan for field in session identification advanced criteria,
when configuring an application in End User Management Administration. For information
on configuring applications in End User Management Administration, see "RUM
Application ConfigurationWizard" in the APM Application Administration Guide.

Specific
Session ID
Coverage

The percentage of traffic collected for the application by the data collection process,
containing the specific session ID key.

Specific
Session ID
Correctness

The probability that RUM gives the located key of being a real session ID key.

You can display data for a specific application only, display detailed information for a specific session ID key,
and view raw data for a single end-user IP address.

To display data for a specific application only:
Select the application in the Filter By Application Name filter, located at the top-left of the report.

To display detailed information for a specific session ID key:
Click a specific key in the Session ID Key column. The Session ID Detection Detailed report is displayed in a
new window, and shows the following information for the session ID key:
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UI Element Description

Session ID
Properties

Application Name. The application name, as defined in End User Management
Administration.

Session ID Key. The session ID key name.

Type.Where the session ID key is located – cookie, query, or cookie and query.

Regular Expression. The regular expression that uniquely defines the session ID
key. The same regular expression should be used in the Scan for field in session
identification advanced criteria, when configuring an application in End User
Management Administration.

Object Retrieve Phrase. The phrase representing the specific objects to be retrieved
from the regular expression. The same phrase should be used in the retrieve field in
session identification advanced criteria, when configuring an application in End User
Management Administration.

Specific Session ID Coverage. The percentage of traffic collected for the
application by the data collection process, containing the specific session ID key.

Specific Session ID Correctness. The probability that RUM gives the located key
of being a real session ID key.

First Page Number. The page in which the session ID first appeared.

Note: The first page number is shown only if you chose to collect raw data for a
specific end-user IP address when starting session ID capturing.

Examples Displays a few examples of the session ID key and the value located in the key.

Set Cookie
Params

If the session ID key is located in a cookie, or in a cookie and query, the path and
domain, which are optional parameters sent from the server when setting a cookie for
the client, are displayed.

Reasons For Not
Locating Session
ID Keys in
Collected Data

Displays the percentage of traffic collected by the data collection process, not
containing the specific session ID key, and for which a reason can be given.

Reasons For
Incomplete
Session ID
Correctness

The reasons why RUM gives the located key a probability of less than 100 percent of
being a real session ID key.

To display raw data for a single end-user IP address:
Click View Raw Data. TheSession ID Detection Raw Data report is displayed, and shows the following
information for the end-user IP address:
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UI Element Description

# A sequential number indicating the row number in the report.

URI The URI of the page or component.

Page/Component Indicates whether the data displayed in the row refers to a page or a component.

Referrer For a page, the referrer is the calling page; for a component, the referrer is the page in
which the component is included.

Client Port The port number of the client’s machine on which the data was collected.

Set Cookie The cookie sent from the server to the client, containing the session ID key.

Cookies The content of the cookie included in the URL POST parameters.

Query The content of the query.

Note: The View Raw Data button is only enabled if raw data was collected for a single end-user IP
address.

Advanced Settings
This option displays RUMmodules and provides direct links to specific pages in the RUM JMX console for
viewing and configuring themodule settings. Eachmodule listed can have any of the following links
associated with it:

l Main Module Page. Links to general settings for themodule name and status.
l Configuration Page. Links to settings for the configuration of the RUMmodule retrieved from APM.
l Settings Page. Links to settings for the configuration of the RUMmodule in the RUM Engine.
For details on working with the JMX console, see "Using the JMX Console to Configure the RUM Engine" on
page 139.

Data Flow Probe Connection Settings
This page displays the current connection settings for the communication channel between RUM and
HPE Universal Discovery, which you can update.

Overview
You can configure a RUM Engine to interact with Universal Discovery's Data Flow Probes. The RUM Engine
gathers information from RUM Probes and passes the following information on to the Data Flow Probes:

l Discovered IPs, running software, and connection dependencies.
l Removed IPs and running software.
When a connection is established between a RUM Engine and Universal Discovery, the RUM Engine
receives configuration details from Universal Discovery and passes them on to the RUM Probes. If you have
configured specific filters for a probe:
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l The RUM Probemonitors traffic according to its filters and from themonitored traffic, sends to Universal
Discovery only data that is relevant according to the Universal Discovery configuration settings.

l The RUM Probe sends its filter settings to Universal Discovery, so that it knows what traffic the RUM
Probe is monitoring.

Prerequisites
l RUM version 9.20 or later
l HPE Universal CMDB version 10.00 or later

Configuration
To configure the connection between the RUM Engine and HPE Universal Discovery, enter the following
information:

Field Description

Data Flow Probe host
name

The IP address or host name of the Data Flow Probe to which the RUM Engine
is to report.

Port The port number through which the RUM Engine is to send data to the Data
Flow Probe.

Protocol The protocol used to connect to the Data Flow Probe.

Note:

l Leave Authentication, Proxy, and SSL settings empty.
l If you change the configuration, click theSave Configuration button to save the configuration and
update the RUM Engine.

l For details on configuring Data Flow Probes, refer to the HPE Universal CMDB documentation.

System Info
This option shows general system information about RUM, which is displayed in the following panes:

l RUM Server - General. Includes the host name, host IP address, total memory, and the number of
available processors for the RUM server.

l RUM Server - OS. Includes the name and version of the operating system of the RUM server.
l RUM Database - General. Includes the host name and port number of the RUM database, as well as the
name of the database schema.

RUMDiagnostics Tools
The Tools drop-downmenu on the RUM Engine web consolemenu bar includes the following tools:

l Monitoring Configuration Information. Displays general configuration data of the applications, end
users, pages, probes, transactions, and engine that have been configured for monitoring by RUM in End
User Management Administration. For details, see "Monitoring Configuration Information" on the next
page.
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l JMX Console. Provides a link to the RUM JMX console for configuring RUM parameters, such as URL
correlation parameters. For details, see "JMX Console" on page 134. (For details on URL correlation, see
"Correlating Collected Data with Configured Pages" in the APM Application Administration Guide.)

l IP Translator. Used to convert between the internal number used by the engine to represent an IP
address and the actual IP address it represents. For details, see "IP Translator" on page 134.

l Time Converter. Used to convert a date and time to an internal number used by the enginemachine to
represent this value. You can also convert the number used by the enginemachine to the date and time it
represents. For details, see "TimeConverter" on page 134.

l Mobile Application Instrumentation. Used to instrument Android APKs for monitoringmobile
applications. For details, see "Mobile Application Instrumentation" on page 135.

Monitoring Configuration Information
The Engine Configuration page displays general configuration data of the applications, end-users, events,
pages, probes, transactions, and engine that have been configured for monitoring by RUM in End User
Management Administration.

Click theSync All Configuration button, located at the top of the Engine Configuration page, to force the
RUM Engine to reload the RUM configuration from APM.

You display the data type you want to see by selecting it from the drop-downmenu located at the top left
corner of the page and clickingGenerate.

This section includes the following topics:

l "Applications" below
l "End Users" on the next page
l "Events" on the next page
l "Pages" on page 131
l "Probes" on page 132
l "Transactions" on page 132
l "Engine Settings" on page 133
l "Transaction Snapshot Mode" on page 134

Applications
When you select applications as the data type to be displayed, the following information about the configured
applications is displayed:

Column Description

ID An internal ID number allocated by APM.

Is Application enabled True or False – as configured in End User Management Administration.

Name The name of the application as configured in End User Management
Administration.

Type The application type as configured in End User Management Administration.
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Column Description

Probes which monitor
the application

The IP addresses and names of the probes configured in End User
Management Administration tomonitor the application.

You can filter the data displayed on theName column. The filter is case sensitive.

For information on configuring applications for monitoring, see "RUM Application ConfigurationWizard" in the
APM Application Administration Guide.

End Users
When you select end users as the data type to be displayed, the following information about the configured
end users is displayed:

Column Description

ID An internal ID number allocated by APM.

Is End User enabled True or False – as configured in End User Management Administration.

Name The name of the end-user group as configured in End User Management
Administration.

Description The description of the end-user group as configured in End User Management
Administration.

Is Monitored (for
collection)

True or False – use host name resolution as configured in End User
Management Administration.

You can filter the data displayed on theName column. The filter is case sensitive.

For information on configuring end-user groups for monitoring, see "Add End User Group with RUM
Configuration Dialog Box" in the APM Application Administration Guide.

Events
When you select events as the data type to be displayed, the following information about the configured
events is displayed:

Column Description

ID An internal ID number allocated by APM.

Is Event enabled True or False – as configured in End User Management Administration.

Name The name of the event as configured in End User Management
Administration.

Event type The event type as configured in End User Management Administration.

Report As Error True or False – as configured in End User Management Administration.

Create Snapshot True or False – as configured in End User Management Administration.
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Column Description

Collection Session
Snapshot

True or False – as configured in End User Management Administration.

Note: Defining events and snapshots has an effect on RUM capacity. For more information on RUM
capacity, see the Real User Monitor Sizing Guide.

You can filter the data displayed on theName column. The filter is case sensitive.

For information on configuring events for monitoring, see "RUM Administration User Interface" in the APM
Application Administration Guide.

Pages
When you select pages as the data type to be displayed, the following information about the configured pages
is displayed:

Column Description

Page ID An internal ID number allocated by APM.

Is Page
Enabled

True or False – as configured in End User Management Administration.

Page Name The name of the page as configured in End User Management Administration.

Application The name of the application in which the page is included.

Description The description of the page as configured in End User Management Administration.

Monitored
Type

Themonitoring condition as configured in End User Management Administration. The
possible conditions are:

1 = Always

2 = Never

3 = Only as part of a transaction

Page Type Currently not used

Page Time
Threshold

The page time threshold, in milliseconds, as configured for the page in End User
Management Administration.

Server Time
Threshold

The server time threshold, in milliseconds, as configured for the page in End User
Management Administration.

Availability
Threshold

The availability threshold, in percent, configured for the page in End User Management
Administration.

Timeout The amount of time, in milliseconds, after which the page is considered to have timed out,
as configured for the page in End User Management Administration.

Page URL The URL of the page as configured in End User Management Administration.

You can filter the data displayed on thePage Name column. The filter is case sensitive.
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For information on configuring pages for monitoring, see "Action Dialog Box" in the APM Application
Administration Guide.

Probes
When you select probes as the data type to be displayed, the following information about the configured
probes is displayed:

Column Description

ID An internal ID number allocated by APM.

Is probe
enabled

True or False – as configured in End User Management Administration.

IP The IP address of the probe as configured in End User Management Administration.

Login
username

The user name for logging in to the probe as configured in End User Management
Administration.

Name The name of the probe as configured in End User Management Administration.

Description The description of the probe as configured in End User Management Administration.

You can filter the data displayed on theName column. The filter is case sensitive.

For information on configuring probes for monitoring, see "Installing RUM" in the Real User Monitor
Installation and UpgradeGuide.

Transactions
When you select transactions as the data type to be displayed, the following information about the configured
transactions is displayed:

Column Description

Trx ID An internal ID number allocated by APM.

Is Trx
Enabled

True or False – as configured in End User Management Administration.

Trx Name The name of the transaction as configured in End User Management Administration.

Application The name of the application in which the transaction is included.

Description The description of the transaction as configured in End User Management Administration.

Transaction
report page

The name of the page which, if reached, causes the transaction to be reported as
unavailable, for transaction errors or timeouts within a session.

Refresh
behavior

The page instance that is measured in case of a refresh, as configured in End User
Management Administration. The possible instances are:

0 = First page

1 = Last page
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Column Description

Timeout The amount of time, in milliseconds, of inactivity since the last page download in a
transaction, that causes the transaction to time out, as configured for the transaction in End
User Management Administration.

Gross Time
Threshold

The total transaction time threshold (download time + think time), in milliseconds, as
configured for the transaction in End User Management Administration.

Net Time
Threshold

The net transaction time threshold, in milliseconds, for the pages included in the transaction,
as configured in End User Management Administration.

Server
Time
Threshold

The server time threshold, in milliseconds, as configured for the transaction in End User
Management Administration.

Availability
Threshold

The availability threshold, in percent, as configured for the transaction in End User
Management Administration.

Trx pages The names of the pages included in the transaction, as configured in End User Management
Administration.

You can filter the data displayed on the Trx Name column. The filter is case sensitive.

For information on configuring transactions for monitoring, see "Business Transaction RUMConfiguration
Page" in the APM Application Administration Guide.

Engine Settings
When you select engine settings as the data type to be displayed, the following information about the
configured engine is displayed:

Column Description

Engine Name Name of the engine as configured in End User Management Administration.

Profile ID Internal APM profile ID.

Profile Name Internal APM profile name.

Engine ID Internal APM engine ID.

Customer Name Always default client.

Snapshot on Error
Enabled

True or False – as configured in End User Management Administration.

Snapshot page
number

Number of pages for which to collect snapshot on error, as configured in End
User Management Administration.

Is monitoring default
application

The applications that aremonitored by the engine, as configured in End User
Management Administration.

0 = configured applications only

1 = all applications
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Column Description

Default Application
Name

Name of default application (for all applications not configured in End User
Management Administration).

Default HTTP Port Default http port of enginemachine.

Default HTTPS Port Default https port of enginemachine.

Default Application ID Internal APM application ID.

Transaction Snapshot Mode
When you select transaction snapshot mode as the data type to be displayed, the following information about
the transaction snapshot mode is displayed:

Column Description

Name The application name.

ID Internal APM application ID.

Snapshot mode on True or False – as configured in End User Management Administration.

JMX Console
This option provides a link to the RUM JMX console, which you use to view and configure RUM parameters,
for example, URL correlation parameters. For details on configuring URL correlation parameters, see
"Correlating Collected Data with Configured Pages" in the APM Application Administration Guide. For details
on working with the JMX console, see "Using the JMX Console to Configure the RUM Engine" on page 139.

IP Translator
You use the IP Translator tool to convert an IP address into different formats. The formats to which the IP data
is translated are:

l Host name. The name of themachine to which the IP address is assigned.
l Signed integer. An internal, signed number used in RUM data samples.
l Unsigned integer. An internal, unsigned number used in RUM data samples.
l Dotted-format IP address. The standard, dotted-decimal notation for the IP address.
You select one of the formats and enter the source data you want to convert to the other formats, or you select
theResolve Engine host option to use the IP address of the current RUM Enginemachine as the source
data.

Click Submit to translate the source data to all the other formats.

Time Converter
You use the TimeConverter tool to convert a time into different formats. The formats to which the time is
converted are:
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l The number of milliseconds since January 1, 1970 – an internal number used by the RUM Engine.
l Time in GreenwichMean Time.
l Time in the time zone set for the RUM Enginemachine.
You select one of the formats and enter the source data you want to convert to the other formats, or you select
theCurrent time option to use the current time as the source data for conversion.

Click Submit to convert the source data to all the other formats.

Mobile Application Instrumentation
The RUMmobile solution enables you tomonitor mobile applications through apps on a user's mobile device
and sends the collected data from the app directly to the RUMClient Monitor Probe. For details, see "Using
the RUMMobile Solution toMonitor Mobile Applications" on page 34.

You use theMobile Application Instrumentation page to instrument an Android APK for monitoring amobile
application. (You can also instrument an APK using a command line batch file. For details, see "Instrumenting
Mobile Apps for Android" in the Real User Monitor Installation and UpgradeGuide.) The instrumentation is
made to the compiled Java classes in the APK and does not modify any source code, as it is done in the post-
build stage.

Note: If you select to apply content extraction configuration change at instrumentation time only, during
instrumentation the RUM engine will try to update the Static Configuration File with the latest
configuration changes before instrumenting the application. If the update fails, a warningmessage
appears telling you to check the configmanager.log for details.

Note: If during instrumentation it is discovered that ACRA crash reporting is already instrumented on
your application, the RUM crash reporting will be disabled, the instrumentation will succeed, but a
warningmessage will appear on the console.

User interface elements are described below:

UI Ele
ment Description

APK
file

Enter the path and file name of the source APK file that you are instrumenting. You can click
Browse to navigate to the relevant file.
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UI Ele
ment Description

Instru
ment
for
Produ
ction

Select this option to fully sign the APK using a Java keystore file with a private key. If you select
this option, configure the following:

Applicati
on

From the drop-down list, select the application configured in APM to which the
monitored data will be associated.

Note:Only applications that use the Network for Mobile Application template are
displayed in the list.

RUM
Client
Monitor
Probe
URL

Enter the URL for the RUMClient Monitor Probe to whichmonitored data is sent.
The format is:

https://<RUM Client Monitor Probe host name>:443/<path to the RUM
Client Monitor Probe on the host>

Note: If no port is specified, port 443 is used by default.

Applicati
on
Signing

Leave the following fields blank if you want to sign the APK later. You can sign the
APK later using Java’s jarsigner.exe tool (see "Signing an APK using Java’s
jarsigner.exe Tool" on page 138).

Keystore file The path and name of the keystore file. You can click
Browse to navigate to the relevant file.

If you do not configure a keystore file, the APK will not be
signed.

Keystore password A password for the keystore, if configured.

Key alias The alias to the private key entry in the keystore.

Note: This field is mandatory if you configure a
keystore file.

Key password A password for the private key entry in the keystore, if
configured.

Add
Access
Network
State
permissi
on to the
applicatio
n

Select this check box to enable the APK to determine and report the type of user
connection (WiFi/2G/G3/4G).

Allow
access
to http
conten
t

Select one of the following to define when to apply mobile device configuration changes
performed in APM Admin to themobile devices. This includes change to parameters, user name,
or unhiding query parameters.
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UI Ele
ment Description

Apply
any
configura
tion
change to
the
mobile
device
even after
instrume
ntation

Select this option to enable the application to send any change in content extraction
to themobile device. Changes to the configuration can be performed even after the
application is deployed on themobile device.

Apply
content
extraction
configura
tion
change at
instrume
ntation
time only

Select this option to enable the application to extract content configuration only
when instrumenting the application. To apply a configuration change, you need to
repeat the instrumentation.

Do not
allow
content
extraction

Select this option to disable the application from using any extracted content
(parameter settings, username detection, or allowed POST parameters) configured
for it in APM, when the application runs.

Instru
ment
for
Testin
g

Select this radio button to sign the APK with a self-signed debug certificate.

Note: This is sufficient for testing the APK, but not for uploading it to the Google Play store.

If you select this option, configure the following:

Applicati
on

From the drop-down list, select the application configured in APM to which the
monitored data will be associated.

Note:Only applications that use the Network for Mobile Application template are
displayed in the list.

RUM
Client
Monitor
Probe
URL

Enter the URL for the RUMClient Monitor Probe to whichmonitored data is sent.
The format is:

https://<RUM Client Monitor Probe host name>:443/<path to the RUM
Client Monitor Probe on the host>

Note: If no port is specified, port 443 is used by default.
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UI Ele
ment Description

Instru
ment
for
Offline
Testin
g and
Data
Collec
tion

Select this option not to sign the APK after instrumentation. You can test the application offline
and collect data locally only.

Note: The APK must be fully signed before you can upload it to the Google Play store.

If you select this option, configure the following:

Store
monitore
d data
locally

Select this check box to configure the APK not to send collected network data to the
probe and to store it locally in the application folder on themobile device.

This data includes the POST content of requests, which can assist you in defining
extracted parameters for the application in APM. For details on extracted
parameters, see "Parameter Extraction Area" in the Real User Monitor Application
General Page in the APM Application Administration Guide.

Signing an APK using Java’s jarsigner.exe Tool
After generating an unsigned instrumented APK, you can sign the APK using Java’s jarsigner.exe tool.

1. From a cmdwindow, enter:

jarsigner.exe –verbose –sigalg SHA1withRSA –digestalg SHA1 –keystore <KEYSTORE_FILE_
FULL_PATH> –storepass <KEYSTORE_PASSWORD> –keypass <KEY_PASSWORD> <APK_FILE_FULL_
PATH> <ALIAS>

Parameter Description

KEYSTORE_FILE_FULL_PATH The path to the keystore file

KEYSTORE_PASSWORD The password to the keystore

KEY_PASSWORD The password for the private key entry in the keystore

APK_FILE_FULL_PATH The full path for the APK file

ALIAS The alias to the private key entry in the keystore.

Note: If you have trouble uploading your mobile application to the app store due to a signing problem, re-
sign the application using the Java 6 jarsigner.exe tool.

2. (Optional) Use Java’s zipalign utility for memory optimization. From a cmdwindow, enter:

zipalign.exe –f –v 4 <SOURCE_APK_FILE_FULL_PATH> <TARGET_APK_FILE_FULL_PATH>

Parameter Description

SOURCE_APK_FILE_FULL_PATH The full path to the source APK file

TARGET_APK_FILE_FULL_PATH The full path to the target APK file
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Chapter 9: Using the JMX Console to
Configure the RUM Engine
You configure RUM Engine settings via the JMX console.

Note: You also use the web console to configure the engine, monitor system health, and use a number of
diagnostic tools. For details, see "Using the RUMWebConsole" on page 41.

This chapter includes the following topics:

l "Using the RUM JMX Console" below
l "URLCorrelation Parameters" on page 145

Using the RUM JMX Console
You use the RUM Engine JMX console to view and configure RUM settings.

This section includes the following topics:

l "Accessing the JMX Console" below
l "Setting URLCorrelation Parameters" on the next page
l "Configuring RUM Aggregation" on the next page
l "Configuring the Samples Rate" on page 142
l "Configuring the Amount of Unsent Sample Data to Store in RUM" on page 142
l "Configuring the Classification Type" on page 143

Accessing the JMX Console
Via the JMX console, you can view and configure RUM parameters, view statistics for RUMmodules and
services, and view and configure JBoss components.

Once you start the RUM Engine after installation, you can access the RUM Engine JMX console by launching
the RUM Engine web console and choosing JMX Console from the Tools drop-downmenu. To access a
specific area of the JMX console for an individual RUMmodule, select Advanced Settings from the
Configuration drop-downmenu in the RUM Engine web console and then click the links for themodule you
want to view. For details on the RUM Engine web console, see "Using the RUMWebConsole" on page 41.

When you access the JMX console, you are prompted for a user name and password. Enter the JMX console
authentication credentials (if you do not have these credentials, contact your system administrator).

Note: You can access the RUM Engine JMX console from a different machine by launching a web
browser and typing the following: http://<HPE engine machine name>:8180/jmx-console

Caution: Changing any of the JMX configuration settings can cause RUM tomalfunction. We
recommend that you do not change any of these settings.
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Setting URL Correlation Parameters
You can configure a number of parameters used by RUMwhen correlating recorded URLs with URLs you
have configured for monitoring. For details on URL correlation, see "Correlating Collected Data with
Configured Pages" in the APM Application Administration Guide. For details on configuring URLs for
monitoring, see "Real User Monitor Application ConfigurationWizard" in the APM Application Administration
Guide.

Some of the URL correlation parameters are set using the RUM JMX console. For details on changing URL
correlation parameters via the RUM JMX console, see "Setting URLCorrelation Parameters Via the JMX
Console" on page 145.

Configuring RUM Aggregation
RUM pre-aggregates a number of the data samples it sends to APM. For details on APM aggregation, see
"Data Aggregation" in the APM Application Administration Guide. For details on RUM pre-aggregation, see
"Aggregating Real User Monitor Data" in the APMUser Guide.

You can change the RUM default aggregation periods via the JMX console.

This section includes the following topics:

l "Pre-aggregated Data Sample Types" on the next page
l "Changing Default Aggregation Periods" on the next page
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Pre-aggregated Data Sample Types
The following table shows the data sample types that are pre-aggregated by RUM, the JMX service in which
they are configured, their attribute and parameter names, and the default aggregation time period:

Data
Sample
Type

JMX Console
Rum.modules
Service Name

Attribute
in JMX
Service Parameter Name

Default
Aggregation
Period in
Milliseconds

Action StatisticsMgrConf Properties aggregator.actions.interval 300,000

Slow End
User

aggregator.domains.interval 300,000

Missing
Component

aggregator.MissingComponents.interval 300,000

Slow Action aggregator.SlowActions.interval 300,000

Slow
Location

aggregator.slowlocations.interval 300,000

Top
Location

aggregator.toplocations.interval 360,000

Top End
User

aggregator.TopDomains.interval 360,000

Top Action aggregator.TopActions.interval 360,000

Most Error
Action

aggregator.actionerrorevent.interval 300,000

Application
Statistics

aggregator.applications.interval 300,000

Transaction aggregator.transaction.interval 300,000

TCP
Application
Statistics

aggregator.tcpapplications.interval 300,000

Undefined
End User
(Domain)

aggregator.domains.interval 300,000

Changing Default Aggregation Periods
You can change the default aggregation periods using the JMX console.

To change the RUM default aggregation periods via the JMX console:

1. Access the JMX console by choosing JMX Console from the Tools drop-downmenu in the RUMweb
console, or by using the following URL in your web browser:
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http://<HPE Real User Monitor engine machine name>:8180/jmx-console

When prompted, enter the JMX console authentication credentials (if you do not have these credentials,
contact your system administrator).

2. In the JMX Agent View, scroll down to theRUM.modules section and click the applicable service
(service=StatisticsMgrConf).

3. Change the aggregation period as required. To change parameter values in theProperties attribute, enter
the parameter name and the aggregation period (in milliseconds) you want to change under the
commented lines (the lines beginning with #) in the format:

attribute name=aggregation period

For example, to change the aggregation period of the Action sample type to 10minutes, enter:

aggregator.actions.interval=600000

4. Click theApply Changes button to save the change.
5. Activate the change by clicking the Invoke button for the deployConfiguration operation.

Caution: Changing the default aggregation periods can significantly affect the amount of data sent by
RUM to APM. We recommend that you do not change the default aggregation periods.

Configuring the Samples Rate
Themaximum burst rate controls the number of samples per second that the RUM Engine can send to APM.
The default setting is 300. You can increase themaximum burst rate to allow more samples to be sent per
second, provided that APM is capable of handling the increased number. You can see the state of the flow of
samples between RUM and APM by looking at thePublisher burst state in RUM system health. For details
on RUM system health, see "Monitoring the Health of RUMComponents" on page 44.

To configure the maximum burst rate:

1. Access the JMX console by choosing JMX Console from the Tools drop-downmenu in the RUMweb
console, or by using the following URL in your web browser:

http://<HPE Real User Monitor engine machine name>:8180/jmx-console

When prompted, enter the JMX console authentication credentials (if you do not have these credentials,
contact your system administrator).

2. In the JMX Agent View, scroll down to theRUM.modules section and click
service=PublisherSettings.

3. In theBurstControlMaxSamples parameter, change the value to themaximum number of samples
required.

4. Click theApply Changes button to save the change.
5. Click the Invoke button for the applyAttributeChanges operation to activate the change.

Configuring the Amount of Unsent Sample Data to Store in
RUM
By default, 1000 chunks of samples data are stored in RUM for sending to APM. You can increase the number
of chunks of data stored (providing you have sufficient disk space) to avoid data loss when APM cannot
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receive data from RUM. For example, youmight want to increase the amount of data stored by RUM during a
planned downtime in APM. Bear in mind that when a lot of data has been stored in RUM, it can take a long
time for all of it to be sent to APM, whichmight cause a delay in seeing real time data. If you increase the
number of data chunks to store, you should reset it to the original number once APM is running and all the
stored data has been transmitted to it.

To increase the maximum number of data chunks stored:

1. Access the JMX console by choosing JMX Console from the Tools drop-downmenu in the RUMweb
console, or by using the following URL in your web browser:

http://<HPE Real User Monitor engine machine name>:8180/jmx-console

When prompted, enter the JMX console authentication credentials (if you do not have these credentials,
contact your system administrator).

2. In the JMX Agent View, scroll down to theRUM.modules section and click
service=PublisherSettings.

3. In theMaxChunksInQueue parameter, change the value to themaximum number of chunks required.
4. Click theApply Changes button to save the change.
5. Click the Invoke button for the applyAttributeChanges operation to activate the change.

Configuring the Classification Type
The classification algorithm groups similar, unconfigured actions under one name (a generic descriptor) and
aggregates their measurements to obtain values for the descriptor. The aggregated actions can be viewed in
the RUM Action Summary report in APM. For HTTP-Web based protocols, there are twomethods of
classification:

l The default method groups actions based on both URLs and parameters.
l An alternativemethod groups actions based on URL paths only. This method is best suited for
applications with changing path or parameter names.
To configure an application to use this alternative classificationmethod, you configure the RUM template
on which the application is based. RUM templates have predefined values for themost common,
recommended configuration settings for a specific protocol and are used to simplify the creation of
RUM applications in APM. For details on configuring the templates to use the alternative classification
method, see "To configure the RUM templates that classify URLs based only on their paths:" on the next
page.

The following examples show the generic descriptor created by each classificationmethod for a group of
monitored URLs:

Example 1
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Monitored URLs

Generic Descriptor Created by
the Default Classification
Method

(using both URLs and
parameters)

Generic Descriptor Created by
the Alternative Classification
Method

(using URL paths only)

http://site/a/b/c?x=1&y=10

http://site/a/b/c?x=2&y=20

http://site/a/b/c?x=3&y=30

http://site/a/b/c?x=*&y=* http://site/a/b/c

Example 2

Monitored URLs

Generic Descriptor Created by
the Default Classification
Method

(using both URLs and
parameters)

Generic Descriptor Created by
the Alternative Classification
Method

(using URL paths only)

http://site/a/b/c1?x=1&y=10

http://site/a/b/c2?x=2&y=20

http://site/a/b/c3?x=3&y=30

http://site/a/b/c1?x=*&y=*

http://site/a/b/c2?x=*&y=*

http://site/a/b/c3?x=*&y=*

http://site/a/b/*

You can configure RUM templates based only on the HTTP-Web protocol to use the alternative classification
method using URL paths only. In APM, you can view a template's protocol in the list of protocols provided
when you create a new RUM application for monitoring, or in the Real User Monitor Application General Page
when viewing an existing application.

Note: The default classificationmethod is used for applications using RUM templates based on the
HTTP-Web protocol that are not configured to use the alternative classificationmethod. However, if the
default method cannot produce satisfactory results, the alternativemethod is then automatically used.

To configure the RUM templates that classify URLs based only on their paths:

1. Access the JMX console by choosing JMX Console from the Tools drop-downmenu in the RUMweb
console, or by using the following URL in your web browser:

http://<HPE Real User Monitor engine machine name>:8180/jmx-console

When prompted, enter the JMX console authentication credentials (if you do not have these credentials,
contact your system administrator).

2. In the JMX Agent View, scroll down to theRUM.modules section and click
service=ResolverTrieClassificationSettings.

3. In the adminTemplatesOfTrieClassificationAlg parameter, enter a comma separated list of the RUM
template IDs for which you want classification to bemade on URL paths only.
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Note: To determine a template's ID, edit the xml file for the relevant template and under the
<metadata> tag, locate the value for template_id. By default, template configuration files are
located on the APMGateway Server in the <APM>\conf\rum_templates directory.

4. Click theApply Changes button to save the change.

URL Correlation Parameters
After the RUM Engine has been installed and started, you can configure a number of parameters to determine
how RUM correlates recorded URLs with web pages you have configured for monitoring in End User
Management Administration.

This section includes the following topics:

l "Setting URLCorrelation Parameters Via the JMX Console" below
l "Correlating Session ID Parameters" on the next page

Setting URL Correlation Parameters Via the JMX Console
You can change the default setting of a number of parameters used by RUMwhen correlating recorded URLs
with URLs you have configured for monitoring. For details on URL correlation, see "Correlating Collected
Data with Configured Pages" in the APM Application Administration Guide. For details on configuring URLs
for monitoring, see "Real User Monitor Application ConfigurationWizard" in the APM Application
Administration Guide.

You can configure the following parameters for URL correlation in the JMX console:

l adaptIndexurl. By default, RUM considers URLs with a suffix of index.html (and other suffixes that are
configured in the urlIndexStrings parameter) to be same as the root URL. For example,
http://www.hpe.com/index.html is considered to be the same as http://www.hpe.com/. To instruct
RUM to consider all suffixes as being different from the root URL, change this parameter to False.

l urlIndexStrings. URL suffixes configured in this parameter are considered to be the same as the root
URL, if the adaptIndexurl parameter is set to True. For example, if the suffix index.html is configured,
then http://www.hpe.com/index.html is considered to be the same as http://www.hpe.com/. By
default, the suffix index.html is configured in this parameter. To add additional suffixes, add them to the
string separated by a semicolon (;). The last suffix in the stringmust also be followed by a semicolon. For
example, /;/index.html;/index.aspx;.

Note: For the urlIndexStrings parameter to be active, the adaptIndexurl parameter must be set to
True.

The index strings in the urlIndexStrings parameter are considered as being identical for all URLs. For
example, if /;/index.html; is configured in the urlIndexStrings parameter then
http://www.hpe.com/ and http://www.hpe.com/index.html are considered as being identical,
http://www.hpe-int.com/ and http://www.hpe-int.com/index.html are considered as being
identical, and so forth.
Changing the urlIndexStrings parameter requires the RUM Engine Resolver to be restarted. For
details, see "To restart the RUM Engine Resolver" on the next page.

l adaptCaseSensitive. By default, RUM URL correlation is case-insensitive, so that a recorded URL such
as http://www.hpe.com/rumEnginePage.html is correlated with the configured URL
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http://www.hpe.com/rumenginepage.html. To instruct RUM to use case-sensitive URL correlation (for
all but the host and protocol parts of a URL), you set this parameter to False.

l basicAuthentication. By default, RUM ignores basic authentication when performing URL correlation.
For example, the recorded URL http://bob:my_password@www.hpe.com is correlated with the configured
URL http://www.hpe.com. To instruct RUM to consider basic authentication when performing URL
correlation, you set this parameter to False.

To change the default setting of a URL correlation parameter in the JMX console
1. Access the JMX console by choosing JMX Console from the Tools drop-downmenu in the RUMweb

console, or by using the following URL in your web browser:

http://<HPE Real User Monitor engine machine name>:8180/jmx-console

When prompted, enter the JMX console authentication credentials (if you do not have these credentials,
contact your system administrator).

2. In the JMX Agent View, scroll down to theRUM.modules section and click
service=ResolverURLMConfig.

3. In the relevant parameter, change the setting to the required value.
4. Click theApply Changes button.

To restart the RUM Engine Resolver
1. Access the JMX console by choosing JMX Console from the Tools drop-downmenu in the RUMweb

console, or by using the following URL in your web browser:

http://<HPE Real User Monitor engine machine name>:8180/jmx-console

When prompted, enter the JMX console authentication credentials (if you do not have these credentials,
contact your system administrator).

2. In the JMX Agent View, scroll down to theRUM.modules section and click service=Resolver.
3. Scroll down to the restart operation and click Invoke.

Correlating Session ID Parameters
You can configure specific parameters in recorded URLs to be ignored by RUMwhen correlating recorded
URLs with URLs you have configured for monitoring in End User Management Administration. For details on
URL correlation, see "Correlating Collected Data with Configured Pages" in the APM Application
Administration Guide. For details on configuring URLs for monitoring, see "RUM Application Configuration
Wizard" in the APM Application Administration Guide.

If you set a parameter to be ignored by RUM, and the parameter is included in a recorded URL, RUM replaces
the contents of that parameter with an asterisk (*). For example, if you set RUM to ignore theBV_SessionID
andBV_EngineID parameters in the following URL:

http://www.hpe.com/~anand/Ticket_Confirm.jsp?BV_
SessionID=@@@@1812057630.1043567934@@@@&BV_
EngineID=cccdadchgidfmlmcefecehidfhfdffk.0&value=0000144976

The URL is translated as follows:

http://www.hpe.com/~anand/Ticket_Confirm.jsp?BV_SessionID=*&BV_
EngineID=*&value=0000144976
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The parameters to be ignored are defined per application server.

To configure session ID parameters to be ignored
1. Open the <HPE Real User Monitor root directory>\conf\configurationmanager\Application_

Server_Types_configuration.xml file in a text editor.
2. Locate the application server type for which you are configuring the parameters to be ignored. This

appears in the format <AppServer name="app_server_name">, where app_server_name is the name of
the application server type. For example, for a Broadvision application server, the entry is:
<AppServer name="BroadVision">

3. Under the application server name, in the section beginning with the <DiscardParameters> tag, is a list
of themost common session ID parameters for that application server. You can add and delete
parameters to create a list of all the parameters you want RUM to ignore during correlation. Parameters
are entered in the format <parameter>parameter_name</parameter>, where parameter_name is the
name of the parameter. For example, for a parameter called BV_EngineID, the entry is.
<parameter>BV_EngineID</parameter>

4. If you want RUM to consider the parameters you enter as a regular expression instead of a string (which
is the default), you add type="regEx" to the <DiscardParameters> tag. For example,
<DiscardParameters type="regEx">

5. Under the application server name, in the line:
<attribute name="enabled">false</attribute>
change false to true.

6. Save the file and exit the editor.
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Chapter 10: RUM Engine File Configuration
Some of the settings used by the RUM Engine aremade in various files that you can edit.

This chapter includes the following topics:

l "ConfiguringMeaningful Page Names" below
l "Unifying Frames" on page 166
l "Configuring User Name Translation" on page 168

Configuring Meaningful Page Names
You can configure RUM to change the URLs of discovered pages that are not configured in End User
Management Administration tomoremeaningful names for use in RUM reports. For information on configuring
pages for monitoring, see "Action Dialog Box" in the APM Application Administration Guide. For information
on RUM reports, see "End User Management Reports Overview" in the APMUser Guide.

This section includes the following topics:

l "About Discovered Page Names" below
l "Formatting Tags" on the next page
l "Rule Tags" on page 157
l "Sample XML File" on page 159
l "ValidatingMeaningful Name XML Files" on page 164
l "Adding and DeletingMeaningful Name XML Files" on page 165
l "ChangingMeaningful Name XML Files" on page 165
l "Viewing Discovered Page Statistics" on page 166

About Discovered Page Names
For each application configured in End User Management Administration, you can create an XML file to be
used to givemeaningful names to pages that are discovered as part of the application, but that are not
configured as pages in End User Management Administration. For information on configuring applications for
monitoring, see "RUM Application ConfigurationWizard" in the APM Application Administration Guide. For
information on configuring pages for monitoring, see "Action Dialog Box" in the APM Application
Administration Guide.

If an XML file has been created and an application linked to it, when a page that is not configured in End User
Management Administration is discovered as part of the application, the page’s URL is compared to the rules
in the XML file. If matches are found, the page is given a new name for use in RUM reports. (A page's URL
must bematched at least three times before this occurs.) If nomatches are found, or if no XML file has been
created and linked to the application, the page’s URL as recorded is used in RUM reports. For information on
RUM reports, see "End User Management Reports Overview" in the APMUser Guide.

The XML file must be created in the \<RUM root directory>\conf\resolver\meaningful_pages directory on
the RUM Enginemachine. For convenience, we recommend that the file name is the same as the application
name. For example, an XML file created for an application calledmyapplication is:
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\<HPE Real User Monitor root directory>\conf\resolver\meaningful_pages\myapplication.xml

Note: RUM includes two default XML files for the PeopleSoft 8.1 and Siebel 7.5 applications.

The XML file contains the followingmain sections:

l Formatting. Contains the formatting commands for changing a URL into ameaningful name.
l Rules. Contains the rules that determine whether or not a page’s URL is changed to ameaningful name.

Tip:We recommend that you create the rules before the formats.

Formatting Tags
The first main section in the XML file is the formatting section, which contains the XML tags that are used to
format parts of a page’s URL, which are then used to create ameaningful name for the page.

Note: All parts of a page’s URL are converted by RUM to lower case for matching and formatting.

The following formatting tags can be used. For the XML schema to be validated (for details, see "Validating
Meaningful Name XML Files" on page 164), the tags must appear in the XML file in the order in which they are
listed below:

l "URLDecoder" below
l "Rename" on the next page
l "Substring" on the next page
l "ExtractStrToStr" on the next page
l "ExtractIndexToStr" on page 151
l "ExtractStrToCount" on page 152
l "Insert" on page 153
l "ChangeCase" on page 154
l "Remove" on page 154
l "RemoveNonAlpha" on page 154
l "Replace" on page 155
l "Alias" on page 155
l "RegExExtract" on page 156
l "RegExMatch" on page 156

URL Decoder
The URLDecoder tag is used to decode a source string using a specified decoder.

Syntax <URLDecoder Name="Command_Name"
EncodingScheme="Scheme"/>

Explanation Command_Name. The name of the Substring formatting tag that can be used in Rule tags.

Scheme. The decoding scheme to be used.
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Example <URLDecoder Name="DecodeUTF-8" EncodingScheme="UTF-8"/>

When the DecodeUTF-8 formatting command is referenced in a rule, the string is decoded
using the UTF-8 decoding scheme.

Note If the URLDeocder tag is used, but no encoding scheme is specified, the UTF-8 scheme is
used by default.

Rename
The Rename tag is used to replace the entire contents of a source string.

Syntax <RenameName="Command_Name"
NewName="Rename_String"/>

Explanation Command_Name. The name of the Rename formatting tag that can be used in Rule tags.

Rename_String. The string to be substituted for the source string.

Example <RenameName="RenameToABC123" String="HPE"

When theRenameToABC123 formatting command is referenced in a rule, the entire source
string is renamed toHPE.

Substring
The Substring tag is used to extract a sub string from the source string.

Syntax <SubString Name="Command_Name"
BeginIndex="Start_Char_Index"Count="Length"/>

Explanation Command_Name. The name of the Substring formatting tag that can be used in Rule tags.

Start_Char_Index. The position in the source string of the starting character of the
substring to be extracted. The first position in the source string is the zero index.

Length. The number of characters from the Start_Char to be extracted. If the number used
is greater than the number of characters from the Start_Char to the end of the source string,
the entire string from the Start_Char to the end of the source string is extracted.

Example <Substring Name="ExtractTenToTwelve"
BeginIndex="10" Count="3"/>

When theExtractTenToTwelve formatting command is referenced in a rule, the tenth,
eleventh, and twelfth characters of the source string are extracted.

ExtractStrToStr
The ExtractStrToStr tag is used to extract a string between two given strings from the source string.
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Syntax <ExtractStrToStr Name="Command_Name"
fromString="Start_String"
fromInclude="Include_Start_String"
fromOccurrences="Occurrences_Start_String"
toString="End_String"
toInclude="Include_End_String"
toOccurrences="Occurrences_End_String"/>

Explanation Command_Name. The name of the ExtractStrToStr formatting tag that can be used in Rule
tags.

Start_String. The starting string from which the required string is to be extracted.

Include_Start_String.Whether to include the starting string as part of the extracted string.
Valid options are:

l True. Include the starting string as part of the extracted string. This is the default used if
nothing is specified.

l False. Do not include the starting string as part of the extracted string.
Occurrences_Start_String. The occurrence number of the starting string at which to start
the extraction of the required string. Valid options are 1-100 or last.

End_String. The ending string up to which the required string is to be extracted.

Include_End_String.Whether to include the ending string as part of the extracted string.
Valid options are:

l True. Include the ending string as part of the extracted string. This is the default used if
nothing is specified.

l False. Do not include the ending string as part of the extracted string.
Occurrences_End_String. The occurrence number of the ending string at which to end the
extraction of the required string. Valid options are 1-100 or last.

Example <ExtractStrToStr Name="ExtractBetweenABCandXYZ"
fromString="ABC" fromInclude="true"
fromOccurrences="2" toString="XYZ" toInclude="false"
toOccurrences="1"/>

When theExtractBetweenABCandXYZ formatting command is referenced in a rule, the
string between the second occurrence of ABC and the first occurrence of XYZ in the source
string is extracted. The starting string of ABC is also included at the beginning of the
extracted string.

ExtractIndexToStr
The ExtractIndexToStr tag is used to extract a string between a given starting position and a given ending
string in the source string.

Syntax <ExtractIndexToStr Name="Command_Name"
fromIndex="Start_Char_Index" toString="End_String"
toInclude="Include_End_String"
toOccurrences="Occurrences_End_String"/>
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Explanation Command_Name. The name of the ExtractIndexToStr formatting tag that can be used in
Rule tags.

Start_Char_Index. The character number from which to start extracting the required string.
The first position in the source string is the zero index.

End_String. The ending string up to which the required string is to be extracted.

Include_End_String.Whether to include the ending string as part of the extracted string.
Valid options are:

l True. Include the ending string as part of the extracted string. This is the default used if
nothing is specified.

l False. Do not include the ending string as part of the extracted string.
Occurrences_End_String. The occurrence number of the ending string at which to end the
extraction of the required string. Valid options are 1-100 or last.

Example <ExtractIndexToStr Name="ExtractBetween3andXYZ" fromIndex="3" toString="XYZ"
toInclude="false" toOccurrences="1"/>

When theExtractBetween3andXYZ formatting command is referenced in a rule, the string
between the third index of the source string and the first occurrence of XYZ in the source
string is extracted.

ExtractStrToCount
The ExtractStrToCount tag is used to extract a string of a specified number of characters starting at a given
string in the source string.

Syntax <ExtractStrToCount Name="Command_Name"
fromString="Start_String"
fromInclude="Include_Start_String"
fromOccurrences="Occurrences_Start_String"
Count="Length" />

Note: The parameter names are case sensitive.
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Explanation Command_Name. The name of the ExtractStrToCount formatting tag that can be used in
Rule tags.

Start_String. The starting string from which the required string is to be extracted.

Include_Start_String.Whether to include the starting string as part of the extracted string.
Valid options are:

l True. Include the starting string as part of the extracted string. This is the default used if
nothing is specified.

l False. Do not include the starting string as part of the extracted string.
Occurrences_Start_String. The occurrence number of the starting string at which to start
the extraction of the required string. Valid options are 1-100 or last.

Length. The number of characters from the Start_String to be extracted. If the number used
is greater than the number of characters from the Start_String to the end of the source string,
the entire string from the Start_String to the end of the source string is extracted.

Example <ExtractStrToCount Name="ExtractBetweenABCfor5"
fromString="ABC" fromInclude="false"
fromOccurrences="1" Count="5"/>

When theExtractBetweenABCfor5 formatting command is referenced in a rule, a string
comprising the five characters after the first occurrence of the string ABC in the source
string is extracted.

Insert
The Insert tag is used to insert a string into a source string at a specified position.

Syntax <Insert Name="Command_Name"
String="Insert_String" ToIndex="Start_Char_Index"
CountFromBeginning="Direction"/>

Explanation Command_Name. The name of the Insert formatting tag that can be used in Rule tags.

Insert_String. The string to be inserted in the source string.

Start_Char_Index. The character number at which to insert the Insert_String in the source
string. The first position in the source string is the zero index.

Direction.Whether to start counting the Start_Char index position from the start of the
source string (that is, from left to right) or from the end of the source string (that is, from right
to left). The valid options are:

l True. Start counting the Start_Char index position from the start of the source string
(that is, from left to right). This is the default used if no direction is specified.

l False. Start counting the Start_Char index position from the end of the source string
(that is, from right to left).

Example <Insert Name="InsertABCAfterOrder" String="ABC" ToIndex="5"/>

When the InsertABCAfterOrder formatting command is referenced in a rule, the string
ABC is inserted in the source string, starting at the fifth index (that is, the letterA becomes
the fifth character in the source string).
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ChangeCase
The ChangeCase tag is used to change the case of a string.

Syntax <ChangeCase Name="Command_Name"
Type="Case_Type" BeginIndex="Start_Char_Index"
Count="Length"/>

Explanation Command_Name. The name of the ChangeCase formatting tag that can be used in Rule
tags.

Case_Type. The type of conversion to be carried out. The valid options are:

l UpperCase. Lower case to upper case. This is the default if no type is specified.
l LowerCase. Upper case to lower case.
l OpposisteCase. Switches the case of characters.
Start_Char_Index. The position in the source string of the starting character to be
converted The first position in the source string is the zero index.

Length. The number of characters from the Start_Char to be converted.

Example <ChangeCase Name="UpperCaseFirstChar"
Type="UpperCase" BeginIndex="0" Count="1"/>

When theUpperCaseFirstChar formatting command is referenced in a rule, the first
character of the source string is converted to upper case.

Note If Length is not specified, the ChangeCase conversion is carried out from theStart_Char to
the end of the source string.

Remove
The Remove tag is used to remove all occurrences of a specified string from a source string.

Syntax <Remove Name="Command_Name"
String="Remove_String"/>

Explanation Command_Name. The name of the Remove formatting tag that can be used in Rule tags.

Remove_String. The string to be removed from the source string.

Example <Remove Name="Removeabc" String="abc"/>

When theRemoveabc formatting command is referenced in a rule, the string abc is
removed from the source string.

RemoveNonAlpha
The RemoveNonAlpha tag is used to remove all non-alpha characters from a source string.

Syntax <RemoveNonAlpha Name="Command_Name">
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Explanation Command_Name. The name of the RemoveNonAlpha formatting tag that can be used in
Rule tags.

Example <Remove Name="RemoveAllNonAlpha"/>

When theRemoveAllNonAlpha formatting command is referenced in a rule, all non-alpha
characters are removed from the source string.

Replace
The Replace tag is used to replace all occurrences of a sub string within a source string.

Syntax <Replace Name="Command_Name"
Old="Old_String" New="New_String"/>

Explanation Command_Name. The name of the Replace formatting tag that can be used in Rule tags.

Old_String. The sub string within the source string to be replaced.

New_String. The string that replaces Old_String.

Example <Replace Name="ReplaceabcWithXYZ" Old="abc" New="XYZ"/>

When theReplaceabcWithXYZ formatting command is referenced in a rule, all
occurrences of abc in the source string are replaced withXYZ.

Alias
The Alias tag is used to replace all occurrences of an alphanumeric sub string within a string with an assigned
alias.

Syntax <Alias Name="Command_Name">
<Pair Name="Source_String" Alias="Assigned_Alias"/>
</Alias>

Explanation Command_Name. The name of the Alias formatting tag that can be used in Rule tags.

Source_String. The alphanumeric string to which you are assigning an alias.

Assigned_Alias. The alias you are assigning to replace the Source_String.

Example <Alias Name="RelateLettersToCategory">
<Pair Name="fi" Alias="Fish"/>
</Alias>

When theRelateLettersToCategory formatting command is referenced in a rule, all
occurrences of the string fi are replaced with the alias Fish.

Note You can includemultiplePair tags within the same Alias tag. Each Alias replacement is
carried out on the output string from the previous Alias replacement – that is, there is only
one output string at the end.
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RegExExtract
The RegExExtract tag is used to extract and build a name from a source string using a regular expression and
replacement formula.

Syntax <RegExExtract Name="Command_Name"
regex="Regular_Expression" replacement="Replacement_Formula"/>

Explanation Command_Name. The name of the RegExExtract formatting tag that can be used in Rule
tags.

Regular_Expression. The regular expression for extracting the name from the source
string.

Replacement_Formula. The formula used by the regular expression tomanipulate the
extract strings.

Example RegExExtract tag: <RegExExtract Name="ExtractPagePrm" regex="/
(oracle|mysql).*webui/(.*)(..)" replacement="$3-$1-MR-$2"/>

Source string: http://a-ebs.jsplc.net/OA_
HTML/OA.jsp?page=/oracle/apps/fnd/sso/login/webui/mainloginPG

Output: pg-oracle-MR-mainlogin

RegExMatch
The RegExMatch tag is used to obtain a name by using a regular expression to extract text from a source
string by matching a specific pattern.

Syntax <RegExMatch Name="Command_Name"
regex="Regular_Expression" occurrences="Occurrences_in_String"/>

Explanation Command_Name. The name of the RegExMatch formatting tag that can be used in Rule
tags.

Regular_Expression. The regular expression for extracting andmanipulating the name
from the source string.

Occurrences_In_String. Thematched occurrence in the source string from which to
extract andmanipulate the strings. Valid options are:

l 1-100 to use a specific matched occurrence in the source string. For example, 3 to use
the third matched occurrence in the source string.

l last to use the last matched occurrence in the source string.

Example RegEXMatch tag: <RegExMatch Name="ExtractPagePrm" regex="[c|h]+..t"
occurrences="2"/>

Source string: http://pluto:8080/jpetstore/shop/updateCartQuantitiesHeatAbcde.shtml

Output: heat
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Rule Tags
The secondmain section in the XML file is the rules section, which contains the logic for assigning a
meaningful name to a page. The rules section is responsible for matching a page to a single rule and then
using the formatting tags included in the rule to assign ameaningful name to the page. Matching is carried out
on the different parts of the URL—URL protocol, URL path, URL host, and parameters (both the GET and
POST parameters of a page).

Rules are prioritized, so that if a page’s URLmatches more than one rule, the rule that has the highest priority
is the single rule that is applied to the page.

The rules section uses a default string delimiter of a space (" "), but you can specify a different delimiter by
including it in theRules tag that begins the rules section. For example, to set a default delimiter of a right,
square bracket: <Rules DefaultDelimiter="]">

Individual rules can use a different delimiter than the general default, if specified within the specific rule.

Rules format
Rules are written in the following format:

<Rule Priority="Priority" Name="Rule_Name">
<Path Name="URL_Path">
<Host Name="URL_Host">
<Protocol Type="URL_Protocol">
<Parameters>

<Param Key="Param_Name" Value="Param_Value">
<Formatter Index="Index_Number">Format_Name1</Formatter>
<Formatter Index="Index_Number">Format_Name2 Format_

Name3</Formatter>
<Formatter Index="Index_Number"></Formatter>

</Param>
</Parameters>

</Rule>

where:

l Priority. The priority in which the rule should be applied. If more than one rule matches the source string,
the rule with the highest priority is the one that is applied. 0 is the highest priority, 1 is the second, and so
forth.
If more than one rule has the same priority, the last one that appears in the XML file is the rule that is
applied.

Tip:When assigning priorities to rules, you can use increments greater than 1. For example, you can
assign priorities of 10, 20, 30, and so forth. This allows flexibility for inserting new rules at a later time.

l Rule_Name. The name of the rule.
l URL_Path. The URL path that is required for the rule to be applied.
l URL_Host. The URL host that is required for the rule to be applied.
l URL_Protocol. The URL protocol that is required for the rule to be applied. This option does not support
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the use of a wildcard.
l Param_Name. The key (name) of a parameter in the URL that is required for the rule to be applied.
l Param_Value. The value in the Param_Name parameter that is required for the rule to be applied. Use ""
to denote an empty parameter value.

l Index_Number. The position that the formatted string occupies in themeaningful name to be created.
l Format_Name. The name of the format to be used on the selected string to format it into a string that is
used as part of the createdmeaningful name for a page. The format namemust be one of the formats
defined in the formatting section of the XML file (for details, see "Formatting Tags" on page 149). If no
format name is specified, no formatting is applied to the input string, resulting in an identical output string
that is used as part of the createdmeaningful name for a page.

Note: URL_Path, URL_Host, URL_Protocol, Param_Name, and Param_Value are always in lower
case.

The following points apply to rules:
l Not all parts of a rule need to exist, but at least one rule should be defined and it should contain a
Formatter tag.

l If a Formatter tag is placed directly under aParam tag, the formatting is carried out on the parameter
value. If a Formatter tag is placed directly under aPath tag, the formatting is carried out on the URL path.

l If an asterisk (*) or questionmark (?) character is included in a URL path, parameter name, or parameter
value, you can specify whether to treat the character as a literal (that is, purely as an asterisk or question
mark), or to treat it as a wildcard character. By default, the character is treated as a literal. To treat the
character as a wildcard character, you add the settingCompareMethod="WildCard" at the end of the
rule tag in which the character appears. For example:

<Param Key="myparam" Value="*" CompareMethod="WildCard">

To use an asterisk or questionmark character as a literal within a wildcard value, precede the character
with a backslash (\). For example, the wildcard valuemy\*str*matches the valuemy*str123, but does not
match the valuemy123str123.

Note:

l The asterisk wildcard represents any combination of characters, whereas the questionmark
wildcard represents a single character only.

l Using the wildcard comparison on page parameters creates significant overhead on the RUM
Engine and should be used only when absolutely necessary.

l You can apply multiple format names to a Path or Param tag. If the format names are placed in individual
Formatter tags one under the other, each format name is applied to the original path or parameter value and
each format name produces its own output for inclusion in themeaningful name. If the format names are
included in the same Formatter tag, each format name is applied to the resulting value from the previous
format name and only one result is created for inclusion in themeaningful name.
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Example of multiple formatting commands in separate Formatter tags:

<Path Name="/mypath/home">
<Formatter Index="1">Format_Name1</Formatter>
<Formatter Index="2">Format_Name2</Formatter>
<Formatter Index="3">Format_Name3</Formatter>

</Path>

Each of the format names is applied to the path /mypath/home.

Example of multiple formatting commands in the same Formatter tag:

<Path Name="/mypath/home">
<Formatter Index="1">Format_Name1 Format_Name2</Formatter>

</Path>

Format_Name1 is applied to the path /mypath/home; Format_Name2 is applied to the output from Format_
Name1.

Sample XML File
The following examples show an XML file with formatting and rule tags defined, and various examples of
URLs and themeaningful names created for them based on the formatting and rule tags in the sample XML
file:

l "XML File" below
l "Examples of Meaningful Names for URL" on page 163

XML File
<?xml version="1.0" ?>

- <Meaningful_Pages xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance"
xsi:noNamespaceSchemaLocation="./meaningfulpages.xsd">
- <Formating>

<Rename Name="RenameToWelcome" NewName="Welcome" />
<Rename Name="RenameToSignIn" NewName="Sign In" />
<Rename Name="RenameToStoreEntrance" NewName="Store Entrance" />
<Rename Name="RenameToEditAccount" NewName="Edit Account" />
<Rename Name="RenameToProduct" NewName="Product" />
<Rename Name="RenameToCheckOut" NewName="Check Out" />
<Rename Name="RenameToOrderSubmitted" NewName="Order Submitted" />
<Rename Name="RenameToSignOut" NewName="Signed Out" />
<SubString Name="ExtractTwoFirstLetters" BeginIndex="0" Count="2" />
<SubString Name="ExtractItem" BeginIndex="20" Count="4" />
<SubString Name="ExtractUpdate" BeginIndex="16" Count="6" />
<SubString Name="ExtractCart" BeginIndex="22" Count="4" />
<SubString Name="ExtractQuantities" BeginIndex="26" Count="10" />
<Insert Name="AppendCategory" String="Category" ToIndex="0" />
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<Insert Name="AppendAddItemPrefix" String="Add Item" ToIndex="0" />
<Insert Name="AppendToCartSuffix" String="to Cart" ToIndex="0"

CountFromBeginning="false" />
<Insert Name="AppendRemoveItemPrefix" String="Remove Item" ToIndex="0" />
<Insert Name="AppendFromCartSuffix" String="from Cart" ToIndex="0"

CountFromBeginning="false" />
<Insert Name="InsertSpaceAfterOrder" String="" ToIndex="5" />
<Insert Name="InsertSpaceAfterConfirm" String="" ToIndex="7" />
<Insert Name="InsertNotAfterOrder" String="Not" ToIndex="6" />
<ChangeCase Name="UpperCaseFirstChar" Type="UpperCase" BeginIndex="0" Count="1" />
<ChangeCase Name="UpperCaseAll" Type="UpperCase" BeginIndex="0" />
<ChangeCase Name="UpperCaseSixthLetter" Type="UpperCase" BeginIndex="6" Count="1" />
<ChangeCase Name="UpperCaseEigthLetter" Type="UpperCase" BeginIndex="8" Count="1" />
<Remove Name="RemoveNew" String="/jpetstore/shop/new" />
<Remove Name="RemoveSHTML" String=".shtml" />
<Replace Name="ReplaceNewWithConfirm" Old="/jpetstore/shop/new" New="Confirm" />

- <Alias Name="RelateLettersToCategory">
<Pair Name="FI" Alias="Fish" />
<Pair Name="K9" Alias="Dogs" />
<Pair Name="RP" Alias="Reptiles" />
<Pair Name="FL" Alias="Cats" />
<Pair Name="AV" Alias="Birds" />
</Alias>

- <Alias Name="RelateProductIdToProductName">
<Pair Name="FI-FW-01" Alias="'Koi'" />
<Pair Name="FI-FW-02" Alias="'Goldfish'" />
<Pair Name="FI-SW-01" Alias="'Angelfish'" />
<Pair Name="FI-SW-02" Alias="'Tiger Shark'" />
<Pair Name="K9-BD-01" Alias="'Bulldog'" />
<Pair Name="K9-CW-01" Alias="'Chihuahua'" />
<Pair Name="K9-DL-01" Alias="'Dalmation'" />
<Pair Name="K9-PO-02" Alias="'Poodle'" />
<Pair Name="K9-RT-01" Alias="'Golden Retriever'" />
<Pair Name="K9-RT-02" Alias="'Labrador Retriever'" />
<Pair Name="RP-LI-02" Alias="'Iguana'" />
<Pair Name="RP-SN-01" Alias="'Rattlesnake'" />
<Pair Name="FL-DLH-02" Alias="'Persian'" />
<Pair Name="FL-DSH-01" Alias="'Manx'" />
<Pair Name="AV-CB-01" Alias="'Amazon Parrot'" />
<Pair Name="AV-SB-02" Alias="'Finch'" />
</Alias>

- <Alias Name="RelateItemNameToItemDesc">
<Pair Name="EST-28" Alias="'Adult Female Golden Retriever'" />
<Pair Name="EST-27" Alias="'Adult Female Chihuahua'" />
<Pair Name="EST-26" Alias="'Adult Male Chihuahua'" />
<Pair Name="EST-25" Alias="'Adult Female Labrador Retriever'" />
<Pair Name="EST-24" Alias="'Adult Male Labrador Retriever'" />
<Pair Name="EST-23" Alias="'Adult Female Labrador Retriever'" />
<Pair Name="EST-22" Alias="'Adult Male Labrador Retriever'" />
<Pair Name="EST-21" Alias="'Adult Female Goldfish'" />
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<Pair Name="EST-20" Alias="'Adult Male Goldfish'" />
<Pair Name="EST-19" Alias="'Adult Male Finch'" />
<Pair Name="EST-18" Alias="'Adult Male Amazon Parrot'" />
<Pair Name="EST-17" Alias="'Adult Male Persian'" />
<Pair Name="EST-16" Alias="'Adult Female Persian'" />
<Pair Name="EST-15" Alias="'With tail Manx'" />
<Pair Name="EST-14" Alias="'Tailless Manx'" />
<Pair Name="EST-13" Alias="'Green Adult Iguana'" />
<Pair Name="EST-12" Alias="'Rattleless Rattlesnake'" />
<Pair Name="EST-11" Alias="'Venomless Rattlesnake'" />
<Pair Name="EST-10" Alias="'Spotted Adult Female Dalmation'" />
<Pair Name="EST-9" Alias="'Spotless Male Puppy Dalmation'" />
<Pair Name="EST-8" Alias="'Male Puppy Poodle'" />
<Pair Name="EST-7" Alias="'Female Puppy Bulldog'" />
<Pair Name="EST-6" Alias="'Male Adult Bulldog'" />
<Pair Name="EST-5" Alias="'Spotless Koi'" />
<Pair Name="EST-4" Alias="'Spotted Koi'" />
<Pair Name="EST-3" Alias="'Toothless Tiger Shark'" />
<Pair Name="EST-2" Alias="'Small Angelfish'" />
<Pair Name="EST-1" Alias="'Large Angelfish'" />
</Alias>
</Formating>

- <Rules DefaultDelimiter="">
- <Rule Priority="0" Name="Welcome">
- <Path Name="/jpetstore/">

<Formatter Index="1">RenameToWelcome</Formatter>
</Path>
</Rule>

- <Rule Priority="1" Name="Welcome">
- <Path Name="/jpetstore/index.html">

<Formatter Index="1">RenameToWelcome</Formatter>
</Path>
</Rule>

- <Rule Priority="2" Name="Sign In">
- <Path Name="/jpetstore/shop/signonForm.shtml">

<Formatter Index="1">RenameToSignIn</Formatter>
</Path>
</Rule>

- <Rule Priority="3" Name="Store Entrance">
- <Path Name="/jpetstore/shop/signon.shtml">

<Formatter Index="1">RenameToStoreEntrance</Formatter>
</Path>
</Rule>

- <Rule Priority="4" Name="Category [any]">
<Path Name="/jpetstore/shop/viewCategory.shtml" />

- <Parameters>
- <Param Key="categoryId" Value="*" CompareMethod="WildCard">

<Formatter Index="1">UpperCaseAll AppendCategory</Formatter>
</Param>
</Parameters>
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</Rule>
- <Rule Priority="5" Name="Edit Account">
- <Path Name="/jpetstore/shop/editAccountForm.shtml">

<Formatter Index="1">RenameToEditAccount</Formatter>
</Path>
</Rule>

- <Rule Priority="6" Name="Any Product [product]">
<Path Name="/jpetstore/shop/v*Product.shtml" CompareMethod="WildCard" />

- <Parameters>
- <Param Key="productId" Value="*" CompareMethod="WildCard">

<Formatter Index="1">ExtractTwoFirstLetters RelateLettersToCategory</Formatter>
<Formatter Index="2">RenameToProduct</Formatter>
<Formatter Index="3">RelateProductIdToProductName</Formatter>
</Param>
</Parameters>
</Rule>

- <Rule Priority="7" Name="Item [any]">
- <Path Name="/jpetstore/shop/viewItem.shtml">

<Formatter Index="1">ExtractItem UpperCaseFirstChar</Formatter>
</Path>

- <Parameters>
- <Param Key="itemId" Value="*" CompareMethod="WildCard">

<Formatter Index="2">RelateItemNameToItemDesc</Formatter>
</Param>
</Parameters>
</Rule>

- <Rule Priority="8" Name="Add Item [any] To Cart">
<Path Name="/jpetstore/shop/addItemToCart.shtml" />

- <Parameters>
- <Param Key="workingItemId" Value="*" CompareMethod="WildCard">

<Formatter Index="1">RelateItemNameToItemDesc AppendAddItemPrefix
AppendToCartSuffix</Formatter>

</Param>
</Parameters>
</Rule>

- <Rule Priority="9" Name="Update Cart">
- <Path Name="/jpetstore/shop/updateCartQuantities.shtml">

<Formatter Index="1">ExtractUpdate UpperCaseFirstChar</Formatter>
<Formatter Index="2">ExtractCart UpperCaseFirstChar</Formatter>
<Formatter Index="3">ExtractQuantities UpperCaseFirstChar</Formatter>
</Path>
</Rule>

- <Rule Priority="10" Name="Remove Item [any] From Cart">
<Path Name="/jpetstore/shop/removeItemFromCart.shtml" />

- <Parameters>
- <Param Key="workingItemId" Value="*" CompareMethod="WildCard">

<Formatter Index="1">RelateItemNameToItemDesc AppendRemoveItemPrefix
AppendFromCartSuffix</Formatter>

</Param>
</Parameters>
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</Rule>
- <Rule Priority="11" Name="Check Out">
- <Path Name="/jpetstore/shop/checkout.shtml">

<Formatter Index="1">RenameToCheckOut</Formatter>
</Path>
</Rule>

- <Rule Priority="12" Name="Order Form">
- <Path Name="/jpetstore/shop/newOrderForm.shtml">

<Formatter Index="1">RemoveNew InsertSpaceAfterOrder RemoveSHTML UpperCaseFirstChar
UpperCaseSixthLetter</Formatter>

</Path>
</Rule>

- <Rule Priority="13" Name="Order Submitted">
- <Path Name="/jpetstore/shop/newOrder.shtml">

<Formatter Index="1">RenameToOrderSubmitted</Formatter>
</Path>

- <Parameters>
<Param Key="confirmed" Value="true" />
</Parameters>
</Rule>

- <Rule Priority="14" Name="Order Not Submitted">
- <Path Name="/jpetstore/shop/newOrder.shtml">

<Formatter Index="1">RenameToOrderSubmitted InsertNotAfterOrder</Formatter>
</Path>

- <Parameters>
<Param Key="confirmed" Value="false" />
</Parameters>
</Rule>

- <Rule Priority="15" Name="Confirm Order">
- <Path Name="/jpetstore/shop/newOrder.shtml">

<Formatter Index="1">ReplaceNewWithConfirm InsertSpaceAfterConfirm RemoveSHTML
UpperCaseEigthLetter</Formatter>

</Path>
</Rule>

- <Rule Priority="16" Name="Sign Out">
- <Path Name="/jpetstore/shop/signoff.shtml">

<Formatter Index="1">RenameToSignOut</Formatter>
</Path>
</Rule>
</Rules>
</Meaningful_Pages>

Examples of Meaningful Names for URL

URL Meaningful Name

http://pluto:8080/jpetstore/ Welcome

http://pluto:8080/jpetstore/index.html Welcome
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URL Meaningful Name

http://pluto:8080/jpetstore/shop/signonForm.shtml Sign In

http://pluto:8080/jpetstore/shop/signon.shtml Store Entrance

http://pluto:8080/jpetstore/shop/viewCategory.shtml?categoryId=CATS Category CATS

http://pluto:8080/jpetstore/shop/editAccountForm.shtml Edit Account

http://pluto:8080/jpetstore/shop/viewProduct.shtml?productId=FI-FW-01 Fish Product 'Koi'

(FI=Fish, K9=Dogs,
RP=Reptiles, FL=Cats,
AV=Birds)

http://pluto:8080/jpetstore/shop/viewItem.shtml?itemId=EST-4 Item 'Spotted Koi'

http://pluto:8080/jpetstore/shop/addItemToCart.shtml?workingItemId=EST-6 Add Item 'Male Adult
Bulldog' to Cart

http://pluto:8080/jpetstore/shop/updateCartQuantities.shtml Update Cart Quantities

http://pluto:8080/jpetstore/shop/removeIteFromCart.shtml?workingItemId=EST-
6

Remove Item 'Male
Adult Bulldog' from Cart

http://pluto:8080/jpetstore/shop/checkout.shtml Check Out

http://pluto:8080/jpetstore/shop/newOrderForm.shtml Order Form

http://pluto:8080/jpetstore/shop/newOrder.shtml Confirm Order

http://pluto:8080/jpetstore/shop/newOrder.shtml?confirmed=true Order Submitted

http://pluto:8080/jpetstore/shop/newOrder.shtml?confirmed=false Order Not Submitted

http://pluto:8080/jpetstore/shop/signoff.shtml SignedOut

Validating Meaningful Name XML Files
You can validate ameaningful name XML file against a predefined XML schema to ensure that the structure
and format of the file are valid. The validation is made using the xerces-j 2.8.0 XML parser.

The schema file against which the XML file is validated is:

\<RUM root directory>\conf\resolver\meaningfulpages.xsd

To validate a meaningful name XML file:

1. Insert the following line at the beginning of the XML file:

<Meaningful_Pages xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance"
xsi:noNamespaceSchemaLocation="./meaningfulpages.xsd"

Note: If this line is omitted from the XML file and the validation is run, amessage that the validation
was successful is displayed, but no validation is actually done.
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2. Access the JMX console by choosing JMX Console from the Configuration drop-downmenu in the
RUMweb console, or by using the following URL in your web browser:

http://<RUM Engine machine name>:8180/jmx-console

When prompted, enter the JMX Console authentication credentials (if you do not have these credentials,
contact your system administrator).

3. In the JMX Agent View, scroll down to theRUM.modules section and click
service=ResolverMeaningfulPagesConfig.

4. In the validateConfiguration option, enter the full name of the XML file you want to validate and click
Invoke. The XML file is validated against the predefined schema file.

5. Any errors encountered are displayed, or amessage that the validation was successful is displayed.

Note: The Formatting tags must be included in the XML file in a specific order (for details, see
"Formatting Tags" on page 149). If the Formatting tags are not in the correct order, a validation error
message is displayed, but no indication of the order mismatch is given.

Adding and Deleting Meaningful Name XML Files
If you add or delete ameaningful name XML file in an application in End User Management Administration and
would like to apply the change immediately, you can force RUM to reread the End User Management
Administration configuration. In the RUM Engine web console, synchronize configuration data by selecting
Tools > Monitoring Configuration Information > Sync All Configuration. For details, see "Monitoring
Configuration Information" on page 129.

(For information on configuring applications for monitoring, see "RUM Application ConfigurationWizard" in the
APM Application Administration Guide.)

Changing Meaningful Name XML Files
If you change the content of an existingmeaningful page XML file that is used by an application, youmust
force RUM to reload the configuration for the specific application. For information on configuring applications
for monitoring, see "RUM Application ConfigurationWizard" in the APM Application Administration Guide.

To force RUM to reload the configuration for an application:

1. Access the JMX console by choosing JMX Console from the Configuration drop-downmenu in the
RUMweb console, or by using the following URL in your web browser:

http://<RUM Engine machine name>:8180/jmx-console

When prompted, enter the JMX Console authentication credentials (if you do not have these credentials,
contact your system administrator).

2. In the JMX Agent View, scroll down to theRUM.modules section and click
service=ResolverMeaningfulPagesConfig.

3. In the reloadConfiguration option, enter the application name (as defined in End User Management
Administration) by which the XML file is being used and click Invoke. The application’s configuration is
reloaded in RUM.

Note: To reload the configuration for all applications, click Invoke for the
reloadCurrentConfigurations option.
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Viewing Discovered Page Statistics
You can view a table showing statistical information for each application that uses ameaningful name XML
file.

To view discovered page statistics:

1. Access the JMX console by choosing JMX Console from the Configuration drop-downmenu in the
RUMweb console, or by using the following URL in your web browser:

http://<RUM Engine machine name>:8180/jmx-console

When prompted, enter the JMX Console authentication credentials (if you do not have these credentials,
contact your system administrator).

2. In the JMX Agent View, scroll down to theRUM.modules section and click
service=ResolverMeaningfulPagesConfig.

3. In the viewStatistics option, click Invoke. TheMeaningful Pages Statistics table opens, showing the
following data:

UI Element Description

Application
name

The name of the application as defined in End User Management Administration. (For
details on configuring applications in End User Management Administration, see
"RUM Application ConfigurationWizard" in the APM Application Administration
Guide.)

Configuration
file name

The name of themeaningful name XML file used by the application.

Published
pages

The total number of pages monitored in the application published to themeaningful
pages module.

Successful
pages

The total number of pages that were successfully processed by themeaningful
pages module.

Unmatched
pages

The total number of pages successfully processed by themeaningful pages module,
but for which nomeaningful namewas assigned as nomatch was found.

Failed pages The total number of pages that were not successfully processed by themeaningful
pages module.

Unifying Frames
By default, the RUM Probe reports each frame as a separate page for statistical purposes. However, when
replaying a session in the Session Analyzer report, the pages of some frames are listed as sub components of
other pages in the hierarchal tree and are displayed accordingly.

RUM uses a default configuration that contains the rules for determining if a page is considered as a parent or
a child page. You can change the default settings and can also create new settings for specific pages.

You configure frames to be unified by RUM in the frame_unification.xml file on the RUM Enginemachine.

Real User Monitor Administration Guide
Chapter 10: RUM Engine File Configuration

HPE Real User Monitor (9.30) Page 166 of 258



To change the default settings for frame unification
1. Edit the <RUM install>\conf\gatewayserver\frame_unification.xml file on the RUM Engine

machine.
2. Locate theDefaultPage entry, which is as follows:

3. Change the settings for your system, where:
l TimeoutMS. The amount of time it takes a frame to load after the previous frame has finished loading.
Within this time, if the framematches the other parameters, such as the referring URL, it is
considered as a child of the previous frame, otherwise it is considered as a parent frame.

l InnerFrames maxInnerFrame. Themaximum number of children that a parent frame can contain.
Use -1 for an unlimited number.

l CanBeInnerFrame. Set to true to enable frames to be considered as children. Set to false to
consider all frames as parents, unless specific page settings have been defined which are applicable
to a frame.

l MatchInnerFramesReferrer. Set to true to allow child frames to bematched to parent frames by
URLs (if specific page settings have been configured), or false to use only the TimeoutMS setting to
create child pages.

4. Save the file and exit.

Note: There can be only oneDefaultPage entry.

To create frame unification settings for specific pages
1. Edit the <RUM install>\conf\gatewayserver\frame_unification.xml file on the RUM Engine

machine.
2. After theDefaultPage entry, create a new Page section in the following format:

where:
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l Pattern. A regular expression for the URL pattern to bematched when RUM determines if a frame is
to be considered as a parent or child. The first Pattern setting at the top of the section determines if
the rule is applicable for the frame beingmatched and is also used as the parent pattern for any
matching children. Subsequent Pattern settings, within InnerFrames, are used to determine if the
frame can be considered as a child.

l InnerFrames maxInnerFrame. Themaximum number of children that the parent frame can contain.
Use -1 for an unlimited number.

l TimeoutMS. The amount of time it takes a frame to load after the previous frame has finished loading.
Within this time, the frame is considered as a child of the parent frame that matches the first Pattern
setting, otherwise it is considered as a parent frame itself.

l CanBeInnerFrame. Set to true to enable a framewhose URLmatches the first Pattern setting to be
considered as a child, or false to consider all frames that match the first Pattern setting as parents.

l MatchInnerFramesReferrer. Set to true to allow child frames to bematched to the parent frame by
the URLs configured in thePattern settings, or false to use only the TimeoutMS setting to create
child pages.

3. Repeat step 2 to create additional page settings as required.
4. Save the file and exit.

Note:

l If a page’s URLmatches the Pattern of more than one Page definition, the first matching Page
definition in the file is applied.

l Missing parameters in a Page definition section inherit the DefaultPage setting for that parameter.

Configuring User Name Translation
When configuring a web or SOAP application in APM (in EUM Administration) for monitoring by RUM, you
can configure an application to use a user name translation file if you want RUM to translate a user's login
name or IP address located inmonitored data to a real name for use in EUM reports.

To enable user name translation for an application in APM, edit the application in End User Management
Administration and in theGeneral tab > User Name Detection area, select theCorrelate end user names
and display aliases check box.

Tip:We recommend that before changing theUserNameResolver.xml file in the procedures below, you
back up the original file.

To configure the RUM Engine to translate detected login names to real names
1. In the RUM Engine, ensure that the following values (which are the default settings) are configured in the

conf\resolver\UserNameResolver.xml file:

<Resolver name="CSVLoginUserNameResolver">

<class>com.mercury.rum.engine.resolver.usernames.resolvers.
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CSVLoginUserNameResolver</class>
<parameters>

<param name="file">${rum.home}/conf/resolver/UserLoginNames.csv</param>

2. Edit the <RUM Engine root directory>\conf\resolver\UserLoginNames.csv file and enter user login
names in the first column and the corresponding real names in the second column.

3. Save the file.
4. If youmade changes to the conf\resolver\UserNameResolver.xml file, restart the RUM Engine.

To configure the RUM Engine to translate detected IP addresses to real names
1. In the RUM Engine, ensure that the following values are configured in the

conf\resolver\UserNameResolver.xml file:

<Resolver name="CSVIPUserNameResolver">

<class>com.mercury.rum.engine.resolver.usernames.resolvers.
CSVIPUserNameResolver</class>

<parameters>
<param name="file">${rum.home}/conf/resolver/ip2Names.csv</param>

2. Edit (or create if it does not exist) the <RUM Engine root directory>\conf\resolver\ip2Names.csv file
and enter IP addresses in the first column and the corresponding real names in the second column.

3. Save the file.
4. If youmade changes to the conf\resolver\UserNameResolver.xml file, restart the RUM Engine.
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Chapter 11: Configuring the RUM Sniffer
Probe
You can configure the RUM Sniffer Probe by changing the default settings and adding additional configuration
settings.

This chapter includes the following topics:

l "Changing the Protocol for Accessing the RUM Probe" below
l "Configuring the RUM Probe for I18N" below
l "Changing the Header inWhich to Locate Client IP Addresses" on the next page
l "Creating Default Configuration and Properties Files for a Specific Probe" on the next page
l "Configuring the RUM Probe to Support Multiprotocol Label Switching (MPLS)" on page 172

Changing the Protocol for Accessing the RUM Probe
The default protocol used for accessing the RUM Probe is HTTPS with a client certificate. In the RUM Engine
web console, you canmanually configure the protocol used to access the RUM Probe. For details, see "Probe
Configuration Dialog Box" on page 111.

Configuring the RUM Probe for I18N
By default, RUM uses the UTF-8 character set whenmonitoring data. To enable RUM to support non Unicode
encodings, you can configure the RUM Probe to use a different character set.

To change the character set used by the RUM Probe when monitoring data:

In the <RUM root directory>\conf\configurationmanager\Beatbox_Default_Const_Configuration.xml
file on the RUM Engine, under the [global] section, add the following lines:

enable_i18n <false/true>
content_charset_search_len <length>
charset <name>

where:

l <false/true>. Set to true to enable RUM to support I18N by using character sets other than UTF-8. The
default setting is false.

l <length>. The number of bytes in the page content in which RUM searches for a character set. By
default, RUM does not search the page content for a character set and only searches the page header.
Themaximum permissible length is 1024 characters.

l <name>. The default character set to use, if RUM does not locate a character set in either the page
header or content. Valid character sets are those that are by default supported by the ICU library.
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The following example shows the additional lines added to the [global] section in the <RUM root
directory>\conf\configurationmanager\Beatbox_Default_Const_Configuration.xml file on the RUM
Engine:

<static_global_params>
<![CDATA[
[global]
max_field_length 2048
collect_server_stats false
collect_website_stats false
enable_i18n true
content_charset_search_len 1024
]]>

Changing the Header in Which to Locate Client IP
Addresses
By default, RUM tries to locate client IP addresses using theX-Foward-For header. If client IP addresses are
located in a different header (for example, in a custom header) you can configure RUM to use that header
when trying to locate client IP addresses.

To change the header used by the RUM Probe when locating client IP addresses:

1. In the <RUM root directory>\conf\configurationmanager\Beatbox_Default_Const_
Configuration.xml file on the RUM Engine, under the [global] section, add the following line:
forwarded_for_header <HEADER_NAME>
where <HEADER_NAME> is the name of the new header to use for locating client IP addresses.

2. In the RUM Engine web console, synchronize configuration data by selecting Tools > Monitoring
Configuration Data > Sync All Configuration. For details, see "Monitoring Configuration Information"
on page 129.

Creating Default Configuration and Properties Files
for a Specific Probe
The RUM Engine uses the same, default, static configuration file and properties file for all the probes attached
to it. You can create individual, static configuration and properties files for a specific probe, so that it will be
configured with specific settings, instead of the general, default ones.

To create a default configuration file for a specific probe
1. On the RUM Engine, in the <RUM root directory>\conf\configurationmanager directory, make a copy

of theBeatbox_Default_Const_Configuration.xml file.
2. Rename the copy of the file, substitutingDefaultwith the name of the probe as configured in RUM. For

example:

Beatbox_123.4.5.67_Const_Configuration.xml
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3. Edit the file as required with the configuration settings for the specific probe.

To create a default properties file for a specific probe
1. On the RUM Engine, in the <RUM root directory>\conf\probes directory, make a copy of the

probe.default.properties file.
2. Rename the copy of the file, substituting defaultwith the name of the probe as configured in RUM. For

example:

probe.123.4.5.67.properties

3. Edit the file as required with the properties for the specific probe.

Configuring the RUM Probe to Support Multiprotocol
Label Switching (MPLS)
By default, the RUM Probe does not support MPLS.

To enable MPLS support:

1. Edit the <RUM root directory>\conf\configurationmanager\Beatbox_Default_Const_
Configuration.xml file on the RUM Engine.

2. Under the [collector] section, add the following line:

mpls_levels 0

Setting the level to 0, instead of to a specific number, configures the probe to calculate the number of
MPLS levels needed for themonitored traffic automatically.

3. Save the file.
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Chapter 12: Administering the MySQL
Database
For RUM to work, it must be connected to aMySQL database that has been created and started.

This chapter includes the following topics:

l "Overview of theMySQLDatabase" below
l "Creating and Connecting to theMySQLDatabase" below
l "Starting and Stopping theMySQLDatabase" on the next page
l "Maintaining theMySQLDatabase" on page 175

Overview of the MySQL Database
TheMySQL database is the RUM’s data repository. The data that is stored in theMySQL database is data
that is either not forwarded at all to APM, or that is only sent on request.

Data that is not forwarded at all to APM is RUM configuration data. Data that is sent to APM on request is
open session data and session clickstream data (data and snapshots of pages included in sessions).
Clickstream data accounts for themajority of the data stored in theMySQL database.

TheMySQL database can be installed on the samemachine as the RUM Engine or on its ownmachine. For
system requirements for theMySQL database, see "Reviewing System Requirements" in the Real User
Monitor Installation and UpgradeGuide.

Creating and Connecting to the MySQL Database
The RUM EngineMySQL database is created during the RUM Engine installation process, if that option is
selected. When theMySQL database is created during the installation process, the RUM Engine is connected
to it, and theMySQL database is started automatically. TheMySQL database to which the RUM Engine is
connectedmust be started for the RUM Engine to work.

You can create a new MySQL database schema and connect the RUM Engine to it, or connect the RUM
Engine to a different, existingMySQL database completely, if required.

Note: The RUM Engine can only be connected to oneMySQL database.

To create schemas and connect to MySQL databases on an RUM Windows installation:

On themachine on which the RUM Engine is installed, select Start > Programs > HPE Real User Monitor
> Administration > RUM Configuration Tool. The RUMConfiguration tool starts. For details on working
with the RUMConfiguration tool, see "RUMConfigurationWizard" in the Real User Monitor Installation and
UpgradeGuide.
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Starting and Stopping the MySQL Database
When theMySQL database is created during RUM installation, it is started automatically as part of the
process. You can start and stop theMySQL databasemanually if required.

Note:When stopping or starting theMySQL database, make sure that the RUM Engine is disabled. You
can confirm that the Rum Engine is disabled in the Task Manager.

To start the MySQL database:

1. Ensure that the RUM Engine is stopped. If not, on themachine on which the RUM Engine is installed,
select Start > Programs > HPE Real User Monitor > Administration > Disable HPE Real User
Monitor.

2. Select Start > Programs > HPE Real User Monitor > Administration > Database > Start Real
User Monitor Database.

3. Select Start > Programs > HPE Real User Monitor > Administration > Enable HPE Real User
Monitor.

To stop the MySQL database:

1. Ensure that the RUM Engine is stopped. If not, on themachine on which the RUM Engine is installed,
select Start > Programs > HPE Real User Monitor > Administration > Disable HPE Real User
Monitor.

2. Select Start > Programs > HPE Real User Monitor > Administration > Database > Stop Real
User Monitor Database.

Changing the MySQL Database User Password
When theMySQL database is created during RUM installation, a user name and password is created.

To change the MySQL database user password:

1. Ensure that the RUM Engine is stopped. If not, on themachine on which the RUM Engine is installed,
select Start > Programs > HPE Real User Monitor > Administration > Disable HPE Real User
Monitor.

2. From aWindows Command Prompt window, login to theMySQL console.
3. Connect to the SQL database using your current user name and password.

C:\<RUM Home>\MySQL\bin>mysql -h localhost --user=user_name -p

4. Show the available database schemas.

mysql> show databases;

+--------------------+
| Database |
+--------------------+
| information_schema |
| mysql |
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| performance_schema |
| rumdb234 |
| test |
+--------------------+

5. Access your database schema.

mysql>use rumdb234;

6. Create new password for the selectedMySQL database schema.

mysql> set password for 'rum_user'@'localhost' = PASSWORD('new_password');

7. Close theWindows Command Prompt window.
8. Run the RUM configuration wizard. On themachine on which the RUM Engine is installed, select Start >

Programs > HPE Real User Monitor > Administration > RUM Configuration Tool.
9. On the Connect to Database page, select Connect to RUM database.
10. On theMySQLDatabase Properties page, enter the new password.

Maintaining the MySQL Database
For details onmaintaining theMySQL database, including strategies and procedures for backing up and
restoring the database, refer to the Database Administration chapter in theMySQLReferenceManual on the
MySQLweb site (http://dev.mysql.com/doc/#manual).

Purging MySQL Binary Log Files
TheMySQL binary log contains all statements that updated data in theMySQL database.

The purpose of the binary log is to help update the database to themost current status during a restore
operation, as it contains all updates made since the last backup. For details onMySQL binary log files and
restoring databases, refer to the Database Administration chapter in theMySQLReferenceManual on the
MySQLweb site (http://dev.mysql.com/doc/#manual).

RUM purges theMySQL binary log files on a daily basis, by deleting all the log files older than five days. You
can change the default number of days for which to keep theMySQL binary log files.

To change the default number of days for which to keep MySQL binary log files:

1. Access the JMX console by choosing JMX Console from the Configuration drop-downmenu in the
RUMweb console, or by using the following URL in your web browser:

http://<RUM Engine machine name>:8180/jmx-console

When prompted, enter the JMX Console authentication credentials (if you do not have these credentials,
contact your system administrator).

2. In the JMX Agent View, scroll down to theRUM.modules section and click
service=MaintenanceDBConfigurationJMX.

3. In theMySQLBinaryLogsDaysCount parameter, change the setting to the required number of days.
4. Click theApply Changes button.
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Purging MySQL Real User Monitor Data
The data stored in theMySQL database is raw data used by Real User Monitor reports to present session
clickstreams and snapshots, and to enable queries for various report filters. The data is sent to HPE
Application PerformanceManagement on request.

Raw data is kept in theMySQL database for a default period of 14 days, after which it is automatically purged
from the database. The amount of time raw data is stored in theMySQL database can be changed to any
number of days between 7 and 100.

To change the period of time that raw data is stored in the database:

1. Edit the <RUM root directory>\conf\partitionmanager\pm_tables_config.xml file on the RUM
Enginemachine.

2. Change the setting <archiveDuration units="DAYS" qty="14"/> from 14 to the required number of
days.

3. Save the file.
4. After changing the default Purging policy in RUM, open APM and change the RUM data purging settings:

a. In APM, click Admin > Platform > Infrastructure Settings.
b. Select Applications >End User/System Availability Management.
c. In the End User/System Availability Management - Data table, locateNumber of days back to

include data in RUM reports and change the value to the new value you just configured in RUM.

Note: By increasing the number of days for which session clickstream data is stored, youmay
significantly increase the size of the database, whichmay necessitate additional disk capacity.
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Chapter 13: Hardening RUM
You can harden the RUM platform so that it can be part of a secure architecture, and can thereforemeet the
challenge of dealing with security threats to which it could potentially be exposed.

This chapter includes the following topics:

l "Hardening the RUM Sniffer Probe" below
l "Securing Connections to the RUM Engine" on page 180

Note: For details on securing connections between RUM and APM, see the APMHardening Guide.

Hardening the RUM Sniffer Probe
You can harden the RUM Sniffer Probe by changing users and creating passwords for them, disabling non-
SSH access, limiting the SSH version that can be used, and by securing the http connection to the probe.

This section includes the following topics:

l "Changing the Probe's User and Password" below
l "Limiting Access to the Probe" on the next page
l "Limiting the SSH Version" on the next page
l "Securing the HTTP Connection to the Probe" on the next page

Changing the Probe's User and Password

Note: This section applies to the RUM Probe only when it is installed on a Linux system.

When the RUM Probe is installed, a user called rum_probe is automatically created, which has access to the
probe channels only. This user does not have a password and you should configure one for it.

By default, the RUM Probe is run under the root user. It is recommended to run the probe process under the
rum_probe user, or another specially created user, rather than the root user.

To change the user that runs the probe process
1. Log on to the probe as the root user.
2. Change the user running the probe process by executing the command:

rp_user.pl <USER>

where <USER> is the name of the user with which you want to run the probe process.

To configure a password for a user
1. Log on to the probe as the root user.
2. Define a password for the user by executing the command:

passwd <USER>
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where <USER> is the name of the user for which you are defining the password. For example, to configure
a password for the rum_probe user, execute the command:

passwd rum_probe

3. Follow the on-screen prompts.

Limiting Access to the Probe
The RUM Engine connects to the RUM Probe via the probe’s web console. It is recommended to limit access
to the RUM Probe by disabling access to other, unnecessary services according to you organization’s
security policies.

Limiting the SSH Version

Note: This section applies to the RUM Probe only when it is installed on a Linux system.

By default, Linux accepts both SSH 1 and SSH 2 connections. To increase security, it is recommended to
configure Linux to accept SSH 2 connections only.

To configure Linux to accept SSH 2 connections only:

On the RUM Probemachine, edit the /etc/ssh/sshd_config file and change the line:

#Protocol 2,1
to
Protocol 2

Securing the HTTP Connection to the Probe
You can secure the http connection to the probe by using https connections.

In RUM version 7.0 and later, the RUM Engine by default connects to the probe via an https connection, using
default sever and client certificates. In some instances (for example, after upgrading an earlier version of
RUM) it might be necessary tomanually configure RUM to use https.

This section describes how tomanually set an https connection to the probe, as well as how to replace the
default, generic, server and client certificates that are included in the probe.

Note: OnWindows installations of the probe, the /etc/rum_probe directory is located in the RUM Probe
root directory.

To manually set an https connection to the probe
1. Log on to the probemachine and edit the /etc/rum_probe/rpsecurity.conf file.
2. Uncomment, edit or add the following line:

use_ssl true

3. Restart the probe:
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l For Linux installations use the command /etc/init.d/rum_probe-capture restart

l ForWindows installations select Start > Programs > HPE Real User Monitor > Administration >
Probe > Start RUMProbe.

4. On the enginemachine, edit the \<RUM root directory>\conf\probes\probe.<PROBE IP>.properties
file, where <PROBE IP> is the IP address of the probemachine for which you are configuring basic
authentication. If this file does not exist, create it.

5. Uncomment, edit or add the following line:

connection.http.ssl=true

6. Force an update of the probe configuration by accessing the RUMweb console and selecting Tools >
Monitoring Configuration Information > Sync All Configuration. For details on working with the
RUMweb console, see "Using the RUMWebConsole" on page 41.

To replace the default server certificate
1. Convert the new server certificate and private key to PEM (base64) format, unencrypted (that is, without

a password) and copy them to the probemachine.
2. Log on to the probemachine and edit the /etc/rum_probe/rpsecurity.conf file.
3. Uncomment, edit or add the following lines:

ssl_key <PRIVATE_KEY_FILE>

ssl_cert <SERVER_CERTIFICATE>

Note: The certificate and private key can be included in the same file. In such cases, both lines
should refer to that file.

4. Restart the probe:
l For Linux installations use the command /etc/init.d/rum_probe-capture restart

l ForWindows installations select Start > Programs > HPE Real User Monitor > Administration >
Probe > Start RUMProbe.

5. Copy the server certificate (without the private key) to the enginemachine.
6. Import the certificate into a new or existing keystore with the command:

\<RUM root directory>\JRE\bin\keytool -import -alias rum_probe_cert -keystore
<KEYSTORE_FILE> -file <CERTIFICATE_FILE>

Note: The RUM Engine should be configured to trust the imported certificate.

7. Edit the \<RUM root directory>\conf\probes\probe.<PROBE IP>.properties file. If this file does not
exist, create it.

8. Uncomment, edit or add the following lines:

connection.http.ssl.truststore.file=<KEYSTORE_FILE>

connection.http.ssl.truststore.password=<KEYSTORE_PASSWORD>

9. Force an update of the probe configuration by accessing the RUMweb console and selecting Tools >
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Monitoring Configuration Information > Sync All Configuration. For details on working with the
RUMweb console, see "Using the RUMWebConsole" on page 41.

To replace the default client certificate
1. On the enginemachine, generate a new private key and certificate into a new, or existing keystore with

the command:

\<RUM root directory>\JRE\bin\keytool -genkey -alias rum_probe_client_cert -keyalg
RSA -keystore <KEYSTORE_FILE>

2. Enter the details of the certificate and when prompted, approve them.

Note: If you choose a different password for the private key than the keystore password youmust
also specify this password when configuring the engine to use the keystore (see no. 3).

3. Edit the \<RUM root directory>\conf\probes\probe.<PROBE IP>.properties file. If this file does not
exist, create it.

4. Uncomment, edit or add the following lines:

connection.http.ssl.keystore.file=<KEYSTORE_FILE >

connection.http.ssl.keystore.password=<KEYSTORE PASSWORD>

If you chose a different password for the private key in step 2, edit or add the following line:

connection.http.ssl.keystore.PrivateKeypassword=<KEY PASSWORD>

5. Export the client certificate with the command:

\<RUM root directory>\JRE\bin\keytool -export -rfc -alias rum_probe_client_cert -
keystore <KEYSTORE_FILE> -file <CERTIFICATE_FILE>

6. Copy the certificate file to the probemachine
7. Log on to the probe and edit the /etc/rum_probe/rpsecurity.conf file
8. Uncomment, edit or add the following line:

ssl_ca_file <CLIENT_CERTIFICATE_FILE>

9. Restart the probe:
l For Linux installations use the command /etc/init.d/rum_probe-capture restart

l ForWindows installations select Start > Programs > HPE Real User Monitor > Administration >
Probe > Start RUMProbe.

10. Force an update of the probe configuration by accessing the RUMweb console and selecting Tools >
Monitoring Configuration Information > Sync All Configuration. For details on working with the
RUMweb console, see "Using the RUMWebConsole" on page 41.

Securing Connections to the RUM Engine
You can access the RUM Engine by different http access points, for the following purposes:

l RUMweb console
l RUM JMX console
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l RUMGateway/Proxy Server (for APM and the replay applet)
You can secure access to the RUM Engine by using authentication and https connections.

This section includes the following topics:

l "Using Authentication" below
l "Using HTTPS" below

Using Authentication
All http access points on the RUM Engine are protected via authenticationmechanisms. The twomain
authenticationmechanisms used are:

l User and password protection. Used for access to the RUM Engine web and JMX consoles.
l Basic authentication. Used for all other access points to the RUM Engine.
You can add users for access to the web console and change passwords for users to access both the web
and JMX consoles. For details on adding, changing, and deleting users to access the web console, and
changing their passwords, see "Using the RUMWebConsole" on page 41.

To change the password for a user to access the JMX console:

1. On the enginemachine, edit the \<RUM root
directory>\EJBContainer\server\mercury\conf\users.xml file.

2. In the appropriate line, enter the new password in the password parameter.
3. Ensure that the encryptedPassword parameter is blank and theRoles parameter value is RUMAdmin.
4. Save the file and restart the engine.

Using HTTPS
When you configure the RUM Engine to work with https, all connections to the engine are affected. This
means that HPE Application PerformanceManagement must also be configured to communicate with the
RUM Engine using https. For details on hardening HPE Application PerformanceManagement, including
creating, configuring, and trusting client and server certificates, see the APMHardening Guide.

In APM, when viewing session details in RUM reports, you can view snapshots of pages and replay a
session. By default, the Session Replay applet retrieves data from the RUM Engine via the APMGateway
Server, but can be configured to retrieve data directly from the RUM Engine (for details, see "Determining
How the RUM Snapshot Applet Retrieves Snapshots" in the APMUser Guide). If the Session Replay applet
is configured to retrieve data directly from the RUM Engine and the RUM Engine is configured to require a
client certificate, youmust copy and import the necessary certificate on the client machine running the
Session Replay applet.

To copy and import a client certificate on a machine running the Session Replay applet:

1. Export the certificate from the keystore on the RUM Engine with the command:

\<RUM root directory>\JRE\bin\keytool -export -rfc -alias rum_client_cert -keystore
<KEYSTORE_FILE> -file <CERTIFICATE_FILE>

2. For each client machine on which the Session Replay applet is run:
a. Copy the certificate exported in step 1 to the client machine.
b. Import the certificate to the default APM truststore with the command:
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<Latest JRE home>\bin\keytool -import -alias rum_client_cert -keystore > -
keystore <Latest JRE home>\JRE\lib\security\cacerts" -file <CERTIFICATE_FILE>

Tip:We recommend that you locate truststore and keystore files outside of the <Real User
Monitor Engine root directory> to avoid possible upgrade issues.

c. Restart the browser.

Note:We recommend that you configure the Session Replay applet to retrieve data from the RUM
Engine via the APMGateway Server, when the RUM Engine is configured to require a client certificate.
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Chapter 14: Deploying RUM in a SiteMinder
Environment
You use the RUM SiteMinder identity adapter to work with the SiteMinderWeb Agent that enables retrieving
the USER’s attributes from the SiteMinder Server Policy Server.

This chapter includes the following topics:

l "Overview" below
l "Prerequisites" below
l "System Flow" on the next page
l "Configuring the SiteMinder Policy Server" on the next page
l "Installing and Configuring the SiteMinderWeb Agent" on page 188
l "Configuring theWeb Server" on page 189
l "Configuring the RUM Engine" on page 193
l "Changing the Configuration of the TCP Port" on page 194
l "Testing and Troubleshooting" on page 194

Overview
Note: This chapter describes the configuration of Internet Information Server (IIS) 6.0 forWindows 2003
only. (While neither Apache Server nor IIS 7.0 configurations are included, they are supported and are
conceptually the same.)

This chapter is intended for system administrators experienced in the configuration andmaintenance of the
following components:

l IIS
l SiteMinder Policy Server
l SiteMinderWeb Agent
l RUM Engine
Refer to the relevant RUM and SiteMinder documentation as necessary.

Prerequisites
The following are prerequisite for the RUM–SiteMinder integration:

l The RUM Engine and SiteMinderWeb Agent must be installed on the samemachine.
l RUM version 9.12 or later.
l IIS.
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System Flow
The following diagram illustrates the flow between the RUM Engine, the RUM SiteMinderWeb Agent, and the
SiteMinder Policy Server.

Processing Steps:

1. The User Session Cache component sends a request with an SMSESSION cookie to the RUMMirror
Servlet for retrieving the USER name (through the RUM SiteMinderWeb Agent).

2. The RUM SiteMinderWeb Agent intercepts the request and requests the USER data from the
SiteMinder Policy Server (relies on the SMSESSION cookie).

3. The SiteMinder Policy Server validates the SMSESSION cookie and sends the Server Policy Response
object with USER data.

4. The RUM SiteMinderWeb Agent transfers the Server Policy Response object with USER data to a
RUMMirror Servlet.

5. The RUMMirror Servlet extracts the USER data and sends a response with USER Name back to the
User Session Cache component through the RUM SiteMinderWeb Agent.

6. The RUM SiteMinderWeb Agent redirects the response back to the User Session Cache component.

Configuring the SiteMinder Policy Server
This section describes the following steps for configuring the SiteMinder Policy Server:

l "Create an Agent" on the next page
l "Create the Agent Conf Object" on the next page
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l "Create the Authentication Scheme" below
l "Configure the Domain" on the next page

Create an Agent
To create an agent, use the SiteMinder Administration console to add the RUMWeb Agent to the Policy
Server.

1. Right-click Agents and select Create Agent. The SiteMinder Agent dialog box opens.
2. In theName field, enter the hostname of themachine on which the RUM SiteMinderWeb Agent is

installed. If you are not using the standard, default port 80, youmust also specify the port number after
the name (separated by a colon). By default, the RUM Engine’s mirror servlet uses port number 8181, so
you enter the name as:

<agent_host_machine>:8181

Note: If you change the port value in this dialog box, youmust also change the port value in other
places. For details, see "Changing the Configuration of the TCP Port" on page 194.

3. For the Description, enterRUM SM Web Agent.
4. For the Agent Type, selectWeb Agent.
5. Click OK.

Create the Agent Conf Object
Use the SiteMinder Administration console to create the Agent Conf Object to the Policy Server.

1. In the left pane of the SiteMinder Administration console, click AgentContObjects.
2. In the right pane, right-click IISDefaultSettings and select Duplicate Configuration Object from the

menu. The SiteMinder Agent Configuration Object dialog box opens.
3. For the Name, enter the hostname of themachine on which theRUM SiteMinder Web Agent is

installed.
4. For the Description, enterRUM SM Web Agent.
5. Edit the #DefaultAgentName configuration value:

a. Select the #DefaultAgentName configuration value.
b. Click Edit. The Edit Parameter dialog box opens.
c. Select thePlain radio button.
d. For the Parameter Name, enterDefaultAgentName.
e. For the Value, enter the agent name exactly as it appears in the SiteMinder Agent Properties dialog

box.
f. Click OK.

6. Click OK.

Create the Authentication Scheme
In the SiteMinder Administration console, add the Authentication Scheme to the Policy Server.
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1. Right-click Authentication Schemes and select Create Authentication Scheme. The SiteMinder
Authentication Scheme dialog box opens.

2. For the Name, enterRUM Scheme.
3. For the Description, enterRUM SM Web Agent.
4. For the Authentication Scheme Type, select HTML Form Template.
5. In the Scheme tab, for theWeb Server Name enter the hostname of themachine on which theWeb

Agent performs authentication.
6. Click OK.

Configure the Domain
To configure the domain, perform the following steps:

l "Create the Realm" below
l "Create the Response" below
l "Create the Rules" on the next page
l "Configure the Policy" on the next page

Create the Realm
In the SiteMinder Administration console, open the domain of themonitored application as provided by your
SiteMinder contact.

1. In the left pane of the SiteMinder Administration console, right-click Domain.
2. In the right pane, right-click the relevant domain and select Properties of Domain from themenu. The

SiteMinder Domain dialog box opens.
3. Select theRealms tab.
4. Click Create. The SiteMinder Realm dialog box opens.
5. For the Name, enterRUM Mirror Servlet.
6. For the Resource Filter, enter /iam/mirror.
7. Click Lookup to search for and select the agent’s hostname.
8. For the Authentication Schema, select theRUM Authentication Schema created previously.
9. For the Default Resource Protection, select Protected.
10. Click OK (in the SiteMinder Realm dialog box).
11. Click OK (in the SiteMinder Domain dialog box).

Create the Response
In the SiteMinder Administration console, open the domain of themonitored application as provided by your
SiteMinder contact.

1. In the left pane of the SiteMinder Administration console, right-click Domain.
2. In the right pane, right-click the relevant domain and select Create Response from themenu. The

SiteMinder Response dialog box opens.
3. For the Name, enterRUM Response.
4. For the Agent, selectWeb Agent.
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5. Click Create. The SiteMinder Response Attribute Editor opens.
a. For the Attribute, selectWebAgent-HTTP-Header-Variable.
b. For the Attribute Kind, select User Attribute.
c. For the Variable Name, enterRUM_SM_USER.

Note: If you change the Variable Name value, youmust also change the value of the
requestHeaderUserNameParamName tag in the
HPRUM\conf\configurationmanager\configuration\IAM_config.xml file.

d. Set the Attribute Name as the name of the LDAP attribute that holds the user name value.

Note: The Attribute name depends on your specific LDAP implementation. (For example, the
uid attribute for SunOne LDAP.)

e. Click OK (in the SiteMinder Response Attribute Editor).
6. Click OK (in the SiteMinder Response dialog box).

Create the Rules
1. Create the RUM SMA Authentication rule for the RUMMirror Servlet realm.

a. In the left pane of the SiteMinder Administration console, right-click theRUM Mirror Servlet realm
and select Create Rule under Realm from themenu. The SiteMinder Rule dialog box opens.

b. For the Name, enterRUM SMA Authentication Rule.
c. For the Action, select Authentication events.
d. In the Action drop-down list, select onAuthAccept.
e. Click OK.

2. Create the RUM SMAWeb Action rule for the RUMMirror Servlet realm.
a. In the left pane of the SiteMinder Administration console, right-click theRUM Mirror Servlet realm

and select Create Rule under Realm from themenu. The SiteMinder Rule dialog box opens.
b. For the Name, enterRUM SMA Web Action Rule.
c. For the resource, enter an asterisk (*).
d. For the Action, selectWeb Agent actions.
e. In the Action list, select Get, Post, andPut.
f. Click OK.

Configure the Policy
In the SiteMinder Administration console, edit the policy of the domain.

Note: If there is more than one policy, youmust add the rule and response to each of them.

1. In the left pane of the SiteMinder Administration console, click Policies.
2. In the right pane, right-click the relevant policy and select Properties of Policy from themenu. The

SiteMinder Policy dialog box opens.
3. Select theRules tab.
4. Click Add/Remove Rules. The Rule Items dialog box opens.
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5. Move theRUM SMA Web Rule and theRUM MA Authentication Rule from Available Members to
Current Members.

6. Click OK.
7. In the Rules tab of the SiteMinder Policy dialog box, select theRUM SMA Authentication Rule.
8. Click Set Response. The Set Response dialog box opens.
9. Select RUM Response.
10. Click OK (in the Set Response dialog box).
11. Click OK (in the SiteMinder Policy dialog box).

Installing and Configuring the SiteMinder Web Agent
This section describes how to install and configure the SiteMinderWeb Agent and includes the following
topics:

l "Prerequisites" below
l "Installing the SiteMinderWeb Agent" below
l "Configuring the SiteMinderWeb Agent" on the next page

Prerequisites
Ensure the following prerequisites before installing the SiteMinderWeb Agent:

l TheWeb Server is installed.
l You have an account with Administrative privileges for yourWeb Server.
l The Policy Server is configured.
l You have an appropriate version of theWeb Agent setup file.
l The setup file is compatible with the host’s operating system.

Installing the SiteMinder Web Agent
To install the SiteMinderWeb Agent:

1. If necessary, extract all the files from the ZIP file provided by SiteMinder.
2. Start theWeb Agent executable.

For example: nete-wa-6qmr6-win64.exe
3. The CA SiteMinderWeb Agent Introduction screen appears. Click Next.
4. On the License Agreement screen, scroll down and select I accept the terms of the License

Agreement, and then click Next.
5. On the Important Information screen, click Next.
6. On the Choose Install Location screen, accept the default location for installing theWeb Agent, or click

Choose to select a different location. Click Next.
7. On the Choose Shortcut Folder screen, click Next.
8. On the Pre-Installation Summary screen, click Install.
9. On the Install Complete screen, select Yes, I would like to configure the Agent now and click Next.
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Configuring the SiteMinder Web Agent
To configure the SiteMinderWeb Agent:

1. On the Host Registration screen, select Yes, I would like to do Host Registration now, but do not
select the Enable PKCS11DLLCryptographic Hardware check box. Click Next.

2. On the Admin Registration screen, type the SiteMinder administrator name and password provided by
your SiteMinder contact. Do not select the Enable Shared Secret Rollover check box. Click Next.

3. On the Trusted Host Name and Configuration Object screen, type the trusted hostname and Host Conf
Object provided by your SiteMinder contact. Click Next.

4. On the Policy Server IP Address screen, type the SiteMinder Policy Server IP address provided by your
SiteMinder contact and click Add. Click Next.

5. On the Host Configuration file location screen, accept the default file name and location and click Next.
6. On the Select Web Server(s) screen, select theWeb server that you want to configure as aWeb Agent

and click Next.
7. On the Agent Configuration Object screen, enter the Agent Conf Object provided by the SiteMinder

contact and click Next. (For details, see "Create the Agent Conf Object" on page 185)
8. On the Self Registration screen, select No, I don’t want to configure Self Registration. Click Next.
9. On theWeb Server Configuration Summary screen, click Install. TheWeb Agent configuration process

starts and when completed, the Configuration Complete screen is displayed.
10. Click Done to complete the configuration process.

Configuring the Web Server
This section describes how configure theWeb Server and includes the following topics:

l "Configuring IIS toWork with RUM" below
l "Configuring IIS toWork with the SiteMinderWeb Agent" on page 192

Configuring IIS to Work with RUM
To configure IIS to work with RUM:

1. Download the ISAPI redirector server plug-in isapi_redirect.dll, which is available at:
l Win32 i386
http://www.apache.org/dist/tomcat/tomcat-connectors/jk/binaries/windows/tomcat-connectors-
1.2.37-windows-i386-iis.zip

l Win64 x86
http://www.apache.org/dist/tomcat/tomcat-connectors/jk/binaries/windows/tomcat-connectors-
1.2.37-windows-x86_64-iis.zip

l AMD64
http://archive.apache.org/dist/tomcat/tomcat-connectors/jk/binaries/win64/jk-1.2.31/amd64/isapi_
redirect-1.2.31.dll

2. Unzip the zip file and copy the isapi_redirect.dll file to the /bin/IIS directory in your RUM Engine
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installation.

For example: C:\HPRUM\bin\IIS\isapi_redirect.dll

Caution: If you are installing on aWinNT orWin2k system, make sure IIS runs with a user that can
access this directory.

3. Open the /bin/IIS/isapi_redirect.properties file that contains the configuration settings for the redirector
plug-in file.

4. Change%LOG_DIR% to the full path of any directory that is not under the RUM home directory.

Caution: Placing the log file in the RUM home directory may cause an automatic uninstallation of
the RUM Engine and interference with the re-installation process.

5. Change%HPRUM% to the full path of the installation directory of your RUM Engine.

For example: C:\HPRUM\bin\IIS\isapi_redirect.properties

6. Save your changes.
7. Open Internet Information Services (IIS) Manager. Youmust be logged on as amember of the

Administrators group on the local computer to perform the following procedures, or youmust have been
delegated the appropriate authority.
To open IIS Manager at a command prompt:
a. On the Start menu, click Run.
b. In the Open dialog box, type inetmgr and then click OK.

For more information, see http://msdn.microsoft.com/en-us/library/bb763170.aspx.
8. Using the IIS management console, set TCP port 8181 toDefault Web Site. This port is used for

accessing themirror servlet from the RUM Engine.

Note: If you change the port value in this dialog box, youmust also change the port value in other
places. For details, see "Changing the Configuration of the TCP Port" on page 194.

a. Right-click the Default Web Site and select Properties from themenu. The Default Web Site
Properties dialog box opens.

b. On theWeb Site tab, click Advanced to open the AdvancedWeb Site Identification dialog box.
c. Select the current line with port 80 and click Edit to open the Add/Edit Web Site Identification dialog

box.
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d. Select the (All Unassigned) IP address option and set the TCP port to 8181. Click OK. The new
configuration appears in theMultiple identities for this Web site list in the AdvancedWeb Site
Identification dialog box.

9. Using the IIS management console, add a new virtual directory to Default Web Site. The name of the
virtual directorymust be jakarta. Its physical path should be the directory in which you placed isapi_
redirect.dll (for example, C:\HPRUM\bin\IIS). While creating this new virtual directory, assign execute
permission to it.
Right-click the Default Web Site and select New>Virtual Directory from themenu. The Virtual Directory
CreationWizard opens. In the wizard:
l Enter jakarta as an alias of the virtual directory.

l Add a path to the directory that contains isapi_redirect.dll (for example, C:\HPRUM\bin\IIS).

l Assign execute permission.

Caution: The name of the virtual directory must be jakarta.

10. Using the IIS management console, grant access to the jakarta resource from the local machine only.
a. In the left pane, right-click jakarta and select Properties from themenu.
b. Select theDirectory Security tab.
c. In the IP address and domain restrictions panel, click Edit. The IP Address and Domain Name

Restrictions dialog box opens.
o Select Denied Access.
o Click Add.
o Select Single computer.
o Enter the IP address of themachine on which the RUM SiteMinderWeb Agent is installed.
o Click OK.

d. Click OK.
11. Using the IIS management console, add isapi_redirect.dll as a filter in Default Web Site (DWS). The

name of the filter should reflect its task (uses the name tomcat) and its executable must be
C:\HPRUM\bin\IIS\isapi_redirect.dll.
a. In the left pane, right-click Default Web Site and select Properties. The Default Web Site

Properties dialog box opens.
b. Select the ISAPI Filters tab and click Add. The Add/Edit Filter Properties dialog box opens.
c. Enter tomcat as the filter name
d. Add the full path to the isapi_redirect.dll as the executable field (for example,

C:\HPRUM\bin\IIS\isapi_redirect.dll).
e. Click OK.

Note: At this stage, the status of the added filter is inactive.

12. Using the IIS management console, add the jakarta ISAPI Redirector to theWeb Service Extensions.
a. In the left pane, right-clickWeb Service Extensions and select Add a new Web Service

extension. The New Web Service Extension dialog box opens.
b. Enter tomcat as the Extension Name
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c. Add the full path to the isapi_redirect.dll to the required files. (for example,
C:\HPRUM\bin\IIS\isapi_redirect.dll)

d. Select theSet extension status to Allowed check box.
e. Click OK.

13. Restart the IIS Web Server.
a. On the Start menu, click Run.
b. In the Open dialog box, type IISReset and then click OK.

Configuring IIS to Work with the SiteMinder Web Agent
To configure IIS to work with the SiteMinderWeb Agent:

1. Open the IIS management console.
2. In the left pane, ensure that the siteminderagent virtual directory has been added under the Default Web

Site.
3. Check the status of the ISAPI filter for SiteMinder:

a. In the left pane, right-clickWeb Sites and select Properties. TheWeb Sites Properties dialog box
opens.

b. Select the ISAPI Filters tab.
c. The status of SiteMinderWeb Agent must be green.

4. In the IIS management console, add the ISAPI6 SiteMinder WEbAgent service to theWeb Service
Extensions:
a. In the left pane, right-clickWeb Service Extensions and select Add a new Web Service

extension from themenu. The New Web Service Extension dialog box opens.
b. Enter ISAPI6 WEbAgent as the Extension Name.
c. Add the full path to the netegrity\webagent\bin\ISAPI6WebAgent.dll to the required files (for

example, C:\Program Files\netegrity\webagent\bin\ISAPI6WebAgent.dll).
d. Select theSet extension status to Allowed check box.
e. Click OK.

5. In the IIS management console, add theSM PW service to theWeb Service Extensions:
a. In the left pane, right-clickWeb Service Extensions and select Add a new Web Service

extension from themenu. The New Web Service Extension dialog box opens.
b. EnterSM PW Services as the Extension Name.
c. Add the full path to the netegrity\webagent\pw\smpwservicescgi.exe to the required files (for

example, C:\Program Files\netegrity\webagent\pw\smpwservicescgi.exe).
d. Select theSet extension status to Allowed check box.
e. Click OK.

6. In the IIS management console, add theSM PW Default service to theWeb Service Extensions:
a. In the left pane, right-clickWeb Service Extensions and select Add a new Web Service

extension from themenu. The New Web Service Extension dialog box opens.
b. EnterSM PW Default Services as the Extension Name.
c. Add the full path to the netegrity\webagent\pw_default\smpwservicescgi.exe to the required files

(for example, C:\Program Files\netegrity\webagent\pw_default\smpwservicescgi.exe).
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d. Select theSet extension status to Allowed check box.
e. Click OK.

7. In the IIS management console, allow all unknownCGI and ISAPI Extensions:
a. In the left pane, selectWeb Service Extensions.
b. In the right pane:

o Select All Unknown CGI Extensions.
o Click Allow.
o Select All Unknown ISAPI Extensions.
o Click Allow.

8. Enable the SiteMinderWeb Agent:
a. Edit the netegrity/webagent/bin/IIS/WebAgent.conf file (for example, C:\Program

Files\netegrity\webagent\bin\IIS\ WebAgent.conf).
b. Change NO to YES in theEnableWebAgent field.

9. Restart IIS.
10. Check that SiteMinder is running by selectingStart > Administrative Tools > Event Viewer.

Configuring the RUM Engine
This section describes how to configure the RUM Engine:

1. Open the \EJBContainer\server\mercury\deploy\jbossweb-tomcat50.sar\server.xml file in a text
editor.

For example: C:\HPRUM\EJBContainer\server\mercury\deploy\jbossweb-
tomcat50.sar\server.xml

2. Enable the AJP entry by uncommenting it (by default it is commented out).

3. Save your changes.
4. Open the \conf\configurationmanager\Beatbox_Default_Const_Configuration.xml file in a text

editor.

For example: C:\HPRUM\ conf\configurationmanager\Beatbox_Default_Const_
Configuration.xml

5. Change the value ofmax_log_field_length from 2048 (the default value) to 10240.
For example: max_log_field_length 10240

6. Save your changes.
7. Restart the RUM Engine.
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Changing the Configuration of the TCP Port
The deployment of SiteMinder resources (Policy Web agent and RUM Enginemirror servlet) is configured by
default to use TCP port 8181. If you want to change the configured port value, youmust also set the port value
in the following:

l Policy server:
l Change theWeb agent name in the SiteMinder Agent dialog box to include the port value. For details,
see "Create an Agent" on page 185.

l Change theDefaultAgentName parameter value in the SiteMinder Agent Configuration Object dialog
box to the agent’s name. For details, see "Create the Agent Conf Object" on page 185.

l IIS:Change the TCP Port parameter in the Default Web Site Properties dialog box in the IIS Manager. For
details, see "Configuring IIS toWork with RUM" on page 189.

l RUM Engine:Change the http_settings > portXML tag in the
HPRUM\conf\configurationmanager\configuration\IAM_config.xml file.

Testing and Troubleshooting
This section describes various testing and troubleshooting procedures for the following:

l "RUM Engine" below
l "SiteMinderWeb Agent" on the next page
l "Mirror Servlet" on page 196

RUM Engine

Note: Before carrying out the following procedures, the SiteMinder Agent must be disabled.

1. Invoke the URL http://localhost:8180/rumwebconsole. If the Login page of the RUM Engine is not
displayed, check that the RUM Engine is running.

2. Invoke the URL http://localhost:8181/iam/mirror. If an Error page is displayed, check if the status of
the ISAPI Filter on the Default Web Site is green.
a. Right-click Default Web Site and select Properties. The Default Web Site Properties dialog box

opens.
b. Select the ISAPI Filters tab.
c. If the status is red, check the Application Event Log for theW3SVC-WP. To open the Event Viewer,

select Start > Administrative Tools > Event Viewer.
o Make sure you use an isapi_redirect.dll that is compatible with for the host’s operating system.
o Make sure IIS runs with a user that can access the C:\HPRUM\bin\IIS directory.

d. If the status is green, examine the last line in the IIS server log file, located in
SYSTEM32/LogFiles/W3SVC1. Take the appropriate action according to the error code in the last
line:
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Error
Code Action

404 Make sure you entered the URL correctly.

505 o Make sure the virtual directory created is called jakarta.
o Make sure that the extension_uri setting is correct.
o Check theworkers.properties file andmake sure the port setting for

worker.ajp13w.port is the same as the port specified in the server.xml for the
Apache AJP13 support.

202
or
403

Make sure you have checkedExecute Access for the jakarta virtual directory in the
AdvancedOptions of the Personal WebManager.

SiteMinder Web Agent
Invoke the URL http://localhost:8181/iam/mirror. The SiteMinder Login Page should be displayed. If an
Error page is displayed:

1. Enable logging. In the SiteMinder Administration console, right-click your Agent Conf Object and select
Properties of Configuration Object. The SiteMinder Agent Configuration Object dialog box opens.
a. Select LogFileName.
b. Click Edit.
c. Enter the full log file path as the value (for example,

C:\Users\johndoe\AppData\Local\Temp\siteminder.log).

Caution: Placing the log file in the RUM home directory may cause an automatic uninstallation
of the RUM Engine and interference with the re-installation process.

d. Click OK.
e. Select Logfile.
f. Click Edit.
g. Enter yes as the value.
h. Click OK.

Note: No restart is required.

2. Check Error in the Event Viewer.Make sure that theHostConfigFile parameter in the
WebAgent.conf file has the path to the host configuration file.

For example:

C:\Program Files\netegrity\webagent\bin\IIS\WebAgent.conf

HostConfigFile="C:\Program Files\netegrity\
webagent\config\SmHost.conf.bk1"
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Mirror Servlet
To check that themirror servlet is alive and operating correctly with the SiteMinderWeb agent, invoke the
following URL: http://localhost:8181/iam/mirror?IDENTITY_PARAM_USER_NAME=RUM_SM_USER

The IDENTITY_PARAM_USER_NAME parameter indicates the header name that is returned at theWeb
agent’s response and that contains the logged-in user name. The header nameRUM_SM_USER is the same
value that was defined in the policy server. For details, see "Create the Response" on page 186.

The result on the page will be the user name that was entered in the login page, followed by the prefix IAM_
UID=. For example, IAM_UID=JohnSmith.

If this result is not accepted:

1. Verify that RUM_SM_USER is the configured value in the Policy server.
2. Test and troubleshooting the RUM Engine. For details, see "RUM Engine" on page 194.
3. Test and troubleshooting the SiteMinderWeb Agent. For details, see "SiteMinderWeb Agent" on the

previous page.
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Chapter 15: RUM Data Export
Data export enables you to extract requested raw data from RUM and provide it to users. You can then use
this data to create your own reports, giving you different views than those provided in the standard End User
Management reports in APM. Another benefit of exporting data is that you are not dependent on the RUM
purging cycle and can save the exported data for as long as you need.

This chapter includes the following topics:

l "Enable Data Export" below
l "How Data is Exported" below
l "Data Export XML File" on the next page
l "Valid Channel Types and Fields" on page 201

Enable Data Export
To enable data export, you create and configure an XML file in the \<RUM root
directory>\conf\datapublisher\consumers directory. This file contains settings such as what data you want
extracted, how it should be formatted, where it should be saved, when to close and save a data file and open a
new one, and so forth. For details on the XML file, see "Data Export XML File" on the next page.

You can createmultiple XML files so that different data can be extracted for different consumers. For
convenience, it is recommended that each file name is the same as the relevant consumer name.

A template XML file called consumer-template.xml is located in the \<RUM root
directory>\conf\datapublisher directory. You can copy and edit this file and then save it in the \<RUM root
directory>\conf\datapublisher\consumers directory.

While a background process checks if configuration files have been changed, you can force an immediate
update by synchronizing the configuration in the RUMweb console (select Tools > Monitoring
Configuration Data > Sync All Configuration).

How Data is Exported
When the RUM Engine is started, it checks to see if there are data export configuration XML files in the
\<RUM root directory>\conf\datapublisher\consumers directory. For each XML file found, the RUM
Engine creates a directory for the configured consumer in the configured output directory, and in the
consumer’s directory creates further sub-directories for each configured channel type. For example, the
following directories are created for a consumer calledXYZ, with a configured output directory of
C:\MyDataPublishing\DpOutput and with configured channel types of Page and Transaction:

l C:\MyDataPublishing\DpOutput\XYZ\Page

l C:\MyDataPublishing\DpOutput\XYZ\Transaction

Note:

l RUMmust have read and write (RW) permissions for the configured output directory.
l The output directory can be a local or remote directory.
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Files are opened in the relevant directories and data is saved to them according to the configuration in the XML
file. Data is continuously saved to the files.

A file is closed when it reaches a certain size, or a specific timeout is encountered. You configure the
maximum file size and/or timeout in the XML file. When a file is closed, a new file is automatically opened
when new data is received. File names aremade up of the consumer name, channel type, and the time in
milliseconds that the file was created (for example, XYZ_PAGE_12345678).

You can also limit the output directories by size, or by the number of files in them. When themaximum size or
themaximum number of files is reached, nomore new files will be opened. Youmust manually manage the
output directories and files to ensure that you have enough space.

To stop the export of data, remove the XML files from the \<RUM root
directory>\conf\datapublisher\consumers directory. Removing the XML file for a specific consumer stops
the export of data for that consumer only.

Data Export XML File
This section describes the elements and attributes used in the data export configuration XML file.

A template XML file called consumer-template.xml is located in the \<RUM root
directory>\conf\datapublisher directory.

Elements Table

Element Description

Attribute

For details,
see
"Attributes
Table" below

consumer Initial element in block containing all the data export
configuration.

l name
l disable

consumerDescription Optional consumer description.

collector Initial element for configuration of a specific collector.

Note:You can configure only one collector for data export.

formats Initial element for configuring the format for common data types
for all exported data.

DOUBLE Format for double precision numbers.

Default value: <DOUBLE>{#.000}</DOUBLE>

DATE Format for dates.

Default value: <DATE>{MM-dd-yyyy hh:mm:ss:SS}</DATE>
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Element Description

Attribute

For details,
see
"Attributes
Table" below

appTierIds Application Filter.

Note:You can specify comma separated application tier IDs. If
you do not specify any IDs, data is displayed for all the
applications.

channels Initial element for configuring what data to export.

channel Initial element for configuring a specific type of data for export.

Note:

l For each channel type, you configure separate fields and
field elements.

l If you declare a channel type, but do not declare any fields
for that type, all fields are exported by default.

type

fields The initial element for configuring the specific fields to export for
each channel type.

Note: For details on the available fields for each channel type,
see "Valid Channel Types and Fields" on page 201.

field Specific data field to export for the configured channel type. l name
l title

publisher Configuration for the actual export of the data.

type The type of output in which to export the data.

Note: The only valid option is FILE.

outputDirectory The directory path in which to save the output files.

Caution:Do not locate the output directory on the same disk
used by theMySQL database.

maxDirectorySizeMb Themaximum size of the output directory. After this limit is
reached, nomore output files are saved.

maxFilesInDirectory Themaximum number of saved output files that can exist in the
output directory. After this limit is reached, nomore output files
are saved until old files are removed.

maxFileSizeMb Themaximum size for the open data export file. After this limit
is reached, the file is closed and saved and a new file is opened
when new data is received.
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Element Description

Attribute

For details,
see
"Attributes
Table" below

timeoutInSec Themaximum timeout that triggers the closing of the data
export file. After this limit is reached, the file is closed and
saved and a new file is opened when new data is received.

publisherFileType The exported data file type.

Note: The only valid option is CSV.

readyFileExtension The extension to add to the output file when it is closed and
saved.

useHeaders If set to true, a line of field headers (or alternate names if
configured) is added to the saved output file.

fieldDelimiter The delimiter to use for separating fields in the output file.

newLineDelimiter The delimiter between records (lines) in a file. Valid options are:

l WINDOW
l UNIX
l MAC

useZip If set to true, the output file is zipped.

comment The sign to use to denote a comment in the output file.

Note: This is limited to a single character.

Attributes Table

Attribute
Parent
Element Description Example

name consumer The consumer name for whom data is exported.

Note:

l The consumer name is also used in the exported
data file name.

l The consumer namemust be unique within all the
configured XML files.

<consumer
name="consumer_XYZ">

disable consumer When set to true, data publishing for the consumer is
disabled.

Default value: false

<consumer
name="consumer_XYZ"
disable="false">
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Attribute
Parent
Element Description Example

type channel The type of data to export. Valid options are:

l Page
l Session
l Transaction
l Action
l Event

<channel type="Page">

name field The name of the field to be exported.

Note: For details on the available fields for each
channel type, see "Valid Channel Types and Fields"
below.

<field name="x-end-user-
id" title="x-end-user-id" />

title field An alternate title for the field name.

Note: For details on the available fields for each
channel type, see "Valid Channel Types and Fields"
below.

<field name="x-end-user-
id" title="x-end-user-id" />

Valid Channel Types and Fields
The tables in the following topics list the valid fields for each channel for which you can export data:

l "Page" below
l "Transaction" on page 205
l "Session" on page 207
l "Action" on page 210

Page

Field Name Type Units Description

all-login-names string Login name of end user

c-browser-name string Describes the web browser used by the visitor

c-host-id object The APM host ID associated with client

c-host-name string The host name associated with client

c-os-name string Describes the operating system used by the visitor

cs-app-bytes int byte The number of bytes received by the software element

cs-version string HTTP version used for the action
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Field Name Type Units Description

referrer string Entire raw referrer string sent in the action

s-host-id object The APM server ID

s-host-name string The server name

s-sw-element-id object The APM software element ID

s-sw-element-name string The software element name

sc-app-bytes int byte The number of bytes sent by the software element

sc-server-firstbut-time-ms long ms Time taken for the server to process the request

sc-status int Status or code sent by the server in response to the action

server-time-threshold-ms long ms Server time threshold for the action

timestamp date date Action start time

x-action-descriptor string Descriptor for given action

x-action-download-
threshold-time-ms

long ms Download time threshold for the action

x-action-download-time-
ms

long ms Total download of the action, from the beginning of the first
request until the end of the last request

x-action-external-time-ms long ms Sum totaling the gaps of time within loading of a page during
which there are no components being transferred

x-action-id long The internal ID of the action

x-action-name string The configured name of the action

x-action-requests int Total number of component requests for this action

x-application-id object The APM application ID number

x-application-name string The APM application name

x-application-tier-id object The APM application tier ID number

x-available boolean Indicates if the action was available

x-cancelled boolean Page request that was prematurely interrupted

x-classify boolean Indicates that the page was classified

x-connect-time-ms long ms Time taken for the client and server to initialize a TCP
connection

x-end-user-id object The APM end-user group ID
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Field Name Type Units Description

x-end-user-packet-
latency-time-threshold-ms

long ms End user packet latency threshold

x-end-user-subnet-id object The APM end-user subnet ID

x-end-user-username string The APM end-user group name

x-errors-events-num int Total number of application error events on page

x-event-id1 int The event ID that has occurred within a particular visitor
session on the action

x-event-id2 int The event ID that has occurred within a particular visitor
session on the action

x-event-id3 int The event ID that has occurred within a particular visitor
session on the action

x-geo-ip-num string IP Address

x-geo-net-end-num string Last IP Address of the client's network block

x-geo-net-start-num string First IP Address of the client's network block

x-host-parameterization string The host name

x-info-event-num int Total number of information (non error) events on page

x-is-backend-tier boolean Indicates if the action belongs to back-end tier

x-is-encrypted boolean Indicates if the action was encrypted

x-is-over-server-time-
threshold

boolean Indicates if the action was over server time threshold

x-location-id object The APM end-user location ID

x-location-name string The APM end-user location name

x-location-packet-latency-
time-threshold-ms

long ms Location packet latency threshold

x-location-parent-id1 object The APM location ID

x-location-parent-id2 object The APM location ID

x-location-parent-id3 object The APM location ID

x-location-parent-id4 object The APM location ID

x-location-parent-id5 object The APM location ID

x-location-parent-name1 string The APM location name

x-location-parent-name2 string The APM location name
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Field Name Type Units Description

x-location-parent-name3 string The APM location name

x-location-parent-name4 string The APM location name

x-location-parent-name5 string The APM location name

x-network-time-ms ms Network time

x-packet-latency-time-
threshold-ms

long ms Packet latency threshold

x-page-title string Title of the web page, which is normally displayed along the
top of a visitor's web browser window

x-parent-action-seq-id int This field is used to correlate frames of the frame sets or
other dependent pages

x-performance-event-num int Total number of performance (non error) events on page

x-retransmission-time-ms long ms Time spent on retransmitting packets

x-rum-probe-id int Internal ID of the RUM Probe

x-server-time-ms long ms Time taken for the server to respond to the request

x-server-time-to-firstbuf-
threshold-ms

long ms Time to first buffer threshold for the action

x-session-action-seq int Number of action views (such as page views) associated
with the session

x-session-application-id string The internal ID of the session application

x-session-id string Universally unique identifier (UUID) automatically assigned
to each unique visitor session

x-session-property-tag1 string The application session property was tagged by RUM

x-session-property-tag2 string The application session property was tagged by RUM

x-session-property-tag3 string The application session property was tagged by RUM

x-session-property-tag4 string The application session property was tagged by RUM

x-session-property-tag5 string The application session property was tagged by RUM

x-session-start-time date date The session start time

x-ssl-time-ms long ms Time taken for the client and server to initialize an SSL
connection

x-total-packets int Total number of packets in the request and response

x-uri-parameterization string The URI
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Field Name Type Units Description

x-url-extracted-data string The URL extracted data

x-url-host string Name of the host requested by the client

x-url-http-method string HTTP request method used

x-url-port int HTTP request port

x-url-post-data string Query string data sent by a POST request

x-url-protocol string Identifier of the protocol

x-url-query-original string Query string data sent by aGET request

x-url-query-
parameterization

string URL query string data sent by aGET request

x-url-uri string URI string data sent by aGET request

Transaction

Field Name Type Units Description

all-login-names string Login name of end user

c-browser-name string Web browser used by the visitor

c-host-id object The APM host ID associated with client

c-host-name string The host name associated with client

c-os-name string Operating system used by the visitor

c-session-start date date Session start time

c-transaction-client-time-
ms

long ms Time of total processing time between components

c-transaction-gross-
download-time-ms

long ms Gross download time

c-transaction-net-
download-time-ms

long ms Net download time

s-host-id object The APM server ID

s-host-name string The APM server name

s-sw-element-id object The APM software element ID

s-sw-element-name string The software element name
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Field Name Type Units Description

s-transaction-server-
firstbuf-time-ms

long ms Time taken for the server to process the transaction

s-transaction-server-time-
ms

long ms Time taken for the server to respond to the transaction

timestamp date ms Transaction start time

x-application-id object The APM application ID number

x-application-name string The APM application name

x-application-tier-id object The APM application tier ID number

x-end-user-id object The APM end-user group ID

x-end-user-subnet-id object The APM end-user subnet ID

x-end-user-user-name string The APM end-user group name

x-geo-ip-num string IP Address

x-geo-net-end-num string Last IP Address of the client's network block

x-geo-net-start-num string First IP Address of the client's network block

x-is-backend-tier boolean Indicates if the action belongs to back end tier

x-is-transaction-available boolean Indicates if the transaction was available

x-is-transaction-complete boolean Indicates if the transaction was completed

x-location-id object The APM end-user location ID

x-location-name string The APM end-user location name

x-location-parent-id1 object The APM location ID

x-location-parent-id2 object The APM location ID

x-location-parent-id3 object The APM location ID

x-location-parent-id4 object The APM location ID

x-location-parent-id5 object The APM location ID

x-location-parent-name1 string The APM location name

x-location-parent-name2 string The APM location name

x-location-parent-name3 string The APM location name

x-location-parent-name4 string The APM location name

x-location-parent-name5 string The APM location name
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Field Name Type Units Description

x-rum-probe-id int Internal ID of the RUM Probe

x-session-application-id string Internal ID of the session application

x-session-id string Universally unique identifier (UUID) automatically assigned
to each unique visitor session

x-threshold-offset-percent The location threshold offset in percent

x-transaction-bytes long Total number of bytes sent and received for the transaction

x-transaction-components int Number of components associated with the transaction

x-transaction-connect-
time-ms

long ms Time taken for the client and server to initialize a TCP
connection

x-transaction-errors-
events-num

int Total number of application error events associated with
the transaction

x-transaction-id object The APM transaction ID

x-transaction-info-events-
num

int Total number of information (non error) events on
transaction

x-transaction-name string The APM transaction name

x-transaction-network-
time-ms

long ms Network time

x-transaction-performance-
events-num

int Total number of performance (non error) events on
transaction

x-transaction-
retransmission-time-ms

long ms Time spent on retransmitting packets

x-transaction-ssl-time-ms long ms Time taken for the client and server to initialize an SSL
connection

Session

Field Name Type Units Description

all-login-names string Login name of end user

c-browser-name string Web browser used by the visitor

c-host-id object The APM host ID associated with client

c-host-name string The host name associated with client

c-os-name string Operating system used by the visitor

cs-session-bytes long byte Total number of bytes received for the session
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Field Name Type Units Description

s-host-id object The APM server ID

s-host-name string The server name

s-sw-element-id object The APM software element ID

s-sw-element-name string The software element name

sc-session-bytes long byte Total number of bytes sent for the session

timestamp date date Session start time

x-application-id object The APM application ID number

x-application-name string The APM application name

x-application-tier-id int The internal ID of the tier

x-avg-download-time-ms long ms Average download time for all actions associated with the
session

x-end-user-id object The APM end-user group ID

x-end-user-subnet-id object The APM end-user subnet ID

x-end-user-username string The APM end-user group name

x-expected-actions-count int Expected number of action hits associated with the session

x-geo-ip-num string IP Address

x-geo-net-end-num string Last IP Address of the client's network block

x-geo-net-start-num string First IP Address of the client's network block

x-is-backend-tier boolean Indicates the session associated with a back-end tier

x-is-session-available boolean Indicates if the session was available

x-is-session-ssl boolean Indicates that the session was over SSL connection

x-location-id object The APM end-user location ID

x-location-name string The APM end-user location name

x-location-parent-id1 object The APM location ID

x-location-parent-id2 object The APM location ID

x-location-parent-id3 object The APM location ID

x-location-parent-id4 object The APM location ID

x-location-parent-id5 object The APM location ID

x-location-parent-name1 string The APM location name
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Field Name Type Units Description

x-location-parent-name2 string The APM location name

x-location-parent-name3 string The APM location name

x-location-parent-name4 string The APM location name

x-location-parent-name5 string The APM location name

x-rum-probe-id int Internal ID of the RUM Probe

x-session-application-id string The internal ID of the session application

x-session-duration-ms long ms Duration time of the session

x-session-dwell-time-ms long ms Session's total dwell time, or the total number of
milliseconds the visitor spent looking at pages during the
current session

x-session-error-events-
num

int Total number of application error events associated with the
session

x-session-failed-actions long Number of failed actions on the session

x-session-id string This is a universally unique identifier (UUID) automatically
assigned to each unique visitor session

x-session-info-events-
num

int The total number of information (non error) events
associated with the session

x-session-last-page date date Time of last page associated with the session

x-session-latency-time-
ms

long ms Total session latency

x-session-packets long Total number of packets sent and received for the session

x-session-pageviews-
num

int Number of page views associated with the session

x-session-performance-
events-num

int The total number of performance (non error) events
associated with the session

x-session-property-tag1 string The application session property was tagged by RUM

x-session-property-tag2 string The application session property was tagged by RUM

x-session-property-tag3 string The application session property was tagged by RUM

x-session-property-tag4 string The application session property was tagged by RUM

x-session-property-tag5 string The application session property was tagged by RUM

x-session-referrer string Entire raw referrer string sent in the session's first request
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Field Name Type Units Description

x-session-requests-num int Number of hits or HTTP requests associated with the
session

x-total-download-time-for-
available-actions-ms

long ms Total download time of available action associated with the
session

x-total-download-time-for-
unavailable-actions-ms

long ms Total download time of unavailable action associated with
the session

Action

Field Name Type Units Description

x-action-id int Action ID

x-action-id-as-
integer

int Action ID as an integer

x-action-name string Action name

x-additional-
properties

string A string containing all additional properties of an action relevant for
the specific protocol

x-action-requests string Total number of component requests for this action

x-action-seq-id int The sequential number of the action from the total actions for the
entire session

x-availability-
threshold

long Availability threshold

x-available boolean Indicates if the action was available

x-bytes-in int Number of received bytes

x-bytes-out int Number of sent bytes

x-client-time-MS long ms Action client time

x-conditional-
follower-time-diff-
threshold

int Relevant for Seibel protocol only

x-connect-time-MS long ms The time taken for the client and server to initialize a TCP
connection, in microseconds.

x-download-
threshold-offset-
percent

int Download threshold offset percent

x-download-time-
threshold-MS

long ms Download time threshold
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Field Name Type Units Description

x-download-time-
MS

long ms Time taken from page first packet to page last packet

x-dynamic-
download-time-Th

long If true - download time threshold is computed dynamically from
historical data

x-dynamic-server-
time-Th

long If true - server time threshold is computed dynamically from
historical data

x-end-time-micros long ms Action end time

x-event-app-error-
count

int Number of event application errors

x-event-info-count int Number of info events

x-event-string string String contains event IDs

x-events int Number of events

x-extracted-
parameters

string A string containing all extracted parameters for an
action</description

x-extracted-
parametersMap

string A string containing amap of all extracted parameters for an action

x-event-category-
protocol-count

int Number of category protocol events

x-event-
performance-count

int Number of performance events

x-generic-descriptor string Descriptor for a given action

x-generic-
parameters

string A string containing generic parameters for the specific protocol

x-hierarchy-tag string Relevant for Seibel protocol only

x-integration-diag string Data from Diagnostics integration

x-is-backend-tier boolean Indicates if the action belongs to a back-end tier

x-is-classify boolean Action has been classified

x-is-SSL boolean Indicates that the action was over an SSL connection

x-network-time-MS long ms Action network time

x-orig-action-
properties-as-string

string A string containing all the original properties of an action for the
specific protocol

x-parameters string String contains protocol parameters
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Field Name Type Units Description

x-parent-action-seq-
id

int This field is used to correlate frames of the frame sets or other
dependent pages

x-retransmission-
time-MS

long ms The time spent on retransmitting packets

x-server-availability-
threshold

int Server availability threshold

x-server-time-
threshold-MS

long ms Server time threshold

x-server-time-MS long ms Time taken for the server to respond to the request

x-server-time-to-
first-buf-MS

long ms Server time to first buffer

x-server-time-to-
first-buf-threshold-
MS

long ms Server time to first buffer

x-session-property-
tag1

string The application session property was tagged by RUM

x-session-property-
tag2

string The application session property was tagged by RUM

x-session-property-
tag3

string The application session property was tagged by RUM

x-session-property-
tag4

string The application session property was tagged by RUM

x-session-property-
tag5

string The application session property was tagged by RUM

x-session-start-time long The session start time

x-specific-descriptor string The APM action name

x-specific-
parameters

string A string containing specific extracted parameters

x-ssl-time-MS long ms The time taken for the client and server to initialize a TCP
connection, in microseconds.

x-start-time-micros long ms Action start time

x-status-code int Protocol status code

x-stopped long The number of page requests that were prematurely interrupted,
including the page itself and all subsequent non-page or image
transactions.
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Field Name Type Units Description

x-template-
parameters

string A string containing all action parameters relevant for the specific
protocol

x-time-stamp date Action start time

x-total-latency-MS long ms Total action latency

x-total-packets int Number of packets

Event

Field Name Type Units Description

c-client-host string Client host name

c-client-host-
cmdb-id

object Client host - APM ID

c-client-ip string Client IP

x-action-
generic-
descriptor

string Generic descriptor of the action containing the event (for non session
events)

x-action-id int ID of the action containing the event (for non session events)

x-action-name string Name of the action containing the event (for non session events)

x-application-
cmdb-id

object APM application ID

x-application-id object APM application configuration ID

x-application-
name

string APM application configuration name

x-application-
tier-id

object APM application tier ID 

x-eu-cmdb-id object End user group - APM ID

x-eu-rule-id int End user group configuration ID

x-eu-subnet-id object End user group subnet - APM ID

x-eu-user-name string End user group name

x-event-
category

string Event Category - ERROR/INFO/PERFORMANCE

x-event-data string Event extra data. For example, extracted data for text pattern events
(limited to 1024 chars)

Real User Monitor Administration Guide
Chapter 15: RUMData Export

HPE Real User Monitor (9.30) Page 213 of 258



Field Name Type Units Description

x-event-id int Event ID

x-event-name string Event name

x-event-type string Event Type - HTTP/TEXT-PATTERN/GLOBAL/DL-
TIME/PAGES/SOAP/SESSSION-PAGES/SESSION-FAILED-PAGES

x-location-id object APM location ID

x-location-
name

string APM end-user location name

x-location-
parent-name1

string APM location name

x-location-
parent-name2

string APM location name

x-location-
parent-name3

string APM location name

x-location-
parent-name4

string APM location name

x-location-
parent-name5

string APM location name

x-session-
comp-seq

int Session action sequence

x-session-guid string Session GUID

x-session-id string Value of the application session ID (for example, JSESSIONID)

x-session-start-
time

date date Session start time

x-swe-cmdb-id obj APM software element ID

x-swe-display-
name

string Software element name

x-swe-host-
cmdb-id

object Software element host - APM ID

x-swe-host-
name

string Software element host name

x-swe-id int Software element ID

x-swe-ips string Software element IPs

x-timestamp date date Event time
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Chapter 16: RUM Integrations
RUM integrations enable you to export data gathered by the RUM Sniffer Probe into the following tools for
analysis:

l "RUM Integration with HPE Operations Analytics" below
l "RUM Integration with PC" below

RUM Integration with HPE Operations Analytics
Integrating RUMwith HPE Operations Analytics allows you to use the forensic root cause analysis tools in
HPE Operations Analytics on data exported from the RUM Sniffer Probe.

The RUM data export function is used to export the data from the RUM Sniffer Probe. For information about
the RUM data export function, see "RUMData Export" on page 197.

To configure RUM to export data to HPE Operations Analytics, you need to access the content pack from
HPE Operations Analytics andmodify setting on the RUM Engine. For details, see the HPE Operations
Analytics documentation.

RUM Integration with PC
The data that is exported in the RUM integration with PC is used to enrich PC with real data from production.

The data export file is located in:
<install dir>\conf\datapublisher\pc_integration.xml.

The data export file defines the default output folder (C:/RUM_Export\pc_integration) and themaximum
default folder size (2 Gb) among other information.

For information about the RUM data export function, see "RUMData Export" on page 197.

To enable integration with PC:

1. Copy the data export configuration file from

<install dir>\conf\datapublisher\pc_integration.xml

to

<install dir>\conf\datapublisher\consumers\pc_integration.xml

2. From the RUMweb console, click Tools > Monitoring configuration information.
3. Click Sync all configuration.
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Chapter 17: Parsing Supported Protocols
Parsing supported protocols are protocols on which RUM can carry out deep analysis, thus providing detailed
data about monitored applications for use in End User Management reports.

Note: The supported protocols are for standard implementation. For specific custom protocol
implementation support contact HPE support.

The following table lists the parsing supported protocols. Additional information for each protocol appears in
the following sections.

Applications

HTTP "HTTP" on page 219

"Flash/ActionScript AMF—HTTP Based" on page 221

SOA "SOA" on page 223

"WCF—HTTP Based" on page 223

Databases "Microsoft SQL Server" on page 224

"Oracle DB [+]" on page 225

"MySQL" on page 226

"DB2" on page 226

Application Servers "Citrix XenApp (ICA) [+] " on page 227

"XenApp Application configured as a VDI tier under themain General Web
Application" on page 227

"Oracle Forms NCA [+] " on page 231

"WMQ " on page 232

"SAPGUI" on page 233

Mailing Applications "IMAP" on page 235

"SMTP" on page 235

"POP3" on page 235

Generically Supported
Protocols

"DNS—Generic UDP" on page 237

"Microsoft Terminals Services (RDP)—Generic Streaming TCP" on page
237

"RMI Registry —Generic TCP" on page 238
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Applications

"SSH —Generic Streaming TCP" on page 239

Financial Protocols "NDC" on page 240

Additional Applications "FTP" on page 242

"LDAP" on page 242

"ISO 8583" on page 243

"SHVA" on page 243

"AMF" on page 243

"UDP" on page 244

Note: For applications monitored with RUM versions prior to 9.0, only Slow Requests report is provided.
However, full support is available for Oracle Forms NCA over HTTP starting from 8.02.

TCP Level Information
RUM supports deep content analysis for the application types listed in this document. The Action Summary
Report and Transaction Summary Report display the information for these application types. The basic TCP
Level information (Connection Availability, network quality) is also available for these applications.

You can also use RUM to create general TCP level reports for all TCP-based applications which are not listed
in this document .
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HTTP
l HTTP/S

l Versions: 1.0, 1.1

l APM Template Name:General Web Application

l Sample Snapshots:
Session Details

Action Summary

Tier Summary
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App Infrastructure

Session Summary
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Event Summary

Event Analysis

l Flash/ActionScript AMF — HTTP Based
l Versions:AMF0, AMF3

l APM Template Name: Flash
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l Sample Snapshots:
Session Analyzer

Action Summary
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SOA
l SOAP — HTTP Based

l Versions: 1.1, 1.2

l APM Template Name:General SOAP Application

l Sample Snapshots:Session Details

l WCF — HTTP Based
l Versions: any (NetTcpBinding binding is the only supported version)

l APM Template Name:WCF TCP

l Sample Snapshots:
App Infrastructure
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Session Details

Tier Summary

Databases
l Microsoft SQL Server

l Versions: 2000 and higher

l APM Template Name:MS SQL

l Sample Snapshots:Session Analyzer
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l Oracle DB [+]
l Versions: Thin Client (JDBC): 10g R2, 11g

l APM Template Name:Oracle DB

l Sample Snapshots:
Action Summary

Session Analyzer

l Comments: JDBC thin driver is a software component that allows the Java application to connect the
Oracle server without SQL*Net installed. It is widespread in Java applets. There are other categories of
JDBC drivers (JDBC OCI and JDBC KPRB) which require SQL*Net to be installed. JDBC OCI and
JDBC KPRB are not yet supported by RUMMonitoring. JDBC Thin connections allow RUM to report
SQL queries and bound parameters (if any). TheOracle JDBC Thin driver uses TCP/IP connections.
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l MySQL
l Versions: 5.X and higher

l APM Template Name:MySQL

l Sample Snapshots:Session Analyzer

l DB2
l Versions: Type 4 driver (DRDA)

l APM Template Name:DB2

l Sample Snapshots:Session Analyzer

l Comments:DRDA (Distributed Relational Database Architecture) is the only architecture (not an
implementation) that enables different platforms to interchange relational data. JDBC Driver type 4 for
DB2 implements DRDA to communicate with the DB2 server.  It was first introduced in DB2 v.8.1. It
does not require any additional middleware software to be installed. There is also DB2CLI protocol
which is used by Type 2, Type 3 to communicate to DB2 server. DB2CLI is not yet supported by
RUM. Monitoring DRDA connections allow RUM to report SQL queries and bound parameters (if any).
DB2 JDBC Driver Type 4 usually uses TCP/IP connections.
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Application Servers
l Citrix XenApp (ICA) [+]

l Versions: 4.5 - 6.5

l APM Template Name:Citrix ICA

l Sample Snapshots:Session Summary

l XenApp Application configured as a VDI tier under the main General Web Application
l Versions: 6.5

l APM Template Name:Citrix ICA VDI
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l Sample Snapshots:
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l Oracle Forms NCA [+]
l Versions: 11g

l APM Template Name:Oracle Forms over HTTP/TCP

l Sample Snapshots:Session Analyzer (v.8.02), Auto-discovered RUM Actions for Oracle Forms,
RUM Actions matching Oracle Forms traffic
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l WMQ
l Versions:WMQ6, WMQ7

l APM Template Name:MQ
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l Sample Snapshots:Session Analyzer

l Comments: IBMWebSphereMQ(previously named MQSeries) is amessage orientedmiddleware
software. It provides infrastructure that allows applications to communicate in distributed systems. In
MQ, infrastructure applications communicate usingmessages. Thesemessages are stored in special
data structures calledMessageQueues. MessageQueues aremanaged by the QueueManager (QM).
At this moment WMQ6 is more widespread. RUM supports bothWMQ6 andWMQ7. WMQ supports
asynchronous communication. InWMQ7, channel multiplexing (the same TCP connection is shared
among several clients).  

l SAPGUI
l Versions:SAPGUI Frontend 7.1, 6.2

l APM Template Name:SAPGUI

l Sample Snapshots:
Session Analyzer
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Session Details
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Mailing Applications
l IMAP

l Versions:Any

l APM Template Name: IMAP

l Sample Snapshots: Tier Summary

l SMTP
l Versions:Any

l APM Template Name:SMTP

l Sample Snapshots:Session Analyzer

l POP3
l Versions:Any

l APM Template Name:POP3
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l Sample Snapshots: Tier Summary
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Generically Supported Protocols
l DNS — Generic UDP

l Versions:Any (UDP only)

l APM Template Name:DNS

l Sample Snapshots:App Infrastructure

l Microsoft Terminals Services (RDP) — Generic Streaming TCP
l Versions:Any

l APM Template Name:Microsoft Terminal Service (RDP)

l Sample Snapshots:
Tier Summary
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Tiers Over Time

l RMI Registry — Generic TCP
l Versions:Any

l APM Template Name:RMI Registry

l Sample Snapshots:
Tier Summary
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Tiers Over Time

l SSH — Generic Streaming TCP
l Versions:Any

l APM Template Name:SSH

l Sample Snapshots:
App Infrastructure

Tier Summary
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Financial Protocols
l NDC

l Versions:Conforming to B006-6180-J000, Issue 2, February 2008 Aptra Advance NDC Reference
Manual

l APM Template Name:Aptra Advance NDC

l Sample Snapshots
RUM Session Summary Report
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RUM Action Summary

RUM Event Summary

l Comments: For detailed information about configuring the NDC protocol, see "NDC Protocol
Configuration" on page 248.
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Additional Applications
l FTP

l Versions:Any

l APM Template Name: FTP

l Sample Snapshots:Session Analyzer

l LDAP
l Versions: 3.0 and higher

l APM Template Name: LDAP

l Sample Snapshots:
Session Analyzer
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Session Details

l ISO 8583
l Versions:VISA BASE I, MasterCard CIS

l APM Template Name:N/A

l Sample Snapshots:Session Analyzer

l SHVA
l Versions:Based on spec by CAL

l APM Template Name: <private>

l Sample Snapshots:N/A

l Comments:Based on the spec provided by customer: CAL

l AMF
l Versions:AMF0, AMF3

l APM Template Name: Flash
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l Sample Snapshots:
o Session Analyzer

o Action Summary

l Comments: Flash is a client side technology. It can be used for many different things, from playing
movies to creating a completely client side application that may never access the server. Flex is a
specific framework for developing applications over Flash. A part of the Flex framework is using the
AMF protocol which is an Adobe protocol for communication between a Flash client and server. AMF in
Flex usually runs over HTTP. Monitoring AMF protocol allows RUM to report remotemethod
invocations and their parameters. RUM supports versions AMF0 and AMF3.

l UDP
l Versions:N/A

l APM Template Name:Generic UDP

l Sample Snapshots:

Application Suites

Oracle E-Business
l Siebel (CRM):HTTP-based. When defining an application in APM, use one of the Siebel X.X types.
l PeopleSoft:Regular HTTP-Web application
l Oracle Database: There are two types of protocols used for Oracle DB: OCI and Thin Client (JDBC). Only
Thin Client (JDBC) is currently supported (see "Databases" on page 224).

l Oracle Forms:Can be implemented as a regular HTTP-Web application, or using Oracle NCA client (runs
integrated in theWeb browser). Oracle NCA client may communicate with the server over HTTP or raw
TCP sockets. For each type of communication, RUM provides a separate application template: Oracle
Forms over HTTP or Oracle Forms over TCP.

These protocol types may be combined in a single RUM application as different tiers.
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Citrix Solutions
l XenApp (successor of MetaFrame):A user connects to XenApp using a special Citrix Client, and runs
certain applications on the server, while getting the look-and-feel of the local application. Uses Citrix ICA
protocol for communication.

l XenDesktop:Similar to XenApp, only that whole desktop is virtualized.
l Citrix Portal:AWeb interface which provides access to XenApp applications. You have to select the
Citrix HTTP application template whenmonitoring a Citrix portal.

l XenServer:Server virtualization, each virtual server runs it's ownOperatins System.
With RUM you canmonitor XenApp and XenDesktop from two angles:

l Monitoring Citrix ICA protocol:You can have all TCP-level measurements (including network quality
parameters) for each user session via the Session Summary report, which shows the breakdown of the
data by username or/and application which runs on Citrix Server;

l Monitoring outgoing traffic:WhenRUMmonitors an HTTP-Web application which is accessed by
users via XenAll or XenDesktop, this virtualization layer hides the real client's properties (IP address,
username). These parameters may be recovered if the RUMHTTP Agent is installed on the Citrix Server.

Extending Protocol Coverage
RUM ships with an SDK which allows you to add support for new protocols to RUM. For some application
types, the support can be easily added; for some it requires more work. If you encounter a customer's request
for an unsupported protocol/application, we recommend that you contact Product Marketing or R&D for
assistance.

Real User Monitor Administration Guide
Chapter 17: Parsing Supported Protocols

HPE Real User Monitor (9.30) Page 245 of 258



Chapter 18: Customizing Error Codes for
SAPGUI
Error capturing is based onmatching status messages against a template list. Out-of-the- box, RUM is
configured tomatch only some of the SAPGUI error messages. You can add additional error messages
(predefined or custom) to the list for matching.

To add additional error messages, on the RUM Probemachine edit the <HPRUMProbe>/etc/rum_
probe/protocols/sapgui.def file and under the [sapgui_custom] section add a line for each error code in the
following format:

status_code <CODE> <MESSAGE_REGEX>

For example, the line status_code 1 Function module \w* does not existmeans that an action is reported
as having a status code of 1 if it results in a status message that matches the regular expression ‘Function
module \w* does not exist’.

APM uses the SAPGUI status codes to create predefined events for applications configured with the
SAPGUI template. By default, only error codes 1 (Object not found) and 2 (Invalid function) are predefined in
APM and are both included in an event calledSAPGUI error. To add additional predefined events for
SAPGUI applications using other codes, on the APMGateway Server edit the <HPE APM>\conf\rum_
templates\SapGui.xml file and under the <events> tag, create a new, single event in the following format:

<event>
<active>true</active>
<snapshot>true</snapshot>
<name>Unique event name</name>
<report_as_error>true</report_as_error>
<category>error</category>
<collect_session_snapshot>false</collect_session_snapshot>
<scope>GLOBAL</scope>
<type>0</type>
<error_codes>
<code>Unique error code number</code>
</error_codes>
<actions/>

</event>

Note: The event name and the error code numbermust be unique within the template. That is, they
cannot be used in any other event configured in the template.

Example
To report actions that contain an 'Invalid key specified' message:

1. On the RUM Probemachine, add the following line under the [sapgui_custom] section in the
<HPRUMProbe>/etc/rum_probe/protocols/sapgui.def file:

status_code 5 Invalid key specified
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2. On the APMGateway Server, add the following event to the SAPGUI template (<HPE
APM>\conf\rum_templates\SapGui.xml):

<event>
<active>true</active>
<snapshot>true</snapshot>
<name>Invalid key error</name>
<report_as_error>true</report_as_error>
<category>error</category>
<collect_session_snapshot>false</collect_session_snapshot>
<scope>GLOBAL</scope>
<type>0</type>
<error_codes>
<code>5</code>
</error_codes>
<actions/>

</event>

3. In APM, an 'Invalid key error' event is added as a default Protocol Error Event for applications configured
with the SAPGUI template:
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Chapter 19: NDC Protocol Configuration
The following provides the information required to configure the NDC protocol parser. To access the NDC
template, contact HPE customer support.

The NDC configuration files comewith a sample configuration. Replace theNdcOperationInfo.csv and
NdcTerminalInfo.csv files with your deployment configuration so the reports display the correct data.
Ndc.defmay also need to bemodified.

The NDC configuration files can be found at: /etc/rum_probe/protocols/

NdcOperationInfo.csv
The end user of the ATM presses function keys at an ATM to perform an operation such as CashWithdrawal.
TheNdcOperationInfo.csv file provides amapping from the end user key sequence to the operation.

The following is an example line in this file:

“Profile 1","ABCDEFGF","Cash Withdrawal"

Each line in this file contains comma separated values for the Profile name, Operation code, and the
Operation. Each ATMmay have different hardware and software running on it . This information is categorized
by the ATM profiles. Each ATM has a unique profile associated with it. TheOperation code is a sequence of
keys pressed at the ATM. By pressing anOperationCode key sequence the end user is able to perform an
operation.

If you update, add, or remove Actions from the sample configuration file, you need to correspondingly update
the defined Actions. You can update the defined Action in the APMUI by clickingAdmin > End User
Management. Select the NDC application in the left pane, and update the Actions tab in the right pane.

NdcTerminalInfo.csv
To provide themapping from theNdcOperationInfo.csv file, you need to know the ATM profile. The RUM
Probe only sees the data coming from the ATM, so it is only aware of the IP address of the ATM. The
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NdcTerminalInfo.csv file helps determine the ATM profile and the ATM user friendly name based on the ATM
IP address.

The following is an example line in this file. Each terminal, characterized by the user friendly terminal name,
has a unique profile.

192.168.1.2,Terminal1,"Profile1"

Each line in the file contains comma separated values for the ATM IP address, ATM user friendly name, and
ATM profile.

ndc.def
The ndc_custom section of the ndc.def file provides additional configuration options for the NDC protocol
parser.

The NDC Server response to ATM requests contains a clear text part. It is possible to match regular
expressions in this clear text to set status codes. In the Events tab of the APM Admin UI for the NDC
application you canmap these status codes to informational, warning, or error events.

The following is an example line in this file:

status_code 1 TRANSACTION ABORTED

TRANSACTION ABORTED is the string that is searched in the clear text response in the server. If the string is
found, a status_code of 1 is set on the Action. In the APMUI for this protocol, this code was mapped to signal
an error, so an error event is triggered when this occurs.

It is also possible to extract text in a server responsematching a regular expression pattern and display that
field in the Action details page for that Action. For example, some transactions might contain Ledger followed
by the ledger balance amount followed by either KES or TZS as the currency.

This following examplematches this pattern. When it is found, the Action Details report for that Action will
contain the field LedgerBalancewith its value and currency.

pattern LedgerBalance.*LEDGER.*([K|T][E|Z]S.*)

Real User Monitor Administration Guide
Chapter 19: NDC Protocol Configuration

HPE Real User Monitor (9.30) Page 249 of 258



Chapter 20: Monitoring Citrix with RUM
You can use RUM’s VDI agent to monitor Citrix traffic.

This chapter includes the following topics:

l "Overview of Citrix Monitoring with RUM" below
l "Overview of the RUM VDI Agent" on page 252
l "Configurations forWorking with the RUM VDI Agent for HTTP Traffic" on page 252
l "Advanced Configuration for HTTP Traffic" on page 254
l "Using the RUM VDI Agent with Terminal Services for HTTP Traffic" on page 256

Overview of Citrix Monitoring with RUM
End users can connect to a Citrix XenApp server via a web portal or a direct ICA connection. Whenmultiple
users connect to the same XenApp server, requests sent from the XenApp server all originate from the same
client, regardless of the originating end user.

This section includes:

l "Monitoring Traffic Between End Users and a XenApp Server" below
l "Monitoring Outgoing Traffic from a XenApp Server" on the next page

Monitoring Traffic Between End Users and a XenApp Server
The following diagram shows typical traffic between end users and a Citrix XenApp server:
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An end user starts by opening a Citrix web portal and selecting one of the published applications. An ICA
session is created, in which the selected application runs on the XenApp server, and the user uses the
application remotely.

Alternatively, a user can create an ICA connection directly, without going through a web portal.

Tomonitor this traffic with RUM 9.x or later, no agent installation is required. You simply configure the
following applications in APM, using specific templates:

l The XenApp application, using theCitrix ICA template.
l The Login application, using theCitrix Http template.
For user interface details on creating RUM applications in APM, see "RUM Application ConfigurationWizard"
in the APM Application Administration Guide.

Monitoring Outgoing Traffic from a XenApp Server
The following diagram shows multiple users connected to the same XenApp server, each running an instance
of the Internet Explorer browser to connect to a web server. In this scenario, all connections opened to the
web server originate from the same client, which is the XenApp server.

Tomonitor this, youmust define the web application (web servers) using theGeneral Web Application
template.

Whenmonitoring this scenario with RUM, it is desirable to see the real end users as the clients, rather than
having a single client combining all the traffic. To achieve such functionality, youmust install the RUM VDI
Agent on the XenApp server.

The following table shows the difference between RUM reports when the RUM VDI Agent is, or is not,
installed on the XenApp server:

Request URL

Without RUM VDI Agent With RUM VDI Agent

Client IP User Name Client IP User Name

/index.html 60.61.2.2 - 121.54.10.4 John

/index.html 60.61.2.2 - 59.64.8.1 Rosetta

/search?q=agent 60.61.2.2 - 121.54.10.4 John

/checkout.jsp 60.61.2.2 - 59.64.8.1 Rosetta

/index.html 60.61.2.2 - 59.64.7.2 Steve

/view?item=agent 60.61.2.2 - 121.54.10.5 Peter

Real User Monitor Administration Guide
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Overview of the RUM VDI Agent
You use the RUM VDI Agent to monitor traffic from a XenApp server for the initiating end user.

This section includes:

l "Supported Browsers for HTTP Traffic" below
l "How the RUM VDI Agent Works for HTTP Protocol" below

Supported Browsers for HTTP Traffic
For details on the supported browsers and ActiveX components, see theRUM VDI Agent Requirements in
the Real User Monitor Installation and UpgradeGuide.

How the RUM VDI Agent Works for HTTP Protocol
The RUM VDI Agent tags outgoing HTTP traffic with the IP address and user name of the real end user
(connected to the XenApp server). This information is added to the preconfigured HTTP header.

The new configurationmode (which is the default mode) adds the following HTTP headers:

l RUM_USER_NAME
l RUM_CLIENT_ADDRESS
In compatibility mode, the information is added to theUserAgent HTTP header

For more information see "Advanced Configuration for HTTP Traffic" on page 254.

Note: Tagging the user agent HTTP header may slow down the browser. However, you can assume that
the browser and website are on the same network (or at least geographically near each other), so any
slow down is not significant.

Configurations for Working with the RUM VDI Agent
for HTTP Traffic
Youmust configure user name detection in the applications you want monitored using the RUM VDI Agent.
Additionally, you can configure RUM to use the IP of the real user connected to a XenApp server as the client
IP in the web application.

This section includes:

l "To configure user name detection in applications" below
l "To configure Real User Monitor to use the IP of the real user connected to a XenApp server as the client
IP in the web application" on the next page

To configure user name detection in applications
1. In End User Management Administration in APM, configure a new application or edit an existing

application.
2. Select Real User Monitor > General and in theReal User Monitor Application General page,

expand theUser Name Detection area.

Real User Monitor Administration Guide
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3. Click theNew User Name Detection button. TheUser Name Detection dialog box opens in a new
window.

4. In theUser Name Detection dialog box, configure the following:
l In compatibility mode:

Field Value

Search in HTTP Header

Header name User-Agent

Extract text:

Between RUM_USER_NAME=

and ;

l In the new configurationmode:

Field Value

Search in HTTP Header

Header name RUM_USER_NAME

Content All content

5. Click OK to save the configuration changes.

Note: The web applicationmay require users to log on when opening the application in the web
browser. In such cases, you should decide whether you prefer configuring the user name for the web
application as the Citrix user name, or as the web application’s user name. In either case, youmay
consider configuring the other user name (Citrix or web application) as a Session Property.

To configure Real User Monitor to use the IP of the real user connected to a
XenApp server as the client IP in the web application
1. On the RUM Engine, edit the file:

<HPRUM>\conf\configurationmanager\Beatbox_Default_Const_Configuration.xml

2. Add the following line at the end of the [Global] section:
l In compatibility mode, add:

forwarded_for_header User-Agent .*RUM_CLIENT_ADDRESS=IPV4\\*([^;]*);.* $1

l In the new configurationmode, add:

forwarded_for_header RUM_CLIENT_ADDRESS IPV4\\*([^;]*);.* $1

3. Save the file.
4. In the RUM Engine web console, synchronize configuration data by selecting Tools > Monitoring

Configuration Information > Sync All Configuration. For details, see "Monitoring Configuration
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Information" on page 129.

Advanced Configuration for HTTP Traffic
You configure advanced settings by editing the <All users Application Data
path>\HP\RumHttpAgent\settings\RumHttpAgent.cfg file on the Citrix XenApp server on which the RUM
VDI Agent is installed.

(For example, C:\Documents and Settings\All Users\Application
Data\HP\RumHttpAgent\settings\RumHttpAgent.cfg.)

To set the configuration mode for VDI Agent
The following files appear in the settings directory:

l RumHttpAgent.cfg
l RumHttpAgent.cfg.update
By default, VDI Agent works in the new configurationmode usingRumHttpAgent.cfg. In the new
configurationmode, new headers are created and the UserAgent header is not used.

To work in compatibility mode (in which information is added to the User-Agent field), rename the
RumHttpAgent.cfg.update file toRumHttpAgent.cfg.

To disable the RUM VDI Agent
In the [common] section of the file, change the disable parameter value to true. The change takes effect for
new IE and Firefox browser instances.

To disable the RUM VDI Agent for a specific browser type

In the [IE] or [Firefox] section of the file, change the disable parameter value to true. The change takes effect
for new instances of the specific browser.

To filter and rename header fields (for example, User Agent)
To avoid the following limitation, we recommended you work in the new configurationmode.

However, if you do decide to work in compatibility mode, be aware that some versions of ASP.NET limit the
length of the User-Agent HTTP header to 256 byte (see http://support.microsoft.com/kb/974762/en-us). If the
User-Agent HTTP header exceeds this threshold, the web browser is not able to browse through the web
pages. AlthoughMicrosoft released a patch for this issue, not all environments worldwide have been updated.

The current implementation of the RUM VDI Agent cannot control the entire User-Agent HTTP header. The
RUM VDI Agent tells the browser to include a substring like RUM_USER_NAME=<john_smith>;RUM_DOMAIN_
NAME=<company_domain>;RUM_CLIENT_ADDRESS=IPV4*<11.22.33.44>; RUM_CLIENT_NAME=<JOHN-WORK-
NOTEBOOK> in the header. This substringmay exceed the 256 character limit.

Starting from version 9.23, you can configure which fields RUM VDI Agent will publish and, optionally, you
can configure these fields to be renamedwith a shorter alias.

To achieve this goal, <ProgramData>\HP\RumHttpAgent\settings\RumHttpAgent.cfg has a new
parameter allowedFieldList under the [Common] section:

# With the aim to reduce the User-Agent header, you can specify only some of the
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fields

# If you want to use all of the field:

# allowedFieldList=RUM_USER_NAME,RUM_CLIENT_ADDRESS,RUM_CLIENT_NAME,RUM_DOMAIN_NAME

# Optionally, you can specify an alias for those fields, use (shorter_name) syntax:

# allowedFieldList=RUM_USER_NAME(RUNAME), RUM_CLIENT_ADDRESS(RCADDR), RUM_CLIENT_
NAME(RCLIENT)

# By default, we do not publish RUM_DOMAIN_NAME

allowedFieldList=RUM_USER_NAME, RUM_CLIENT_ADDRESS, RUM_CLIENT_NAME

As one can see, by default, RUM_DOMAIN_NAME is not published anymore, as the field is not used in either
User NameDetection or Real User IP detection. RUM_CLIENT_NAME also could be eliminated from the
list, since User NameDetection is configured solely by RUM_USER_NAME (see To configure Real User
Monitor to use the IP of the real user connected to a XenApp server as the client IP in the web application in
"Configurations forWorking with the RUM VDI Agent for HTTP Traffic" on page 252.

Using field aliases, you can save somemore space in the User-Agent header. For example, if you enter:

allowedFieldList=RUM_USER_NAME(RUNAME), RUM_CLIENT_ADDRESS(RCADDR)

the following appears in the User-Agent header:

User-Agent: Mozilla/4.0 (compatible; MSIE 8.0; Windows NT 6.1; Win64; x64; Trident/4.0; .NET CLR
2.0.50727; SLCC2; .NET CLR 3.5.30729; .NET CLR 3.0.30729; Media Center PC 6.0; .NET4.0C;
.NET4.0E; RUNAME=<john_smith>;RCADDR=IPV4*<11.22.33.44>)

Renaming the fields affects the User Name detection and Real User IP detection. Therefore, you need to edit
the contents of the ‘Between’ field in the User NameDetection dialog box, and the forwarded_for_header
variable. In our example :

1. In the User NameDetection dialog box, configure the following:

Field Value

Search in HTTP Header

Header name User-Agent

Extract Text

Between RUNAME=

and ;

2. Add the following line at the end of the [Global] section:

forwarded_for_header User-Agent .*RCADDR=IPV4\\*([^;]*);.* $1
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To turn on logging
In the [common] section of the file, change the enableLog parameter value to true.

Log files are located in the <COMMONAPPDATA>\HP\RumHttpAgent\logs directory, where <
COMMONAPPDATA> is the file system directory that contains application data for all users. (This directory
differs between operating systems. For example, inWindows 7 it is C:\ProgramData, and forWindows XP it
is C:\Documents and Settings\All Users\Application Data.)

Using the RUM VDI Agent with Terminal Services for
HTTP Traffic
The RUM VDI Agent can be used with Terminal Sessions in a similar way as with Citrix. If an end user is
browsing a web application via a Remote Desktop connection, the RUM VDI Agent can be used to extract the
real client’s IP address and user namewhenmonitoring the web traffic with RUM.
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Chapter 21: Supporting ISO8583 Based
Protocols
ISO8583 is the standard for building financial communication protocols. However, this standard does not
cover all aspects of a particular implementation. Some things (such as optional headers and field definitions)
need to be defined according to your implementation.

RUM provides ISO8583 core support as well as two implementations (MasterCard and Visa) which are
supported out of the box. RUM also has amechanism to adapt the custom flavor of the protocol.

Note: There are different implementations of Visa/MasterCard protocol. Only part of them are supported
by RUM. In order to verify if your specific implementation is supported by RUM, .record a PCAP file and
open a support ticket.

Monitoring ISO8583-based protocols can be supported either with standard or custom templates. If you have
a custom implementation, you need to change the configuration files to adapt to your implementation.

If the custom protocol implementation is not supported with standard templates, you can customize the
template as follows:

1. Locate the documentation for the custom implementation of the protocol.
2. In RUM probe /etc/rum_probe/protocols, open the fileMC.xml orVisaNet.xml and change the

protocol specification.
3. Use themodified version of the template tomonitor the application.
If there are several versions of the protocol and all of them have to bemonitored with the sameRUM Probe
instance, you need to have dedicated templates and configurations on APM, RUM Engine, and RUM Probe.

ISO8583 includes a variety of custom flavor implementations some of which are supported by RUM. We
recommend consulting HPE Support at an early development stage to provide support of custom flavor
implementations.
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Send Documentation Feedback
If you have comments about this document, you can contact the documentation team by email. If an email
client is configured on this system, click the link above and an email window opens with the following
information in the subject line:

Feedback on Real User Monitor Administration Guide (Real User Monitor 9.30)

Just add your feedback to the email and click send.

If no email client is available, copy the information above to a new message in a webmail client, and send
your feedback to SW-doc@hpe.com.

We appreciate your feedback!
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